# Table of Contents

Part I: MapInfo Professional 7.5 Supplement .......................... 9

Chapter 1: Upgrading to MapInfo Professional 7.5 ......................... I-10

- System Requirements for MapInfo Professional ........................................ I-11
  - Handling Database Connectivity .................................................. I-11
- Before You Upgrade MapInfo Professional ........................................... I-11
  - Navigating the MapInfo Professional 7.5 CD Browser ...................... I-12
- Upgrading MapInfo Professional .......................................................... I-12
  - Typical Workstation Installation ................................................ I-13
  - Custom Workstation Installation ............................................... I-14
  - Network Installation ...................................................................... I-15
  - Setting Up Client Workstations ................................................ I-16
- Modifying, Repairing, or Removing MapInfo Pro ................................. I-16
  - Controlling Advanced System Settings ...................................... I-17
  - Controlling the Location of Application Data Files During Installation I-18
  - Installing Data ................................................................................ I-20
  - Installing Related Programs, Hardware, and Resources ..................... I-21
  - Troubleshooting your Installation ................................................ I-23
  - Removing MapInfo Professional from your System ......................... I-23

Chapter 2: What’s New in MapInfo Professional 7.5 ......................... I-24

- New Major Features of MapInfo Professional 7.5 ............................... I-25
  - Accessing Web Map Services ....................................................... I-25
  - Raster Registration Enhancements ............................................... I-28
  - Create Points Changes ............................................................... I-31
  - New Shortcuts throughout MapInfo Professional ......................... I-33
  - Additional OSGB/GML Support .................................................... I-33
  - Improved Resolution for 3D and Prism Maps .................................. I-35
- Printing Enhancements ........................................................................ I-36
  - MapInfo Professional 7.5 Printing Guide .................................... I-36
  - Additional Fill Patterns .................................................................. I-36
  - Printing Fill Patterns to Match Screen Display ......................... I-36
  - Setting your Output Setting Preferences .................................... I-37
- Database Enhancements ...................................................................... I-39
  - Reading Larger Excel Files into MapInfo Professional .................... I-39
  - Read Oracle Tables in 8.1.7 like 9i ............................................... I-40
- Datum Enhancements .......................................................................... I-40
  - Enhanced KKJ Projection Algorithm ........................................... I-40
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping Enhancements</td>
<td>I-40</td>
</tr>
<tr>
<td>Clearing Default Workspace Name After Close All</td>
<td>I-40</td>
</tr>
<tr>
<td>Moving and Offsetting Geographic Objects</td>
<td>I-40</td>
</tr>
<tr>
<td>Increase Memory Size and New Resolution Preference Setting</td>
<td>I-43</td>
</tr>
<tr>
<td>Zooming, Panning, and Moving Changes</td>
<td>I-45</td>
</tr>
<tr>
<td>Zoom Layering Enhancements</td>
<td>I-46</td>
</tr>
<tr>
<td>Snap Enhancements</td>
<td>I-46</td>
</tr>
<tr>
<td>Setting and Printing the Map Scale in Layout Windows</td>
<td>I-47</td>
</tr>
<tr>
<td>Large Crosshairs</td>
<td>I-48</td>
</tr>
<tr>
<td>Custom Symbol Enhancements</td>
<td>I-48</td>
</tr>
<tr>
<td>Improved Object Rotation</td>
<td>I-52</td>
</tr>
<tr>
<td>Data Disaggregation Dialog Changes</td>
<td>I-53</td>
</tr>
<tr>
<td>Dot Density Theme Enhancements</td>
<td>I-54</td>
</tr>
<tr>
<td>Object Clean Gaps Modification</td>
<td>I-54</td>
</tr>
<tr>
<td>Setting Map Bounds for DBMS Tables</td>
<td>I-54</td>
</tr>
<tr>
<td>Saving a Buffer as a Table</td>
<td>I-56</td>
</tr>
<tr>
<td>New Voronoi Capabilities</td>
<td>I-58</td>
</tr>
<tr>
<td>Add In Enhancements</td>
<td>I-61</td>
</tr>
<tr>
<td>Crystal Reports Changes</td>
<td>I-61</td>
</tr>
<tr>
<td>Vertical Mapper Integration</td>
<td>I-62</td>
</tr>
<tr>
<td>Menu Enhancements</td>
<td>I-62</td>
</tr>
<tr>
<td>Window Menu Changes</td>
<td>I-62</td>
</tr>
<tr>
<td>Tool Enhancements</td>
<td>I-63</td>
</tr>
<tr>
<td>New Tools for MapInfo Professional 7.5</td>
<td>I-63</td>
</tr>
<tr>
<td>Enhancements to Existing Tools in MapInfo Professional 7.5</td>
<td>I-64</td>
</tr>
<tr>
<td>EasyLoader Changes</td>
<td>I-65</td>
</tr>
<tr>
<td>MapBasic Enhancements</td>
<td>I-65</td>
</tr>
<tr>
<td>Appendix A: Directory of MapInfo Professional Shortcuts</td>
<td>I-66</td>
</tr>
<tr>
<td>Shortcuts for File Menu Items</td>
<td>I-67</td>
</tr>
<tr>
<td>Shortcuts for Edit Menu Items</td>
<td>I-67</td>
</tr>
<tr>
<td>Shortcut to Tools Menu Items</td>
<td>I-67</td>
</tr>
<tr>
<td>Shortcuts to Objects Menu Items</td>
<td>I-68</td>
</tr>
<tr>
<td>Shortcuts for Query Menu Items</td>
<td>I-68</td>
</tr>
<tr>
<td>Shortcuts for Options Menu Items</td>
<td>I-68</td>
</tr>
<tr>
<td>Shortcuts for Map Menu Items</td>
<td>I-69</td>
</tr>
<tr>
<td>Shortcut for Layout Menu Item</td>
<td>I-69</td>
</tr>
<tr>
<td>Shortcuts for Windows Menu Items</td>
<td>I-69</td>
</tr>
<tr>
<td>Shortcuts by Keystroke</td>
<td>I-70</td>
</tr>
<tr>
<td>Appendix B: Fill Patterns Used in MapInfo Professional</td>
<td>I-72</td>
</tr>
<tr>
<td>Fill Pattern Table</td>
<td>I-73</td>
</tr>
<tr>
<td>New Fill Patterns (Added in This Release)</td>
<td>I-74</td>
</tr>
<tr>
<td>Appendix C: New and Enhanced MapBasic Statements and Functions</td>
<td>I-78</td>
</tr>
</tbody>
</table>
# MapInfo Professional 7.8 Supplement Table of Contents

## Part II: MapInfo Professional 7.8 Supplement ........................................... 95

### Chapter 1: Upgrading to MapInfo Professional 7.8 ..................................... II-96

**System Requirements for MapInfo Professional 7.8** ................................ II-97
- Handling Database Connectivity ................................................................ II-97

**Before You Upgrade to MapInfo Professional 7.8** ................................... II-98
- Navigating the MapInfo Professional 7.8 CD Browser ................................ II-98

**Upgrading MapInfo Professional 7.8** ....................................................... II-98
- Typical Workstation Installation (7.8) ..................................................... II-99
- Custom Workstation Installation (7.8) .................................................... II-100
- Network Installation (7.8) ........................................................................ II-102
- Setting Up Client Workstations (7.8) ....................................................... II-103

**Setting your Database Connection Preferences** ...................................... II-103

**Modifying, Repairing, or Removing MapInfo Pro** ................................... II-104
- Controlling Advanced System Settings (7.8) ............................................ II-105
- Controlling the Location of Application Data Files During Installation (7.8) II-106
- Installing Data ......................................................................................... II-108
- Installing Related Programs, Hardware, and Resources (7.8) .................. II-109
- Troubleshooting your Installation ............................................................. II-111
- Removing MapInfo Professional 7.8 from your System using Control Panel II-111
- Removing MapInfo Professional 7.8 from your System using the CD Browser II-111

### Chapter 2: What's New in MapInfo Professional 7.8 ................................. II-112

**New Major Features of MapInfo Professional 7.8** ................................ II-113
- Adding WFS Client Support ................................................................. II-113
- Adding GetFeatureInfo Support to Web Map Service ......................... II-124
- Controlling WMS Server Timeout Values ............................................. II-125
- Clearer WMS Error Messages .............................................................. II-126
- Saving Your Workspace as an XML-Based MWS File ......................... II-127

**Raster Enhancements** ............................................................................. II-129

**Mapping Enhancements** ......................................................................... II-130
- Removed: 256 Character Limit in Text Boxes ........................................ II-130
- More Dot Density Choices for Thematic Maps ..................................... II-130
- Snap and Thin Settings now Saved in Metadata ................................... II-130
- New Preference for Visible Snap Area ................................................... II-130
- Adding User-Defined Custom Symbols ................................................. II-131
- New High-Resolution Custom Symbols ............................................... II-132
- Selecting Sample Size for Cartographic Legend Window .................... II-132
- Changes to the AutoTrace Mode (Toggle Option for Line Following) .... II-134
- Sample Data Changes Available ............................................................ II-135

**3D Enhancements** .................................................................................... II-135

**Datum Enhancements** ............................................................................ II-135
- French RGF93 Coordinate System ....................................................... II-135
- Australian Coordinate System Modifications ....................................... II-136
- Israeli Coordinate System Added ........................................................... II-136
- Swedish Coordinate System Added ........................................................ II-136

---

© 2004 MapInfo Corporation. All rights reserved.

MapInfo Professional 7.5/7.8

MI_UG.pdf
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Swedish Coordinate Systems (SWEREF 99) Added</td>
<td>II-136</td>
</tr>
<tr>
<td>Reordered/Added Danish Coordinate Systems</td>
<td>II-136</td>
</tr>
<tr>
<td>AirPhotoUSA Conterminous U.S. Coordinate System Now Available</td>
<td>II-137</td>
</tr>
<tr>
<td><strong>Printing Enhancements</strong></td>
<td>II-137</td>
</tr>
<tr>
<td>New Scale Choices when Printing Maps</td>
<td>II-137</td>
</tr>
<tr>
<td>Exporting to CSV Format Available</td>
<td>II-138</td>
</tr>
<tr>
<td><strong>Database Enhancements</strong></td>
<td>II-138</td>
</tr>
<tr>
<td>Default Range Options When Importing MS Excel File</td>
<td>II-138</td>
</tr>
<tr>
<td>Controlling Treatment of Imported Excel Tables</td>
<td>II-139</td>
</tr>
<tr>
<td><strong>Tool Enhancements</strong></td>
<td>II-139</td>
</tr>
<tr>
<td>Instructions for Adding New Tools to the Tool Manager</td>
<td>II-139</td>
</tr>
<tr>
<td>Enhanced Split Polyline at Node</td>
<td>II-140</td>
</tr>
<tr>
<td>Using the Spider Graph Tool</td>
<td>II-141</td>
</tr>
<tr>
<td>Using the Distance Calculator Tool</td>
<td>II-142</td>
</tr>
<tr>
<td><strong>Universal Translator</strong> Upgrade Improves Log File Viewing</td>
<td>II-144</td>
</tr>
<tr>
<td>Universal Translator Upgrade Includes Finnish and JDG2000 Projections</td>
<td>II-146</td>
</tr>
<tr>
<td><strong>New Tool: The Synchronize Windows Utility</strong></td>
<td>II-146</td>
</tr>
<tr>
<td>COGOLine (Create Line by Length) Utility Improvements</td>
<td>II-147</td>
</tr>
<tr>
<td>Search and Replace Tool Updates Multiple Column Entries</td>
<td>II-149</td>
</tr>
<tr>
<td>GeoTracker Upgrade Completed</td>
<td>II-149</td>
</tr>
<tr>
<td><strong>Documentation Enhancements</strong></td>
<td>II-149</td>
</tr>
<tr>
<td>Updated the Coordinate Systems Section of the User Guide</td>
<td>II-149</td>
</tr>
<tr>
<td>Printing Guide 7.8 Updated</td>
<td>II-150</td>
</tr>
<tr>
<td>Upgraded ProViewer Documentation Available</td>
<td>II-150</td>
</tr>
<tr>
<td>Enhanced Line Style Editor Documentation Available</td>
<td>II-150</td>
</tr>
<tr>
<td>MapX Mobile Viewer Documentation To Be Available</td>
<td>II-150</td>
</tr>
<tr>
<td>MapInfo Professional Tutorial and Data Available</td>
<td>II-150</td>
</tr>
<tr>
<td><strong>Licensing Enhancements</strong></td>
<td>II-150</td>
</tr>
<tr>
<td><strong>MapBasic Enhancements</strong></td>
<td>II-151</td>
</tr>
<tr>
<td>WFS Support</td>
<td>II-151</td>
</tr>
<tr>
<td>MGRS Conversion Functions</td>
<td>II-151</td>
</tr>
<tr>
<td>Printing a Window to a File</td>
<td>II-152</td>
</tr>
<tr>
<td>Polyline Split at Node</td>
<td>II-152</td>
</tr>
<tr>
<td>Dot Density for Thematic Maps</td>
<td>II-152</td>
</tr>
<tr>
<td>Cartographic Legend Sample Size</td>
<td>II-153</td>
</tr>
<tr>
<td>Excel Column Import</td>
<td>II-153</td>
</tr>
<tr>
<td>Excel CSV Export</td>
<td>II-153</td>
</tr>
<tr>
<td>Running the MapInfo Professional Tutorial</td>
<td>II-154</td>
</tr>
<tr>
<td><strong>Appendix A: Working with Coordinate Systems and Projections</strong></td>
<td>II-156</td>
</tr>
<tr>
<td><strong>Working with Coordinate Systems</strong></td>
<td>II-157</td>
</tr>
<tr>
<td>Elements of a Coordinate System</td>
<td>II-157</td>
</tr>
<tr>
<td>Understanding Coordinate Systems</td>
<td>II-157</td>
</tr>
<tr>
<td><strong>Building Blocks of a Coordinate System</strong></td>
<td>II-162</td>
</tr>
<tr>
<td>Understanding Coordinate Systems, Projections, and their Parameters</td>
<td>II-162</td>
</tr>
<tr>
<td>Projection Types</td>
<td>II-163</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Datums</td>
<td>II-166</td>
</tr>
<tr>
<td>Units</td>
<td>II-174</td>
</tr>
<tr>
<td>Coordinate System Origin</td>
<td>II-174</td>
</tr>
<tr>
<td>Standard Parallels (Conic Projections)</td>
<td>II-175</td>
</tr>
<tr>
<td>Oblique Azimuth (Hotine Oblique Mercator)</td>
<td>II-175</td>
</tr>
<tr>
<td>Scale Factor (Transverse Mercator)</td>
<td>II-175</td>
</tr>
<tr>
<td>False Easting and False Northing</td>
<td>II-175</td>
</tr>
<tr>
<td>Range (Azimuthal Projections)</td>
<td>II-175</td>
</tr>
<tr>
<td>About Polyconic Coordinate Systems</td>
<td>II-175</td>
</tr>
<tr>
<td>Examples of Projection Entries in the MAPINFOW.PRJ File</td>
<td>II-176</td>
</tr>
<tr>
<td>New Projections in the MAPINFOW.PRJ File</td>
<td>II-178</td>
</tr>
<tr>
<td>Using the New Projection in a Coordinate System</td>
<td>II-179</td>
</tr>
<tr>
<td>Entering a New Coordinate System (Example)</td>
<td>II-180</td>
</tr>
<tr>
<td>Understanding Affine Transformations</td>
<td>II-181</td>
</tr>
<tr>
<td>Description of an Affine Transformation</td>
<td>II-181</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>II-184</td>
</tr>
<tr>
<td>For More Information</td>
<td>II-185</td>
</tr>
<tr>
<td>Contact Information</td>
<td>II-185</td>
</tr>
<tr>
<td>Appendix B: High-Resolution Custom Symbols</td>
<td>II-186</td>
</tr>
<tr>
<td>New High Resolution Custom Symbols</td>
<td>II-187</td>
</tr>
<tr>
<td>Enhanced High Resolution Custom Symbols</td>
<td>II-189</td>
</tr>
<tr>
<td>Appendix C: New and Enhanced MapBasic Statements and Functions</td>
<td>II-190</td>
</tr>
<tr>
<td>Appendix GL: Glossary of Terms</td>
<td>II-200</td>
</tr>
<tr>
<td>Index</td>
<td>II-215</td>
</tr>
</tbody>
</table>
Part I: MapInfo Professional 7.5 Supplement

This part contains the supplement for the MapInfo Professional 7.5 product. We are including this in this document so that you can have one resource for new features for the post-7.0 MapInfo Professional product.

Topics:

- Upgrading to MapInfo Professional 7.5 .................................................. I-10
- What's New in MapInfo Professional 7.5 ............................................... I-24
- Directory of MapInfo Professional Shortcuts ........................................ I-66
- Fill Patterns Used in MapInfo Professional ........................................... I-72
- New and Enhanced MapBasic Statements and Functions ...................... I-78
Upgrading to MapInfo Professional 7.5

This chapter helps you upgrade to MapInfo Professional® 7.5 and all of the components you require to run the product. In addition, there are instructions for fixing problems that come up as part of the upgrade process.

Sections in this Chapter:

- System Requirements for MapInfo Professional ............ I-11
- Before You Upgrade MapInfo Professional ................. I-11
- Upgrading MapInfo Professional ............................. I-12
- Modifying, Repairing, or Removing MapInfo Pro......... I-16
System Requirements for MapInfo Professional

These are the system requirements for MapInfo Professional 7.5:

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>Memory</th>
<th>Disk Space</th>
<th>Monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98 SE, Windows 2000 Professional SP 3, Windows NT 4.0 Workstation SP 6a</td>
<td>32 MB of RAM with a minimum of a Pentium PC</td>
<td>MapInfo Professional 103 MB Data 450 MB</td>
<td>16- or 24-bit color SVGA recommended</td>
</tr>
<tr>
<td>Windows XP Professional SP 1, Windows XP Home</td>
<td>64 MB of RAM with a minimum of a Pentium PC</td>
<td>MapInfo Professional 103 MB Data 450 MB</td>
<td>16- or 24-bit color SVGA recommended</td>
</tr>
</tbody>
</table>

**Note:** The Installer requires that your TEMP variable be set to a valid directory.

Handling Database Connectivity

MapInfo Professional supports the following relational database engines:

- The latest versions of Oracle Spatial, 9i and 9i Locator, while continuing support for 8.1.6 and 8.1.7.
- SpatialWare 4.6 on all of its supported platforms, including SpatialWare for Microsoft SQL Server versions 7 and 2000 and Informix 9.21 with linked tables and live access.

And, to make your database work more productive, MapInfo Professional 7.5 provides an interface for opening remote tables; the ability to easily save tables to a remote database using Save Copy As and to create new tables on remote databases; as well the means to create a new table from existing tables.

Have a favorite connection setting? Use the new Startup preference setting to automatically use that connection when beginning your session. Or, choose to make a connection from within three dialog boxes: Open, Create New Table, and Save Copy As. Additionally, resolving database conflicts is now simplified using the improved Conflict Detection for Live Access.

**Note:** Data Direct (Merant) ODBC drivers have been removed from the installer and from the MapInfo Professional product.

Before You Upgrade MapInfo Professional

Before upgrading MapInfo Professional, record your serial number in an easy-to-remember place, such as a manual title page. You need a valid serial number to complete the upgrade. Also, please complete the postage-paid registration card and return it to MapInfo Corporation. Additionally, you can register online by accessing the Contact Info option on the CD Browser.
If the MapInfo Professional 7.5 installer detects an existing version of the product, 6.0 or earlier, or detects that the product had been installed at some time, the installer copies the MAPINFOW.WOR, STARTUP.WOR and MAPINFO.W.PR F from the operating system's system directory to <user profile root>\Application Data\MapInfo\MapInfo.

Application data (appdata) files are the non-executable data files that MapInfo Professional uses during operation.

Navigating the MapInfo Professional 7.5 CD Browser

The initial screen of the MapInfo Professional 7.5 CD Browser includes these options:

- **Install Products**: From this option you can install MapInfo Professional (including DBMS support and translators), free data, access to the documentation, and Install Utilities, including: ECW Compressor, GPS, and Meta Data Browser.
- **What's New**: Display a list and description of new and enhanced features.
- **Online Reference**: MapInfo Professional 7.5 provides the following online reference documents: MapInfo Professional User's Guide (Unabridged), MapBasic Reference, Crystal Reports User's Guide, the MapInfo Professional Printing Guide, as well as the Adobe Acrobat Reader.
- **Run MapInfo Tutorial**: From this option you can run the MapInfo Tutorial to learn more about the basic features of MapInfo Professional.
- **Other Products**: Display information about MapBasic, MapInfo Discovery, and MapInfo Pro for SQL Server.

**Note**: To install the remote database connectivity tools, choose the **CUSTOM WORKSTATION INSTALLATION** option.

Upgrading MapInfo Professional

**CAUTION**: We strongly recommend that you exit from all Windows programs before beginning the upgrade process.

You must have Administrator rights to run the Installer on NT/2000 and Windows XP.

If your Windows Start menu does not have a MapInfo program folder, the upgrade process creates this folder. If your Windows Start menu already has a MapInfo program folder, the upgrade process creates a new MapInfo icon within that folder.

MapInfo Professional now provides its application data files to each user. Called a Per-User install, this functionality runs the first time you run MapInfo Professional or MapInfo Professional client on a machine, and each time the MapInfo Professional Installer is run thereafter. The application data files include, among others, the Pen Styles file, Custom Symbols files, Graph Support files, and Thematic Legend templates. These files allow different users to have custom settings.

To upgrade MapInfo Professional:

1. On the **LAUNCHER** menu, click **INSTALL PRODUCTS** from the MapInfo Professional CD Browser.
2. Click **MapInfo Professional**. The Install Shield Wizard dialog box displays. Click **NEXT** to continue the upgrade process and display the License Information dialog box.

3. Click **I ACCEPT THE TERMS** to accept the terms of the license agreement and click **NEXT** to continue the upgrade. The Customer Information screen displays.

4. Type your name, organization name, and serial number in these required fields. Click **NEXT** to continue. The Setup Type dialog box displays.

5. Review the following installation types and determine which instructions are appropriate for your upgrade. Click one of the following and click **NEXT** to continue:

   - **Typical Workstation Installation.** Click this option if you will be using MapInfo Professional as a desktop application requiring no remote database access or connectivity. See **Typical Workstation Installation on page I-13** to continue these upgrade instructions.

   - **Custom Workstation Installation.** Click this option if you require ODBC or Oracle Spatial connectivity support. See **Custom Workstation Installation on page I-14** to continue the upgrade instructions.

   - **Network Installation.** Click this option if you are upgrading your MapInfo Professional network product. See **Network Installation on page I-15** to continue the upgrade instructions. These instructions are for network administrators only. After you upgrade MapInfo Professional on the network, follow the instructions for upgrading MapInfo Professional on client equipment in **Setting Up Client Workstations on page I-16**.

If you have already upgraded to MapInfo Professional 7.5 or if the product has been previously installed, the Program Maintenance Screen displays. Select **MODIFY**, **REPAIR**, or **REMOVE** to continue. For assistance in completing this process, see **Modifying, Repairing, or Removing MapInfo Pro on page I-16**. If you find that you need to install ODBC drivers after installing MapInfo Professional, select the **MODIFY** option to add them.

## Typical Workstation Installation

Choose this option to install MapInfo Professional program files, Online Help, Tools, Universal Translator, and Crystal Reports. ArcLink is not selected.

**CAUTION:** Make sure you have completed the directions in **Upgrading MapInfo Professional on page I-12** before beginning these directions.

To continue upgrading a typical workstation:

1. In the Setup Type dialog box, click **Typical Workstation Installation**; the Destination Folder screen displays.

   **Note:** If you have an earlier version (or versions) of MapInfo Professional installed and you do not want to overwrite that version, create a new directory name in the next step.

2. Do one of the following:

   - Click **NEXT** to accept the destination folder indicated
   - Click **CHANGE** to create a new path in the Change Current Destination Folder dialog box. Type the new path in the Folder name field and click **OK** to continue. Click **NEXT** to continue.

   The Ready to Install the Program screen displays. Review your selections to ensure that the path is correct before moving on. Click **BACK** to return to the previous screens to make changes.
3. Click **INSTALL** to begin the upgrade. The Installing MapInfo Professional 7.5 screen displays with a progress bar indicating the status of the upgrade process.

   **Note:** After the upgrade is complete, the prompt: “Would you like to check our web site for any current updates to our product?” displays. If you have an Internet connection, check **YES** to be connected to the page of the MapInfo Corporation Web site containing information about product updates.

4. When the Installation Complete screen displays, choose **FINISH** to return to the Install Products screen.

**Custom Workstation Installation**

Choose this upgrade type to select components and drivers within the MapInfo Professional 7.5 installation program. This is particularly useful if you need to install MapInfo ODBC Connectivity support and Oracle Spatial Object support.

**CAUTION:** Make sure you have completed the directions in **Upgrading MapInfo Professional** on page I-12 before beginning these directions.

To continue upgrading using the custom workstation instructions:

1. In the Setup Type dialog box, click **CUSTOM WORKSTATION INSTALLATION**; the Custom Setup dialog box displays.

A feature description, and the space required for the feature and its sub-features displays in the Feature Description area.

2. In the Custom Setup dialog box you decide what components are to be installed and the directory you want them to install to. Click the feature icon to select the feature for installation. The options for a Custom Setup include:
   - **MAPINFO PROFESSIONAL**
   - **TOOLS (MAPINFO UTILITY TOOLS, CRYSTAL REPORTS)**
   - **TRANSLATORS (UNIVERSAL TRANSLATORS, ARCLINK)**
   - **HELP FILES**
   - **MAPINFO ODBC CONNECTIVITY SUPPORT**
   - **ORACLE SPATIAL OBJECT SUPPORT**
3. When you select a feature by clicking the DOWN ARROW beside it, a menu displays.

For each feature you want to install, choose one of the following:

- This feature will be installed on local hard drive.
- This feature, and all subfeatures, will be installed on local hard drive
- This feature will not be available

When you select option 1 or 2 described above, the feature will be installed on your local hard drive in the default folder. To specify another path, select CHANGE button to display the Current Destination folder dialog box.

To see if you have enough space on your hard drive or other mapped resources, click the SPACE button. The Disk Space Requirement dialog box displays the disk size, the amount of available space, and the amount of space the selected install would take.

Additionally, you can choose to not install a component.

4. After you select all the custom options you want to install, click NEXT to display the Ready to Modify the Program dialog box.

5. Click the INSTALL button to install the features you selected. The Installing MapInfo Professional 7.5 screen displays with a progress bar indicating the status of the upgrade process.

6. Install MapInfo Professional according to your selections.

Note: After the upgrade is complete, the prompt: “Would you like to check our web site for any current updates to our product?” displays. If you have an Internet connection, check YES to be connected to the page of the MapInfo Corporation Web site containing information about product updates.

Adding ODBC Drivers

You add the ODBC drivers as part of the Custom Installation process.

Network Installation

Installing MapInfo Professional on a network involves two separate procedures:

- Installing the product on a network drive (presumably done by the Network Administrator).
- Setting up users with program manager icons, etc. (presumably done by the user).

Make sure you have completed the directions in Upgrading MapInfo Professional on page I-12 before beginning these directions.

Choose this installation if you are a Network Administrator and have full rights to the network.

To continue upgrading MapInfo Professional on a network:

1. Click NETWORK INSTALLATION; the Administrator Selection Screen displays.
   The options for a Network Setup include:
   - MAPINFO PROFESSIONAL
   - TOOLS, TRANSLATORS
   - HELP FILES
A feature description, and the space required for the feature, displays in the Feature Description area. Click the option icon to select the option for installation.

2. When you select a feature, a menu displays allowing you to choose to install and/or run the feature and its subfeatures from various locations, including your local hard drive or from CD. If you select the hard drive option, the feature will be installed in the path indicated; on your local hard drive in the folder indicated; to specify a different location, choose Change to display the Current Destination folder screen.

If you choose to install an option to your hard drive, the SPACE button is enabled; choose this button to display the Disk Space Requirement dialog box.

Additionally, you can choose to not install a feature. See Installing MapInfo Professional on a Network Drive on page I-16 for additional details.

Note: After the upgrade is complete, the prompt: “Would you like to check our web site for any current updates to our product?” displays. If you have an Internet connection, check YES to be connected to the page of the MapInfo Corporation Web site containing information about product updates.

Installing MapInfo Professional on a Network Drive

The procedure for installing MapInfo Professional on a network drive is the same as the regular installation procedure except for the following:

- Select Network Installation in the Setup Type screen.
- Continue as in a Workstation Installation, selecting features, destination locations, etc.

The Network Installation alone does not install any files to the local hard drive.

Setting Up Client Workstations

To permit a user to use this network installation of MapInfo Professional, run SETUP.EXE:

1. Map a drive to the MapInfo Professional Install directory.
2. Select RUN from the Start menu.
3. Run SETUP.EXE from the [MapInfo install directory]\AddClient. The MapInfo Professional 7.5 Client Welcome screen displays.
4. Click NEXT. The License Information screen displays.
5. Click "I ACCEPT THE TERMS." Select NEXT. The Customer Information screen displays with the network install values as the default.
6. Modify for the current instance and select NEXT.
7. Click INSTALL to continue the installation.
8. Click FINISH to complete the client installation.

Modifying, Repairing, or Removing MapInfo Pro

Use the Program Maintenance feature of the CD Browser to modify, repair, or remove MapInfo Professional 7.0.

To access Program Maintenance:
1. Click **INSTALL PRODUCTS** from the MapInfo Professional CD Browser.

2. Click **MAPINFO PROFESSIONAL**. The Welcome screen displays. Choose **NEXT**. The Program Maintenance screen displays.

3. Choose modify, repair, or remove MapInfo Professional 7.5 based on your needs.
   - Click **MODIFY** to display the Custom Setup dialog box. See the instructions for Custom Workstation Installation on page I-14 for more about this process.
   - Click **REPAIR** to repair installation errors in the program.
   - Click **REMOVE** to remove an existing copy of MapInfo Professional 7.5 from your system. The installer displays the Remove the Program dialog box. Click **REMOVE** to uninstall the product’s programs from your system.

   You can also access the Program Maintenance screen from the Start menu by clicking **CONTROL PANEL** and then **ADD/REMOVE PROGRAMS** and finally **MAPINFO PROFESSIONAL 7.5**.

Controlling Advanced System Settings

MapInfo Professional has some advanced system settings—settings that cannot be configured through a dialog box. These settings allow you to control several low-level, technical aspects of how MapInfo Professional runs. Most MapInfo Professional users do not need to worry about these advanced settings.

For example, MapInfo Professional has a Dynamic Data Exchange (DDE) time-out setting, which controls how long MapInfo Professional tries to communicate with other applications during DDE communications. If you run a MapBasic application, and that application encounters time-out errors during DDE, you may want to increase the DDE time-out setting.

If you need to modify one of MapInfo Professional’s advanced system settings (such as the DDE time-out setting), use the following procedure.

**Modifying the Windows Registry**

MapInfo Professional stores system settings in the Windows registry. To edit the Windows 98 registry, use the REGEDIT program. To edit the Windows 2000 registry, use the REGEDT32 program.

**CAUTION:** Be very careful when editing the registry; damaging the registry can cause serious problems in your operating system.

For example, to set MapInfo Professional’s Dynamic Data Exchange (DDE) time-out setting, locate the following key in the registry:

```
HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo\MapInfo\Common
```

Within that key, edit the DDeTimeout value. If there is no value by that name, create a new value of type string (this data type is referred to as REG_SZ on Windows NT), and assign the name DDeTimeout to the value. Set the value’s data to be a number, representing the number of milliseconds (e.g., enter 30000 to specify a time-out of 30,000 milliseconds, or 30 seconds).

For more information on editing the registry, see the online help for REGEDIT or REGEDT32.
Descriptions of Advanced Registry Settings

This section describes advanced settings that are stored in the registry.

**DDeTimeout = number**

This setting controls MapInfo Professional’s time-out setting in DDE conversations where MapInfo Professional is the client (the application that initiates a conversation). The *number* represents milliseconds. The default value is 10,000 milliseconds (ten seconds). If you run a MapBasic application that attempts to initiate a DDE conversation, but the conversation fails because the server application does not respond within the time-out period, you may need to increase the DDeTimeout number.

**OffscreenBitmap = number**

The *number* is 0 (zero) or 1 (one). A value of 1 (the default) indicates that MapInfo Professional will process off-screen bitmaps when drawing a map. This means that if you cover a Map window, and then bring the Map window to the front again, the map redraws instantly. If you set this setting to zero, MapInfo Professional will not process off-screen bitmaps. This means that when you bring a Map window to the front, you may have to wait as MapInfo Professional redraws the map.

If you are using a video driver that is uncommon or buggy, and if you encounter video problems with Map windows, you may be able to eliminate those problems by setting the OffscreenBitmap number to 0.

**MaxFiles = number**

This setting must be an integer from 10 to 100, indicating how many files MapInfo Professional can open simultaneously. This setting does not limit the number of tables you can open, but it does limit the number of tables you can edit at one time (the number of tables that have unsaved edits). The default value is 29. If you need to work with more files simultaneously, set *number* to 100.

**MaxORACLETILES = number**

A value from 0 = unlimited tiles to infinity.

**Improving Performance**

To improve MapInfo Professional’s performance, increase the speed of the processor in the machine. A video accelerator card will increase the speed of the redraw. It will not speed up the initial draw of the map, but all subsequent redraws will be faster. A faster disk cache will also improve performance, as will adding memory.

**Controlling the Location of Application Data Files During Installation**

By default, the setup program for MapInfo Professional installs application data files to locations that make sense for the typical user. After installing the product, the user is free to move one or more of the application data files to another predefined location and MapInfo Professional will find that file. For example, the administrator of a machine might move MAPINFOW.PEN from the per user area (its default location) into the install directory so all users on that machine will share the same set of pens.

For IT personnel responsible for a large number of MapInfo Professional installs it is not practical to manually move application data files to realize the desired configuration.
To solve this problem we have developed a solution that allows IT personnel to specify the location of application data files by creating a setting file, call MODE.INI, prior to installing MapInfo Professional.

1. Create a MODE.INI file in the root directory of the installer.
2. Open MODE.INI into any text editor.
3. Edit MODE.INI, modifying the code of the application data file/group whose location you wish to change.
4. Install MapInfo Professional.

The following is a list of predefined locations for application data files supported by MapInfo Professional, and the corresponding numeric code to be used in MODE.INI.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>per user, roaming</td>
<td>&lt;Current User&gt;\Application Data</td>
</tr>
<tr>
<td>2</td>
<td>per user, not roaming</td>
<td>&lt;Current User&gt;\Local Settings\Application Data</td>
</tr>
<tr>
<td>3</td>
<td>per machine</td>
<td>&lt;All Users&gt;\Application Data</td>
</tr>
<tr>
<td>4</td>
<td>program directory</td>
<td>&lt;Install Dir&gt;</td>
</tr>
</tbody>
</table>

The following is a list of application data files/groups and their default location:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAPINFOW.CLR</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.PEN</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.FNT</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.ABB</td>
<td>program directory</td>
</tr>
<tr>
<td>MAPINFOW.PRJ</td>
<td>program directory</td>
</tr>
<tr>
<td>MAPINFOW.MNU</td>
<td>program directory</td>
</tr>
<tr>
<td>CustSymb</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>ThmTmplt</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>GraphSupport</td>
<td>per machine</td>
</tr>
</tbody>
</table>

**MODE. INI File Example**

Create a text file with the following syntax:

GraphSupport = 3
CustSymb = 1
ThmTmplt = 1
Installing Data

To help you get started, MapInfo provides you with some United States-based and world-wide maps you can use as a background to your data. Use these instructions to install this free data.

To install the free data provided with MapInfo Professional 7.5:

1. Choose INSTALL PRODUCTS from the CD Browser.
2. Choose FREE DATA to display the MapInfo Professional Data screen. In this screen, you can also review the data specifications, access new data over the web and learn about what data is available from MapInfo Corporation.
3. Choose INSTALL FREE DATA. The Welcome screen displays.
4. Choose NEXT to continue. The License Information screen displays.
5. Choose YES to accept the terms of the agreement and to continue the installation process. The Choose Destination Location screen displays.
6. Select the product for which you will be installing the data. Select one of the following:
   • MapInfo Professional
   • MapInfo Run Time
   Click NEXT to continue.
7. Specify the directory where the data will be installed. Use the Browse button to select a directory if necessary or accept the default directory.
   Click NEXT to continue.
8. Choose one of these options:
   • CUSTOM INSTALL: Choose which datasets to install. Select the check box beside each dataset you want to install. The size of each dataset displays, as well as space required and space available.
     To see the subcomponents of the data you selected, click CHANGE.
   • TYPICAL INSTALL: Install all datasets.
     Choose NEXT to continue. Respond YES to the "Would you like setup to display workspace Icons" prompt if you want to create an icon for each data set you choose.
9. The Select Program Folder screen displays if you chose to set up Workspace icons. Select the program folder where the icons will be created. Choose NEXT.
10. The Start Copying Files screen displays. Review the selections you have chosen and click BACK to return to any screen to change your selections. When you are ready to begin the installation, click NEXT.
11. The Setup Complete dialog box displays; click FINISH.
Getting More Data

To learn more about our data products, click the **GET MORE DATA** option in the MapInfo Professional Data screen during the Data Installation process or click **MAPINFO DATA PRODUCTS ON THE WEB** in the Help Menu. If you have a Browser installed, you will be automatically connected to MapInfo Corporation’s web site, where we provide detailed information about MapInfo’s World Wide Data Products. We have over 350 data products to choose from—products that provide both reliable and current information.

Installing Related Programs, Hardware, and Resources

This section contains the instructions for installing the ECW Compressor, the MetaData Browser, the Blue Marble GPS, and the documentation associated with MapInfo Professional. We also include information about the Microsoft Intellimouse and how to use it.

Installing ECW Compressor

The ECW raster handler allows you to open and display raster images compressed in the ECW format. We recommend that you exit all Windows programs before installing.

1. Choose **INSTALL PRODUCTS** from the MapInfo Professional 7.5 CD Browser.
2. Choose **ECW COMPRESSOR**. The Welcome screen displays. Choose **NEXT** to continue the installation process.
3. The Software License screen displays. Choose **YES** to accept the terms of the agreement and to continue the installation process.
4. The Choose Destination Location screen displays. Specify the directory where ECW Compressor will be installed.
5. The Select Program Folder screen displays. Select a folder. Choose **NEXT** to continue.
6. The Setup Complete screen displays: choose to display the ReadMe file and/or create a shortcut on your desktop. Choose **FINISH**.

Installing Meta Data Browser

The MetaData Browser allows you to search data clearinghouse web sites for data products that meet your geographic analysis needs. We recommend that you exit all Windows programs before installing Meta Data Browser.

1. Choose **INSTALL PRODUCTS** from the MapInfo Professional 7.5 CD Browser.
2. Choose **META DATA BROWSER**; the Introduction screen displays.
3. Choose **NEXT** to continue the installation process. The License Agreement screen displays.
4. Choose **YES** to accept the terms of the agreement and to continue the installation process. The Choose Install Folder screen displays.
5. Specify the directory where Meta Data Browser will be installed. Select **CHOOSE** to display a list of directories.
6. Choose the Shortcut location. You have the option to put the icon in a new group, into the MapInfo group, in the Start menu, on the Desktop, or to display no icon.
7. Click **INSTALL** to begin the installation.
8. After installation is complete, select **DONE**.
Using the Microsoft IntelliMouse™ to Move Around the Windows

MapInfo Professional supports the Microsoft IntelliMouse™ as follows:

**Document Scrolling:** In the Map, Layout, Browser, and MapBasic windows, hold down the **CONTROL** key and move the wheel to scroll the document vertically; the effect is the same as clicking on the arrow at the end of the scroll bar.

**Document Panning:** In the Map and Browser windows, hold down the wheel button on the IntelliMouse™ and move the mouse to pan the document. Release the button to end the panning. There are three panning speeds. The speed of the panning is based on the cursor’s distance from the starting point, indicated by the origin mark. In the Map window, the distance moved at each speed is a percentage of the zoom distance.

For example, the amount to move at slow speed is. 005 * ZoomDistance, medium speed is. 01 * ZoomDistance, and super speed is .1 * ZoomDistance. In the Browser, the window is scrolled by 1, 3, and 7 lines or columns for slow, medium and super speeds. When the cursor is within 15 pixels of the starting point, there is no panning.

**AutoScroll:** In the Map and Browser windows, click and release the wheel button to activate AutoScroll. When the mouse cursor is moved away from the starting point the document starts to scroll in whatever direction you move the mouse. When the cursor is returned to the starting point, scrolling stops. AutoScroll is turned off by any mouse click or key stroke. AutoScroll is also turned off when MapInfo Professional loses the focus, for example, when you **ALT-TAB** to another application.

**Zoom:** In the Map and Layout windows, move the wheel forward to zoom in on the document. Roll back the mouse wheel to zoom out on the document. The wheel has a series of settings; each “click” is the same as one click with a zoom tool. The mouse wheel does not recenter the view. There are other keyboard commands that allow you to zoom in and out more precisely. Review the **MapInfo Professional 7.5 User’s Guide (Unabridged)** on your MapInfo Professional 7.5 Installation CD for more information.

**Installing Global Positioning Software (GPS)**

To install Global Positioning Software from Blue Marble:

1. From the CD menu, click **INSTALL PRODUCTS** and then **FREE UTILITIES**.
2. Click **INSTALL GPS SUPPORT**. You will be prompted to exit all applications before installing. Choose **OK**.
3. The MapInfo Special Edition dialog box displays. Choose **OK**.
4. The Select Destination Location screen displays. Specify the directory where GPS will be installed.
5. The Software License screen displays. Choose **YES** to accept the terms of the agreement and to continue the installation process.
6. The Add to the Start Menu dialog box displays: click **YES** to add a shortcut to the **START** menu.
7. The ReadMe displays; choose **OK** to exit the ReadMe.
Installing the Online References


To install the documentation locally:

1. Install the Acrobat Reader.
2. Copy the files from the [CD_ROM]\PDF_DOCS folder to a local directory.
3. From Windows Explorer, double-click any of the PDF files to automatically launch the Acrobat Reader and the online book.

Troubleshooting your Installation

Here are issues you may encounter during your installation and correcting the problems associated with them.

**Temp Variable**
The MapInfo Professional Installer requires that your TEMP variable is set to a valid directory to which the user can write.

**Other Issues**
The Installer must be run from a drive with a letter such as G: and not from an explicit UNC path. For example, you might have the MapInfo Professional CD in your computer as USERSPC. Other users may share this device as USERSPC; however, it would not contain a drive letter. The MapInfo Professional Installation program requires a drive letter. To remedy this situation:

1. Right-click the shared directory or CD-ROM and select MAP NETWORK DRIVE.
2. Choose a drive letter to map.
3. Run the Installation Program again from the newly mapped drive letter.

Removing MapInfo Professional from your System

Remove MapInfo Professional 7.5 by accessing the CD Browser, Program Maintenance screen, or by choosing the Add/Remove program option from the Control Panel in Windows, 98, 2000, Windows NT or Windows XP.

Using the MapInfo Professional 7.5 CD Browser to Uninstall

To uninstall MapInfo Professional 7.5:

1. Choose INSTALL PRODUCTS from the CD Browser.
2. Choose MAPINFO PROFESSIONAL. The Welcome screen displays. Choose NEXT.
3. The Program Maintenance Screen displays. Choose REMOVE.
What’s New in MapInfo Professional 7.5

Thank you for upgrading to the most advanced computer mapping product in the MapInfo family! As the field of computer mapping continues to expand, MapInfo leads the way with new products that are designed to fulfill your computer mapping needs from the most basic to the most specialized with MapMarker, our premier address matching product.

Among the features of this release are the inclusion of the Web Map Service client, major enhancements to the raster registration process and GML import.

The MapInfo Professional 7.5 User’s Guide (Unabridged) provides comprehensive coverage of the changes in MapInfo Professional 7.5 and covers the breadth of the product. This guide is available in .PDF format on your MapInfo Professional 7.5 Installation CD.

Sections in this Chapter:

- New Major Features of MapInfo Professional 7.5 . . . . . . . . . . . I-25
- Printing Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-36
- Database Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-39
- Datum Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-40
- Mapping Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-40
- Add In Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-61
- Menu Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-62
- Tool Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-63
- EasyLoader Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-65
- MapBasic Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-65
New Major Features of MapInfo Professional 7.5

There are several exciting new features in MapInfo Professional 7.5. These innovations are the results of requests from many of our customers and are in response to changes and growth in the computer mapping industry. We are very excited to bring these changes to you in this release.

Accessing Web Map Services

MapInfo has created an interface to allow you to use maps available over a network or over the Internet. We conform to the Open GIS Consortium’s specification so we can offer you this functionality.

Displaying and Importing Data from a Web Map Service

A Web Map Service (WMS) is a technology that gives you a source for data over your Intranet or over the Internet. This innovation is based on a specification from the Open GIS Consortium (OGC) and allows you to use raster map images from servers that also comply with the specification. You must specify the coordinate system within your data request to ensure that the images you retrieve “sync up” or register with your other map data.

This specification supports transparent pixel definition for image formats as well. This allows you to use the images you retrieve as overlays and not solely as the bottom layer of your map.

This is a very new technology and WMS may not exist for the geography you are looking for. Further, the data that is provided is determined by the WMS Server.

Note: You must have a working Internet connection whenever you retrieve or use WMS data.

To access WMS data and build a .tab file:

1. On the FILE menu, click OPEN WMS or click to display the Open WMS Table dialog box.

The order of these layers determines their display order.

Click the MOVE UP and the MOVE DOWN buttons to arrange the layers appropriately.
Note: The WMS Servers that display in the WMS Server list are based on a list we have compiled for you. MapInfo has no control over the availability of these servers at any given time. The availability of WMS data depends upon the status of the server and the status of the maps on those servers. You can customize this list to suit your needs.

2. To work with the layers from a particular server, select a WMS Server from the WMS Servers drop-down list.

To see the details of a particular WMS Server, including the Server URL, the Server Name, version, and usually a server supplied description, click DETAILS.

If you do not see the server you are looking for in the WMS Server drop-down list, click the SERVERS button to display the WMS Servers List.

To add new WMS Servers to the WMS Servers List, click the ADD button to display the WMS Server Information dialog box. Here you can add the new web server address and description in the fields provided. The WMS Server Information dialog box also displays when you click the EDIT button in the WMS Servers List to allow you to change these entries.

Type the URL you want to add in the Server URL field. Click TEST URL to ensure that MapInfo Professional can find the server. Click GET DESCRIPTION to get the server provided description or type in a description. Click OK to return to the WMS Servers list.

In the WMS Servers list, click the SET DEFAULT button to select a default server in the list. The default server will be selected the first time you open the WMS Table dialog box. When you set a default WMS server, a check mark displays beside it. If you do not select a default server, MapInfo Professional displays the first server in the list when you begin your WMS Server session.

Note: If you work with a WMS Server that is not the default, MapInfo Professional remembers that new server for the rest of the session and returns to it whenever you return to the Open WMS Table dialog boxes.
3. When you have completed your work in the WMS Servers List, click OK to return to the Open WMS Table dialog box.

4. Review the list of available layers for the server you selected and do one of the following:
   • Double-click one or more layer(s) you want to retrieve in the WMS Layers list to move them to the right pane
   • Click each layer you want to retrieve from the server and click Add to move them to the right pane

   **Note:** The topmost layers display over the bottom most layers.

5. Decide how you want to use these WMS server layers and do one of the following:
   • To create a single .tab file with several WMS layers in it, select all of the layers for that .tab file so they display in the right pane. Then organize them in the order you want them to display using the Move Up and Move Down buttons.
   • To create individual .tab files for the WMS server layers you want, select one layer at a time, select the appropriate Style, Format, and Projection options from their drop-down lists and save the .tab file. Repeat this process for each layer you want to retrieve.

   Using either method, you move the layer(s) you selected to the right pane. The Style, Projection, and Image Format information associated this layer or layers change to reflect either the attributes of the single layer or the attributes that all the layers have in common. We describe the process for changing and selecting these attributes below.

   **Note:** To remove a layer from the list in the right pane, select the layer you want to remove and click the Remove button.

6. If there are styles associated with the layer(s) you selected, they display in the Style drop-down list. Styles indicate the visual display options available with this layer and are supplied by the web server. Initially, we display the selected layer in the server’s default style. The style that displays pertains to the currently selected layer.

   To change the style of a layer, click it in the left or right pane and select the style from the Style drop-down list. The styles you select for a layer do not pertain to any other layer in the list.

   **Note:** You can also change these image display style attributes later (on the Map menu, point to Layer Control and click Display override options. In this dialog box you can change the image’s translucency and transparency as well as other raster display properties available in MapInfo Professional.

7. Choose a format for the layer from the Image Format drop-down list. The options that display in this list may differ depending upon the formats the server supports and the formats we support. We support: PNG, JPEG (JPG), TIFF (GeoTIFF and TIFF) and GIF formats, in that order of priority.

8. To change the background options, specify them in the Image Background box. To make the background of your layer transparent, click the Transparent check box and select the color of the background. Click the Color button to display the list of colors.

   **Note:** The more color depth the image has, the more difficulty you have isolating the background for transparency purposes. If you experience problems with transparency with one image format, try another, if it is available.

9. The Coordinate Reference System Projections drop-down list displays all of the projections that the selected layers have in common. This list is disabled when the selected layers do not have any projections in common. If the Projections drop-down list is disabled, you cannot make a map request.
Note: To enable this list, try removing layers one at a time to see if the problem is caused by layers not having projections in common.

10. To enter a name for this table, do one of the following:
   • Click the button at the end of the TABLE FILENAME field to display the Please specify a TAB filename dialog box. Select the path and type the file name in the FILENAME field and click OK.
   • Type the path into the TABLE FILENAME field

Note: There are three conditions that might prevent you from saving the .tab file at this point. To save the .tab file you must:
   a. Select at least one valid layer from the WMS Server list
   b. Layer(s) must contain a supported projection
   c. Type a valid .tab file name

11. Select the view for this map in the PREFERRED VIEW drop-down list to determine where the WMS table should display after you open it. Options include: Automatic, Current Mapper, New Mapper, and No View.

12. Click OK to generate the WMS map request.

Once you have saved a WMS table name, you can change its WMS layer settings using the WMS Table Properties dialog box. To access this dialog box, go to the TABLE menu and click WMS TABLE PROPERTIES. When the WMS Table Properties dialog box displays, select the layer you want to edit and change the settings for that layer. You can also add, remove, and reorder the WMS layers, change the projection, image formats, and background options of the layers. Remember, you can edit the display attributes for the WMS table using Display Style override commands in Layer Control.

How Does MapInfo Professional Use WMS Servers?

When you create a .tab file from WMS Server layer(s), you are actually creating a pointer to an XML file that keeps track of the data you selected, (the server address, the selected layer(s), the styles, the format, and the projection settings). You never actually retrieve the data and save it on your computer. Every time you add a WMS Server table as a layer in a Map window or you change the view of the Map, the system generates a map request and retrieves the layer information. To do this, the .tab file points to an XML file which retrieves the information from the WMS Server and displays it on your computer. If you are not connected to the Internet, the server is unavailable, or the WMS layer(s) you are retrieving are not available, you cannot use the WMS .tab file.

Projection Issues Associated with WMS

The coordinate system used in the map image is very important. It is what enables various layers to line up properly. Make sure you retrieve WMS Server images that you can use with the other maps you use. Keep in mind that the raster layer always determines the projection of the map. If there is more than one raster layer in a map, the largest raster layer determines the projection of the map.

Raster Registration Enhancements

We have enhanced the raster registration process to make it quicker and easier to use.
Registering the Coordinates of a Raster Image

Before you can overlay vector data on top of a raster image, you must first register the raster image so that MapInfo Professional can position it properly in a Map window. In the Image Registration dialog box, you can identify control point coordinates and specify the appropriate projection for the raster image.

Control points are the coordinates you identify on the raster image that MapInfo Professional can use later to match up to other layers. It is very important to provide accurate control point information when registering a raster image, so MapInfo Professional can display raster images without distorting or rotating them. Later, when you overlay vector data, MapInfo Professional distorts and rotates the vector data so both layers can line up properly. Identifying significant control points makes this match up process easier. We suggest you use highway/street intersections and prominent landmarks as control points, as they rarely move.

Specifying the correct projection of the raster image is also important for accurate display. Images that do not have known projections, such as unrectified aerial photographs, are less suitable for use with vector data.

There are two ways to register a raster image in MapInfo Professional. Each involves specifying the map coordinates of control points on a reference map and matching them with equivalent points on the raster image. To determine map coordinates, you can:

- Identify a point’s coordinates from the paper map.
- Determine a raster images control point coordinates on screen and automatically transfer the information to the Image Registration dialog box.

Note: If you scanned in the image from a paper map, the map most likely contains a graticule (latitude and longitude grid). You can choose those coordinates for prominent features and enter them in the Image Registration dialog box.

To register the coordinates of a raster image and create a .tab file from the raster image:

1. On the **FILE** menu, click **OPEN** and specify the Raster Image file format in the Files of type drop-down list.
2. Choose a raster image file and choose **OPEN**. The Display/Register dialog box displays.

3. Click **REGISTER** to display the Image Registration dialog box.
4. Choose the **PROJECTION** button to specify the raster image’s projection. It is easier to match up the maps if you select the same projection for the raster image as the vector images (layers) you want to use. Choosing the same projection minimizes image distortion when overlaying the vector map layers. You cannot change the projection from the Map window.

**Note:** If you do not set the projection, MapInfo Professional defaults to Longitude/Latitude or to the default table projection set by using the map window preferences you set.

5. You can set the units for the control point entries by clicking the **UNITS** button.

6. To select the actual coordinates to register in the raster image, click the **ADD** button to add a new entry into the **CONTROL POINTS** list box. The Add Control Point dialog box displays.

7. Specify the coordinates from the paper map in the dialog box. The location of each point is marked on the preview image with a “+” symbol. You can change the Label to something more meaningful to you, such as US85/LA132, to describe an intersection in the raster map. You might also select a prominent building or other very specific address that is easily identifiable in both maps.

8. Repeat this process (**step 6** and **step 7**) until you have registered at least three or four points on the raster image. Try to vary the position of these control points to better define the map. If too many points are in a straight line, an error displays.

If you are working with an image for which you do not know the projection (such as an aerial photograph), enter at least three control points to improve accuracy.
When you have completed your control point entries, click **OK**. The raster image displays as a .tab file. Use the + and - buttons to zoom in and out of the raster image. Zooming in on the image may help you obtain greater accuracy in control point location. If you are having difficulty finding a control point in the Image Registration image, click the control point entry in the Image Registration list and click the **FIND** button to display the point in the image.

**Transferring Vector Map Coordinates Directly to a Raster Map**

To transfer the coordinates automatically from a vector map to a raster image, you need a vector map of the same image. Then, you display the vector map side by side with the Image Registration dialog box, which shows a preview of the raster image. Click a prominent feature in the vector map to determine its coordinates and transfer this control point to the Image Registration dialog box.

To transfer a vector map’s coordinates to a raster image:

1. On the **FILE** menu, click **OPEN** and Raster Image file format.
2. Choose the raster image file and click **OPEN**. The Display/Register dialog box displays.
3. Click **REGISTER**. The Image Registration dialog box displays. A preview of the raster image appears in the lower half of the dialog box.
4. Choose the **PROJECTION** button to specify the image’s projection. If you do not set the projection, MapInfo Professional defaults to Longitude/Latitude or to the default table projection set in the Map Window Preferences.
5. To add control points, click the **ADD** button to add a control point entry to the Control Points list.
6. Click the **PICK FROM MAP** button and select a location in the Map window that matches a location in your raster image. MapInfo Professional updates the Map X and Map Y fields in the Edit Control dialog box with the new coordinates. Click **OK** to save this entry and close the dialog box.
7. Click the entry in the **CONTROL POINTS** list and click the matching control point location in the image pane. The Edit Control Point dialog box displays showing the control point’s location in pixels in the Image X and Image Y fields. Click **OK** to save these entries.
   **Note:** Remember to type a meaningful description of this location in the **LABEL** field.
8. Repeat this process until you have identified three or four non-linear points in the preview pane of the Image Registration dialog box.
9. After you have defined all of the control points, click **OK** in the Image Registration dialog box. The raster image displays in the Map window under the vector layer.
   Use the Layer Control feature to position the raster map appropriately with your vector layers.

**Create Points Changes**

We have added two new enhancements to the Create Points functionality. The first change: you can optionally use numeric data in non-numeric columns (i.e. columns with a character-based format). We made this change to make it easier to create points from sources where the numeric values appear in columns not specifically flagged as numeric. The second change allows you to replace existing objects with new point objects without deleting the existing geographic data first. You do not have to clear the Table is Mappable check box in the Table Structure window to get these results.
You may have a file that already contains X and Y coordinates, but not the point objects themselves that you want to display in MapInfo Professional. While the geographic information exists in the table, MapInfo Professional needs to create points to represent these coordinates before displaying them in a Map window. The Create Points command under the Table menu allows you to create points for each record in your database that has X-Y coordinate information.

**Note:** MapInfo Professional uses the coordinate fields in your table to create point objects. Records that already have graphic objects associated with them will be skipped during the Create Points operation.

For example, you have a table showing transmitter tower locations that was created by recording coordinates using a global positioning system. You want to display the locations on a map in MapInfo Professional. The table already has X and Y coordinate information but MapInfo Professional cannot display this information until you create points for that coordinate data that MapInfo Professional can read.

To create points:

1. Open the table for which you want to create points.
2. On the **TABLE** menu, click **CREATE POINTS**. The Create Points dialog box displays.

3. Choose the appropriate table from the drop-down list.
4. Select the columns in which the X and Y coordinates display from the Get X and Y coordinate information lists, the lists default to XCOORD and YCOORD.

   **Note:** If you select the same table for the X and Y coordinates, a warning message displays, prompting you to make a change. Click **OK** and change the selections in these drop-downs.

5. The Multiply X and Y coordinates by options allow the user to place a multiplier on the coordinate columns if necessary. To specify a projection other than longitude/latitude or the default Table Projection preference, choose projection. In some cases you will need to specify a negative multiplier depending on the locations quadrant. For locations in North America the X coordinate is negative. In Africa and Australia, the Y coordinate is negative. For locations in and around South America both coordinates are negative.

6. Select the appropriate check boxes:
   - **DISPLAY NON-NUMERIC DATA** — Select this check box if the data you want to create points for is in text fields in the original table. MapInfo Professional will attempt to convert the text values to numbers. If the values are not numbers, MapInfo Professional will not create an object for that record. This check box is automatically selected and disabled when the table you have selected does not contain two numeric fields.
   - **OVERWRITE EXISTING POINTS** — Select this check box to replace the existing objects in the current map with points based on the data contained in this table.
7. Click **OK**. MapInfo Professional updates the table to create point objects.

8. To display the table, on the **WINDOW** menu, click **NEW MAP WINDOW**, or choose **MAP** menu, point to **LAYER CONTROL** and click **ADD** to add the table to an existing map.

---

**New Shortcuts throughout MapInfo Professional**

For a comprehensive list of currently valid shortcuts, see *Directory of MapInfo Professional Shortcuts* in Appendix A on page I-66.

**Additional OSGB/GML Support**

As of this release, you can import GML files in the OSGB schema 2.0 and 3.0 as .tab files. You can now import address and transportation routing layers into MapInfo Professional. You can now import different feature types in the Topographic Layer as separate tables to enhance your ability to isolate this information in different layers.

**Importing GML File Data into .Tab Files**

Many of our international customers want to display MasterMap GML files developed by the Ordnance Survey of Great Britain (OSGB). Customers using versions 7.0 and 7.5 can display these GML files using the Import command. In version 7.0, we provided support for some of the Topography features (OSGB version 2.0), Topographic Area, Lines and Points, Cartographic Symbols and Boundary Lines. In version 7.5, we maintain support for these features and add support for Cartographic Text and Departed Features.

Currently, we support the OSGB recommended styles by mapping the style definitions to existing MapInfo Professional styles. Where it is not possible to render complicated fill patterns, we use the simple dot screen that the OSGB recommended to us. You cannot change the OSGB style mapping to MapInfo styles.

To import GML data into a .tab file:

1. On the **TABLE** menu, click **IMPORT** and navigate to the folder containing your GML files.
2. In the **Files of Type** drop-down list, select the OS MasterMap (*.GML) option to display the available GML files in the directory. Select the file you want to open and click **Open**. The GML Import dialog box displays.

![GML Import dialog box](image)

3. Click the **Select GML Layer to Import** drop-down list to display the layer options.

![Select GML Layers to Import](image)

**Note:** When you select the DepartedFeature layer, MapInfo Professional imports only the changed features of the selected layer.

4. Do one of the following:
   - Select the layer in the list you want to import.
   - Select the **All Layers** option to import all of the layers and convert them to individual .tab files.

*MapInfo Professional 7.0 Users:* You may only see the Topographic Area feature type in this list.

*MapInfo Professional 7.5 Users:* You may notice that both the TopographicArea feature type and the LandformArea feature type display in this list. You can choose to save each of these feature types as a separate table as of this version.

For more about these layers and feature types and how MapInfo Professional handles the Topographic Layer, see [Understanding MapInfo Professional’s Use of the Topography Layer on page I-35](#).

5. Choose the style you would like to use to display the GML file. Choose one of the following:
   - Click **Use GML Style** to display the selected file using the OSGB GML styles
   - Click **Use MapInfo Current Style** to display the selected file using your currently established styles. MapInfo Professional uses the style preferences you selected in the Style Preferences dialog box if you have not already modified them in the current Map window.

6. After you have made these selections, click **OK**. One of these dialog boxes displays:
   - If you selected one layer in **step 4**, the Import to Table dialog box displays. Choose the directory and file name you want for this file and click **Save**. MapInfo Professional saves the file to this directory. Go to **step 7** to continue.
   - If you selected **All Layers** in **step 4**, the Choose Directory dialog box displays. Select the directory you want MapInfo Professional to place the new .tab files in and click **OK**. A status box displays showing the progress as each layer is converted and saved into a separate .tab file.

7. To open the GML files that are now .tab files, choose **Open** from the **File** menu and navigate to the directory you specified.
Understanding MapInfo Professional’s Use of the Topography Layer

OSGB MasterMap’s Topographic Layer contains nine themes including roads, tracks and paths, buildings, landforms, water, height, heritage, structures, and administrative boundaries. You can import these themes as TopographicArea, LandformArea, TopographicLine, TopographicPoint, CartographicText, CartographicSymbols, BoundaryLines, and DepartedFeatures. The TopographicArea feature type contains two 'complexes', Topography and Landform, which contain different polygons of information. The Landform polygons overlap the Topography polygons (which represent land features like slopes and cliffs).

In MapInfo Professional 7.0, we imported the TopographicArea and LandformArea into a single table, which can result in the features displaying in random order. This can lead to TopographicAreas masking Landforms.

In version 7.5, we split the TopographicArea feature type output into two layers so it is possible to save them in different tables. The TopographicArea table now contains only output whose areas defined in the OSGB user guide as being part of the Topography complex or Structuring Layer.

Note: There is a feature type in the GML Import dialog box called LandformArea, which allows the creation of the LandformArea table.

Improved Resolution for 3D and Prism Maps

In the past, if you wanted to create a 3D or prism map, the resolution of the textured image was restricted by the resolution of the original map window. You could create a larger map window, but the resolution would not be as detailed. We have improved the way we generate the texture for 3D Map windows to maximize the resolution of the underlying map window. This gives you a much better looking image to display on the final geometries. The final textured image on the 3DMap should always look the same without regard to the size of the original map.

Review these examples from MapInfo Professional 7 and in MapInfo Professional 7.5:

Image Version 7.0:
Printing Enhancements

MapInfo Professional 7.5 Printing Guide

We have done extensive work to enhance printing for this release and have updated our Printing Guide with those results. See the MapInfo Professional 7.5 Printing Guide on the MapInfo Professional 7.5 Installation CD for a complete summary of these changes and for specific coaching on how to print high quality maps and layouts.

Additional Fill Patterns

We have increased the fill pattern image size (up to 32 x 32 pixels) and added new fill patterns to enhance the look of your maps. To access these additional patterns on the OPTIONS menu, click REGION STYLE and scroll to the bottom of the PATTERN drop-down list to display the new patterns. These patterns were created in response to customer requests. For a complete list of the new patterns, see Fill Patterns Used in MapInfo Professional in Appendix B on page I-72.

Printing Fill Patterns to Match Screen Display

We have added a Scale Patterns check box to scale non-transparent fill patterns in your print output to more closely match what you see on the screen. This check box displays on both the Advanced Print Options and the Output Preferences dialog boxes. You can only enable this option for printing (not when exporting or when using the Clipboard).

Note: When you export or copy to the Clipboard, we automatically scales the non-transparent fill patterns to match the resolutions you requested, so there is no selectable option in that case.
Setting your Output Setting Preferences

The Output Settings allow you to control raster and grid file color settings for on-screen display, printed output, and file export settings. In addition, you can also specify how you want to handle transparency in vector and raster files in both your printed output and exported files. Other printer settings enable you to specify an output method, map scaling, and whether to print a border around a Map window.

You can override the settings in the Output settings preferences in the Advanced Printing dialog box. These preferences represent the default settings used in the Advanced Printing dialog box. These new settings can then be saved in a workspace.

Note: You can get additional printer advice in the MapInfo Professional Printing Guide on the MapInfo Professional 7.5 Installation CD.

To set your output preferences:

1. On the OPTIONS menu, point to PREFERENCES and click OUTPUT SETTINGS to display the Output Preferences dialog box.

2. The DISPLAY settings control the on-screen display of a raster or grid file. Click the appropriate output settings based on your output requirements.

These entries explain the display settings, the printing options, and window export options in this dialog. Some of the options appear in more than one dialog so we have grouped all of the like explanations together.

- **DISPLAY RASTER IN TRUE COLOR WHEN POSSIBLE** — Click this check box to display your 24-bit raster or grid file images in true color (make sure your display settings are set to greater than 256 colors). Clear this check box if you only want your images to display using 256 colors. This box is checked by default.

- **DITHER METHOD** — Dithering is a technique that blends pixels electronically to improve the look of an image. Click a dither method when you are converting a 24-bit image to 256 colors.
Dithering creates the illusion of complex colors by using a pattern of finite (fixed) color dots. For example, to create the color green using dithering, the color would consist of a pattern of yellow and blue dots.

**HALFTONE** dithering calculates a series of half tone differences in color between high-contrast elements in your image to create a smooth transition of color. This option is selected by default for display, print, and export options.

**ERROR DIFFUSION** dithering calculates an interim color between contrasting colors and shades the surrounding pixels to blend evenly toward that interim color.

**Note:** You can select dither method options in the display, printing, and exporting sections of this dialog box. The same definitions apply to each area.

3. The **PRINTING** settings control the printing options for Map windows, Layout windows and all other output file types. Select the appropriate printing settings based on your output requirements. Remember that resetting these printer options locally overrides these preferences.

- **OUTPUT METHOD/PRINT DIRECTLY TO DEVICE** — Click this option to print your image file directly from MapInfo Professional as you did when you were using MapInfo Professional 6.0 or earlier. This check box is checked by default.

- **OUTPUT METHOD/PRINT USING ENHANCED METAFILE** — Click this option to generate an enhanced metafile of your MapInfo Professional image before sending it to the printer. This setting takes advantage of current printer technology to shrink the spool size and print your file quicker without sacrificing quality.

**Note:** You must use this setting if you are printing a map containing a translucent raster or grid layer. If you do not use this setting, the image will not print translucently.

- **PRINT BORDER FOR MAP WINDOW** — Click this check box to print a black border around the image you are printing. Clear this check box to leave the image unbordered. This check box is checked by default.

- **INTERNAL HANDLING FOR PRINTING TRANSPARENT VECTOR FILLS AND SYMBOLS** — Special programming has been added to handle transparent fill patterns and bitmaps for vector images when printing or exporting. Click this check box to use this functionality or clear it to let the printer or Windows export functions to handle this. This check box is checked by default.

- **SCALE PATTERNS** — Select this check box to match the non-transparent fill patterns in your print output to more closely match what you see on your screen. This check box is checked by default. Clear this check box to let the printer driver have exclusive control over rendering the pattern fills.

**Note:** The Scale Patterns check box does not affect transparent fill patterns because transparent fill patterns are always scaled.

- **USE ROP METHOD TO DISPLAY TRANSPARENT RASTER** — Click this check box to allow the internal ROP (Raster Overlay by Pixel) to manage the transparent pixel display and printing in raster images. Since the ROP Method is largely a display method, not all printers, plotters, and export programs can use it. We recommend that you either check with the printer manufacturer before using this setting or try a few test prints or exports to get the results you want. This check box is cleared by default. Using the ROP method may not produce problems unless you print the metafile.

- **PRINT/EXPORT RASTER IN TRUE COLOR WHEN POSSIBLE** — Click this check box to print and export your 24-bit raster or grid file images in true color (make sure your printer settings are set to greater than 256 colors). Clear this check box if you are not working with a color printer. This check box is checked by default.
4. The **Window Export** settings control the export options for Map windows, Layout windows and all other output file types. Select the appropriate window export settings based on your output requirements. Remember that resetting these options locally overrides these preferences.
   • **Export Border** — Click this check box to include a black border on images you are exporting. Clear this check box to export the image without a border. This check box is checked by default.

   **Note:** The preference setting definitions for Internal Handling for Transparent Vector Fills and Symbols, Use ROP Method to Display Transparent Raster, Print Raster in True Color When Possible, and Dithering Methods are the same for export as for printing above.

5. Click OK to save these settings and return to the Preferences dialog box.

6. Click OK to close the Preferences dialog box.

**Recommendations for Effective Pattern Scaling**

When you are printing, find out what type of printer driver you are using. Many PCL6 and some HPGL drivers handle fill pattern scaling and give you control over this feature. Turning off their scaling may be the difference between what you see in print and what you see on your monitor. We recommend that you try turning off your driver’s scaling options and try ours first, because we have enhanced our method to more meet your Layout window requirements. To turn our pattern scaling options on, check the **Scale Patterns** check box in the Output Preferences dialog box. Then try turning off our scaling and turn theirs back on and see what you like better. Our tests show that our scaling will give you better matching results and when doing color output, our scaling also produces better color output.

If you are printing to postscript drivers using LanguageLevel 2 or 3, we find that some of the Microsoft drivers did not support pattern scaling. As a result, our scaling method may not help you. Microsoft recommended that you reset the language level of the postscript driver to LanguageLevel 1 to remove this restriction. We did find some exceptions to this condition. On Windows 2000 and Windows NT, some HP Laser Jet and Color Laser Jet postscript drivers using our scaling option printed correctly.

**Database Enhancements**

**Reading Larger Excel Files into MapInfo Professional**

We have expanded the range limit in the product to support the 64K row limit currently supported in Excel. There used to be a 32K row limit but we have been able to expand our support to include these larger files.
Read Oracle Tables in 8.1.7 like 9i

In the past, Oracle 8i clients could not open three dimensional SDO objects in MI Pro. Traditionally, we have read these objects in Oracle 9i but not for 8i. The product was only indexing tables on two dimensions for customers using Oracle 8.1.7. We recommend that you index your columns with the default 3D index to ensure that your queries do not fail.

Datum Enhancements

Enhanced KKJ Projection Algorithm

For this release, we have significantly improved the KKJ projection algorithm using conversion formulas from the National Land Survey of Finland.

Japanese Geodetic Datum Conversion

In the late 90’s, Japan started using new parameters for its Tokyo datum, which are somewhat different from those in the previous version of the product. In MapInfo Professional 7.5, we have added a new datum, which uses the JGD2000 conversion to convert the old Tokyo datum (the NIMA Tokyo datum (1991)) and the “new” Tokyo datum to the JGD2000 datum. If the JGD2000 conversion fails (for example, when a point is outside the JGD2000 grid), we use the standard Molodensky transformation method. See Tokyo97 in Appendix B in the MapInfo Professional User’s Guide (Unabridged).

Mapping Enhancements

Clearing Default Workspace Name After Close All

We have corrected a file overwriting problem you might have seen using the Close All option. In the past when you saved your workspace, selected Close All, and then saved another workspace, MapInfo Professional failed to recognize that you were working in a different workspace. It would automatically prompt you to save with the same name as you had previously entered, running the risk of overwriting the other saved workspace. We have changed this process to clear the name of the last saved workspace after the Close All selection. The default workspace filename is now UNTITLED.WOR.

Moving and Offsetting Geographic Objects

We have made it easier and quicker to move and offset an object or a group of objects in Version 7.5. The offset / move functionality is available when any layer is editable however, you can only move an object within its editable layer. You can always use the copy feature as long as a layer is editable. Instead of moving the selected object one pixel at a time, the Arrow keys now allow you to pan the map. We have added keystroke instructions to move objects more precisely on the
map. To move an object one pixel at a time, click it and press and hold the Ctrl key and press the Arrow button corresponding to the direction you want the object to move. To move the object 10 pixels at a time, press and hold the Ctrl and Shift keys and press the Arrow button corresponding to the direction you want the object to move.

**Positioning and Sizing your Map Objects**

To move an object to a new location, make the object’s layer editable and click the object to select it. Hold down the mouse button for at least one second until the cursor turns into a four-headed arrow. Drag the object to its new location and release the button. The object maintains its shape.

To move an object (in an editable layer) one pixel at a time, click it and press and hold the Ctrl key and press the Arrow button corresponding to the direction you want the object to move. To move the object 10 pixels at a time, press and hold the Ctrl and Shift keys and press the Arrow button corresponding to the direction you want the object to move.

Also, if you click the on the fifth edit handle (rotate handle) and hold down the mouse button, you can rotate the highlighted box to the desired angle. A rubber banding box is drawn representing the bounds of the rotated object. If you press and hold Shift key while the rubber banding box is being drawn, the rotation will be limited to 45 degree increments.

**Moving Objects on the Map**

You can move selected objects within its editable map layer easily.

To move an object on the map:

1. Click your map to make it active.
2. Make the layer where the object is located editable (on the Map menu, click Layer Control).
3. Select the object(s) using the Select tool.
   - If you select more than one object at a time to move, the objects move in the same way. Take care to ensure that you do not move an object off the map or off land by mistake.
   - **Note:** When you move the objects, you move them all at once, maintaining their positions relative to one another.
4. Do one or all of the following:
   - To move the selected object(s) using the mouse, hold down the mouse button and drag the object to its new location
   - To move the selected object(s) one screen pixel at a time, press and hold the Ctrl key and press the Arrow key in the direction you want the object(s) to move
   - To move the selected object(s) 10 screen pixels at a time, press and hold the Ctrl and Shift keys and press the Arrow key in the direction you want the object(s) to move
   - **Note:** Since the moves are made in screen pixels, the zoom level affects how far the object is moved.

**Offsetting Objects on the Map**

The Offset feature makes a copy of the object(s) you select from the original source object(s) and saves them in the original data file.
You can both move and offset the objects you select using this process. The difference between these two operations is whether MapInfo Professional makes a copy of the data (as in the case of copy) or simply moves the objects and stores the new value in the original table.

To move/offset selected objects on the map:

1. Click your map to make it active.
2. Make sure a layer is editable (on the MAP menu, click LAYER CONTROL).
   The offset/move functionality is available when any layer is editable, not just when the objects you want to move or offset are in the editable layer. However, you can only move an object within its editable layer. Copy is always permitted as long as a layer is editable.
3. Select the object(s) using the Select tool.
4. On the OBJECTS menu, click OFFSET to display the Offset Objects dialog box.

5. To move your selected objects, enter or select from the following options and click OK to apply the changes.
   To copy your selected objects to offset them, enter or select from the following options and click NEXT. Then go to step 6.
   - **ANGLE** — To offset your selected object at an angle, type the angle (in degrees) in this field. The new object is created based on the original object and is offset in the direction of the angle you specified, measured from the positive X-axis. If you enter a positive angle, the object is offset counterclockwise; if you enter a negative angle, the object is offset clockwise.
   - **DISTANCE/UNITS** — To set the offset distance and units, type the distance and select the units in the Distance box. The list of units is as follows: inches, links, feet, U.S. Survey feet, yards, rods, chains, miles, nautical miles, millimeters, centimeters, meters, and kilometers.

   **Note:** MapInfo Professional takes the default units from the map window in which you've selected the object.
   - **CREATE COPY** — Click this option to create a copy of the selected object(s) in the data. When you complete this process, MapInfo Professional saves the copy to the editable layer.
   - **MOVE OBJECTS** — Click this option to move the object without creating a copy in the data. You can only move an object within its own editable layer. When you move
objects, the Data Aggregation dialog box does not display, since you are only moving the data within the layer.

- **COPY OR MOVE DISTANCE USING** — The option you select in this box depends largely upon the projection of your source map. If your map has a latitude/longitude projection, MapInfo Professional enables the Spherical type only. If you are working with a non-Earth projection, MapInfo Professional enables the Cartesian type only.

  When you click **Spherical**, MapInfo Professional calculates the copy/move distance by mapping the data into a Latitude/Longitude On Earth projection.

  When you click **Cartesian**, MapInfo Professional calculates the copy/move distance by considering the data to be projected to a flat surface and distances are measured using Cartesian distance calculations.

6. The Data Aggregation dialog box displays if one of these conditions are true:
   - You clicked the **CREATE COPY** option
   - You selected objects in a different table from the table associated with the editable layer
   - The editable layer is not the cosmetic layer and has no text associated with the geographical objects in it

   You may notice that the only controls available to you in this dialog box are **Blank**, **Value**, and **No Data**.

   Type a value you will remember in the **Value** field of this dialog box. For more information about data aggregation, see *Aggregating and Disaggregating Data* in the *MapInfo Professional 7.5 User Guide (Unabridged)* on your MapInfo Professional 7.5 Installation CD.

7. Click **OK** to copy the data and offset the objects you selected.

**Increase Memory Size and New Resolution Preference Setting**

You can now set the number of bytes for the process in the System Settings Preferences dialog box. There used to be an processes limit of 100K, but we have set this new field to 1,000,000 bytes by default.

Now you can set the image resolution for export and Clipboard-placed graphics in the System Setting Preference dialog. This change affects the resolution of all the export options including the Save Window As option.

**Setting your System Preferences**

Use the System Settings Preferences dialog box to control the default settings that affect how MapInfo Professional interacts with your system.

To set your system settings preferences:

1. On the **Options** menu, point to **Preferences** and click **System Settings** to display the System Settings Preferences dialog box.
2. Select the appropriate system preferences for your implementation of MapInfo Professional and click OK to save them.

- **Copy to Clipboard** — Click the Copy to Clipboard check boxes to specify what items you want to copy to the Clipboard: text, bitmaps, or metafiles. MapInfo Professional now copies metafiles in Enhanced Metafile format (EMF). All three are copied to the Clipboard by default. Clear the appropriate check box(es) to prevent the item from being copied to the clipboard.

- **Color Defaults** — Select one of the Color Defaults preferences described below to control how MapInfo Professional shades thematic map layers.

  By default, **Monitor Setting** is selected. MapInfo Professional uses the color settings of the monitor to shade the map when this option is selected.

  Click the **Black & White** radio button if you are using a color monitor and want to shade your thematic map in gray-scale.

  Click the **Color** radio button if you are using a black and white monitor and want to print a thematic map in color on a color printer.

- **Aspect Ratio Adjustment** — Select the Aspect Ratio Adjustment options so that your map maintains the appropriate aspect ratio on your screen. Enter the dimensions of your screen in these fields.

- **Paper and Layout Units** — Specify the Paper and Layout Units used when you measure the size of objects in a Layout window and the size of paper in the Print dialog boxes. The default is set to inches. You can choose: inches, picas, points, millimeters, and centimeters.

- **Number of Objects** — You can only undo the last action. Set this option to the number of objects in the last action you want the system to Undo. For example, if you removed 10 objects at the same time and enter 10 in this field, MapInfo Professional undoes all 10.

**Note:** You cannot undo the following operations: Revert, Save, Save As, or Modify Table, or any operations whose effects are primarily cosmetic.
The default for this field is 10 objects. You can set it from 0 to 800. Setting the number of Undo objects to 0 deactivates the system. After you use the Undo option, the system toggles to REDO.

- **MEMORY SIZE FOR UNDO** — Type the number of bytes of memory you want to set aside for the Undo feature. This entry is set to 1,000,000 bytes by default. You can enter up to 10,000,000 bytes into this field. Increasing this entry may result in slower response time.

- **DISPLAY PRE-VERSION 4 SYMBOLS USING THE TRUE TYPE FONT** — Click this check box to indicate how you want to draw symbols from versions of MI Pro earlier than 4.0. Check this box to draw vector symbols with characters from the MapInfo Professional Symbols font. By default, vector symbols are drawn.

- **WINDOW EXPORT AND CLIPBOARD RESOLUTION** — To set the image resolution for exporting and Clipboard purposes, type the resolution in this field. MapInfo Professional uses this preference whenever you copy windows to the Clipboard, export your work to metafile and raster formats and the Save Window As export process as well. If you do not set this resolution manually, the product assumes 96 DPI. The maximum setting for this field is 1200 DPI.

- **DATE WINDOW FOR 2 DIGIT YEARS** — Select the appropriate Date Window for 2-Digit Years option for your purposes:
  - Click the **TURN DATE WINDOWING OFF** radio button to use the current century for all 2-digit years. This option is selected by default.
  - Click the **SET DATE WINDOW TO** radio button to refer to dates in both the current century and the previous century. You need to use this setting if your data uses dates in the 1900s.

  For example, if you type the number 30 in the Set Date Window field, 2-digit years from 00–29 are set in the 21st century (2000-2029), and 2-digit years from 30–99 are set in the 20th century (1930-1999).

3. Click **OK** to close the Preferences dialog box.

**Zooming, Panning, and Moving Changes**

We have added new functionality to assist you in zooming and panning more precisely in the Map window. We have changed the function of the Arrow keys in the Map window to move objects in an editable layer.

In addition to the usual zoom keys on your Main Toolbar ( , , and ), you can use the + and - keys on the keyboard, to zoom in and out more precisely.

- When you press +, you zoom in by a factor of 2
- When you press -, you zoom out by a factor of .5

You can pan in the Map window using the scroll bars, if enabled, or the UP, DOWN, LEFT, and RIGHT ARROW keys.

Further, you can move an object in an editable layer more precisely using the following key combinations. Previously, you would use these commands to pan your view of the Map window.

- **<CTRL ARROW>** - moves the editable, selected objects 1 pixel at a time
- **<CTRL SHIFT ARROW>** - moves the editable, selected objects 10 pixels at a time
Zoom Layering Enhancements

When you add an object, a region, a line or a polyline in the Map window and zoom out beyond where the zoom layer would permit you to see that feature, MapInfo Professional turns off zoom layering so you can continue to see what you are working on. When you complete the add process, a message displays asking you if you want to leave zoom layering off (so you will still be able to see the feature). If you answer CANCEL, the product cancels the zoom layering. If you answer OK, you need to adjust your zoom settings to see this feature again.

Snap Enhancements

New to this release is the addition of a circle around the Snap Mode cursor. This snap radius gives you a better idea of which node(s) you are snapping to. The circle is sized based on the snap tolerance setting. The default setting of 5 pixels can be changed in the Map Window Preferences dialog box. A larger snap tolerance creates a larger circle around the cursor and snaps to nodes farther away than if the tolerance was smaller.

Note: Snap tolerance cannot be set to less than 0 or greater than 50, nor accept any negative, decimal, or non-numeric settings.

The snap radius is only visible when Snap mode in toggled on, (press the S-key). Once you snap to a node, the radius disappears and a snap crosshair displays at the snapped point. Additionally, when the Snap is on, the new functionality allows you to snap to visible centroids (which display in region objects).

Using “Snap To” to Select Nodes and Centroids

Not only can nodes be used to reshape an object, they can also be used to align one object to another object. MapInfo Professional refers to this process as snapping to a node.

You can also use the snap to capability to snap to visible centroids in region objects.

In the Map window, regions, polylines, lines, arcs and rectangles all have nodes that can be attached (or snapped) to each other. When the Snap mode is enabled, MapInfo Professional searches for nodes and centroids as you move around a window. MapInfo Professional automatically snaps the cursor to a node or centroid when the cursor comes within the snap tolerance of the node. The crosshairs display when the node is “snapped to”.

To toggle Snap to Nodes, press the S key. The Status Bar displays with the word “SNAP” when Snap mode is activated. When you activate the Snap mode, a circle displays around your cursor showing the size of the tolerance of the Snap mode in pixels.

The S key acts like a toggle on/off switch. You can set the snap tolerance in pixels in the Map Window Preferences dialog box. The Snap Tolerance field allows you to specify a tolerance within which snap operates. For example, if you set the snap tolerance to 3 pixels, whenever you move the cursor within 3 pixels of a node, the cursor will snap to the node.

Snap mode works in the Map Window and Layout window (but not raster layers). It works with all MapInfo Professional tools in the Main and Drawing toolbars except Pan, Drag Map, and Text tool. Additionally, snap mode works on object types, including regions, points, multipoints, collection
objects, lines and polylines, rectangles, and arcs. It is not available for text objects, ellipses, and rounded rectangles. You set the Snap in one window at a time and can save it with your workspace.

Snap to Nodes applies to all selectable layers—this is useful if you are drawing an object in one layer and want to attach it to an object in another layer. If you do not want to snap to objects in certain layers, make those layers unselectable.

Setting and Printing the Map Scale in Layout Windows

You can now change the map scale in the Layout window by changing the frame size or by changing the zoom value to correctly create the scale of the layout. This new option calculates the zoom required to create the requested scale without changing the size of the frame. Keep in mind that while your current map frames may each share a Map window, you will only be able to change the scale of one map frame at a time.

Adding Windows to Current Layout – Using the Frame Tool

After you have created a layout, you may decide that you want to add other maps to it. You do not have to create a new layout to do this. You can create frames by hand to contain other windows. Use the Frame tool to draw window frames where you want them. The Frame tool is available whenever the Layout window is active.

Note: If you draw a frame when no windows are open, MapInfo Professional places a blank frame in the Layout window.

To add a window to a layout you are already working with:

1. Make the Layout window active and click the **FRAME** button. The Frame tool is activated.
2. In the Layout window, click and drag to draw the frame for the new window. When you release the mouse, the Frame Object dialog box displays.

   ![Frame Object Dialog](image)

   **Note:** This dialog is slightly different for each type of frame. The Map Scale options are only available when you select a Map window in the frame. The **FILL FRAME** check box does not display for Browser, Cartographic Legend, and Graph windows.

3. In the **WINDOW** drop-down list, select the window you want to add and review the options for creating this frame.

   - **BOUNDS X1 AND 2, BOUNDS Y1 AND Y2** — Use these fields to define the x and y boundaries for the new frame. When you change bounds entries, the Center, Width,
and Height entries change accordingly. When you change the bounds entries, the **MAP SCALE** changes as well.

- **CENTER X, Y** — Use these fields to define and adjust the center point of your new frame.

**Note:** When you make a change to the **CENTER X** or **Y** entries, the **WIDTH** and **HEIGHT** bounds do not change.

- **WIDTH, HEIGHT** — Use these fields to define and adjust the width and height of the new frame.

- **CHANGE MAP ZOOM** — Click this radio button to implement the correct map scale without changing the size of the frame. This option changes the zoom of the actual Map window so that the Layout frame is in the correct scale. This option is selected by default. Type the scale you want within this frame in the Scale. The units are set by the Paper Unit setting in the System Preferences dialog box. For example:

  Map Scale = Scale field entry x (Frame width / Map window width)

**Note:** Changing the map scale with this option will not change the values in the Bounds fields or the Width and Height fields because there is no change to the size of the frame, only the look of the map within the frame. To undo the change to the map zoom, return to the Map window and click **PREVIOUS VIEW**.

4. Select one of these options:

- **RESIZE FRAME** — Click this radio button to change the size of the frame based on the data you enter into the Scale field. When you change this entry, the bounds, Center, Width, and Height entries change accordingly.

- **FILL FRAME WITH CONTENTS** — Click this check box to display as much of the Map window as fits in the frame. When you do not select this button, the frame may be only partially filled but it will have the same contents as the window it contains.

5. Click **OK** to display the new frame in the Layout frame.

**Note:** When you click the **CHANGE MAP ZOOM** or **RESIZE FRAME** radio button, you set your selection as the default for the rest of the session. If you change it during the session, the change becomes the default.

**Large Crosshairs**

We have added a large crosshairs feature. You can use these crosshairs that extend vertically and horizontally to the length and width of the Map window to show the relative position of objects and map features in your Map window. You toggle the Large Crosshairs by clicking **C** in the Map and Layout windows. The Large Crosshairs stay on for the duration of the session, unless you turn them off.

**Custom Symbol Enhancements**

We have added enhancements which significantly improve the implementation of custom symbols. We have:

- Increased the bitmap file size from 128K to a virtually unlimited file size
- Increased the color depth of the bitmaps from 8bit maximum to a 24bit color maximum.
- Increased maximum symbol point size to 240 points and increased maximum label offset to 200 points (to support large custom symbols in maps and legends).
- Added a new “Display at Actual Size” option for all custom symbols, so you can display the symbol in its actual dimensions to see if it is appropriate for your map.
You can now:

- Create bitmaps in rectangular shapes as well as squares
- Save more custom bitmap symbols than ever — you used to be limited to 256 symbols but MapInfo Professional can now handle 32,767.

**Working with Custom Symbols**

You can create and use your own custom bitmaps as symbols in MapInfo Professional. To access these custom symbols, place them in the CUSTSYM directory and select them from the Custom Symbols option in the Font list of the Symbol Style dialog box (OPTIONS > SYMBOL STYLE). All of the custom symbols in MapInfo Professional are stored in the CUSTSYM directory. If you cannot find this directory, there are a couple of places you could check. The location of this file depends largely on the administration of your computer, the version of MapInfo Professional you use, and the location of your installation directory.

Usually, this directory is located in Program Files\MapInfo\Professional\ (or one of it's subdirectories) or in \Documents and Settings\user's login directory\Applications Data\MapInfo\MapInfo\version number\. If you cannot find this directory, click **START** and **SEARCH** and search for \CUSTSYM on your system.

**Note:** If you add custom symbols while you are working in MapInfo Professional, open the Symbol Style dialog box and click the **RELOAD** button to ensure that the new symbol(s) you have added display. Otherwise, you have to exit MapInfo Professional and re-enter it to get the new symbols to display in the Custom Symbols list.

When you change the style of a custom symbol, the Effects options in the Symbol Style dialog box change. You can either show a background or apply a color.

- **SHOW BACKGROUND** displays the custom symbol with the background color with which it was created.
- **APPLY COLOR** replaces all non-white pixels with a color you choose from the color palette.
- **DISPLAY AT ACTUAL SIZE** shows the symbol at its actual size.

When you are creating extended custom symbols we recommend you check the Show Background check box if you do not require transparency. This setting improves performance significantly during exporting and Drag and Drop operations.

MapInfo Professional ships with custom symbols that you can use to enhance your maps. Here is a list of the custom symbols we provide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Image</th>
<th>File Size</th>
<th>Color Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMBU-64.BMP</td>
<td><img src="image" alt="AMBU-64.BMP" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>BANK-64.BMP</td>
<td><img src="image" alt="BANK-64.BMP" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>Title</td>
<td>Image</td>
<td>File Size</td>
<td>Color Depth</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>BUILDINGS.BMP</td>
<td><img src="image1.png" alt="Buildings" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>FIRE-64.BMP</td>
<td><img src="image2.png" alt="Fire Truck" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>FOOD-64.BMP</td>
<td><img src="image3.png" alt="Food" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>HOUS-64.BMP</td>
<td><img src="image4.png" alt="House" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>PINB-64.BMP</td>
<td><img src="image5.png" alt="Pin" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>PING-64.BMP</td>
<td><img src="image6.png" alt="Ping" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>PINGY-64.BMP</td>
<td><img src="image7.png" alt="Pingy" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>PINR-64.BMP</td>
<td><img src="image8.png" alt="Pinr" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>RAIL-64.BMP</td>
<td><img src="image9.png" alt="Rail" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
</tbody>
</table>
Understanding the Custom Symbol Types

There are two types of custom symbols: custom symbols and extended custom symbols. The difference in these two types depends upon the complexity of the bitmap images. Files that are equal to or larger than 128K and/or have greater than 8 bit color are considered to be extended custom symbols. You need to know the distinction between these two types of custom symbols because the options for the extended custom symbols are slightly different from the custom symbols.

Understanding the Custom Symbol Sizes, Shape, and Color Rules

You can create various sized and shaped bitmaps for use as custom symbols. As a general rule, smaller symbols look better at smaller font sizes because they won’t need to be stretched. Larger symbols look better at larger font sizes because they have more pixels and more detail. Here are some rules and tips that govern custom symbols:

- You can select the point size for custom bitmaps from 9 to 240 pt.
- You can display the custom bitmap image at actual size.
- There is no a file size limit for custom bitmaps (other than what is required by your raster engine and the amount of memory you have).
- Extended custom symbols can be either rectangular or square in shape.
- Extended custom symbols usually have their own complex color pattern (which is what makes them extended) so the APPLY COLOR option is disabled.
- MapInfo Professional supports up to 24bit color bitmaps.

When you are dealing with very large bitmaps, there are a couple of special rules to keep mind:

- Some users have reported panning problems associated with very large symbols. When you create a symbol that is larger than 36 points, the symbol may not completely redraw as you pan across your map. To alleviate this problem, go to the system registry and add or change your MBRExtraPoints registry entry.
- There are times when the custom symbol you are trying to display is too large for the Sample area.

<table>
<thead>
<tr>
<th>Title</th>
<th>Image</th>
<th>File Size</th>
<th>Color Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>RED-CAR.BMP</td>
<td><img src="image" alt="RED-CAR.BMP" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
<tr>
<td>TRUC-64.BMP</td>
<td><img src="image" alt="TRUC-64.BMP" /></td>
<td>13 KB</td>
<td>24-bit</td>
</tr>
</tbody>
</table>
Improved Object Rotation

MapInfo Professional 7.5 continues to improve on rotating object functionality. For selected objects, you can now set a precise angle of rotation and choose the anchor point on which to rotate. Additionally, we have changed the rotation handle from Pro 7.0 from a square symbol to a circle, to differentiate it from square edit handles. Multiple selected objects can now be rotated.

To rotate an object or objects by a specific angle, use the Rotate Objects tool, which is available whenever you have selected an object(s) in an editable layer in a Map or Layout window.

To rotate an object or objects in a Map or Layout window:

1. On your editable layer, select the object(s) you want to rotate.
2. On the OBJECTS menu, click ROTATE to display the Rotate Objects dialog box.

   These entries can be in degrees decimal or degrees/minute/second format and are determined by the Display Coordinates setting in your Map Options dialog box. You cannot use the Military Grid Reference here.

3. In this dialog box, you specify the angle and the anchor point of the rotation. Type the rotation angle in the Rotation field.

   Note: The rotation angle can be positive (counter clockwise) or negative (clockwise).

4. Determine the anchor point by doing one of the following:
   • Accept the default anchor point of the selected object(s) by leaving the X and Y coordinates that display in these field as they are

   Note: The default anchor point varies depending upon how many objects you have selected and the kind of objects they are. See Understanding an Object’s Default Anchor Point on page I-53 for more about default anchor points.
• Type new entries in the X and Y coordinate fields to select a new anchor point
• Click the **PICK FROM MAP** button and click the anchor point you want on the Map or Layout window. Click the mouse button only once to establish this point.

To return to the default anchor point, click the **RESET ANCHOR** button.

5. Decide whether or not you want to lock the anchor point. Click the **LOCK ANCHOR POINT POSITION** check box to lock the anchor point.

When you lock the anchor point, you ensure that the anchor point will not be recalculated when you return to the Map or Layout window. If you do not lock the anchor point, MapInfo Professional recalculates the anchor point in the based on the rotated selection. Once the objects are rotated, they may have a different anchor point.

**Note:** You cannot maintain an anchor point lock when you change the selection from the Map window to the Layout window or from the Layout window to the Map window.

6. When you have completed these entries or selections, click **OK** to rotate your object(s).

### Understanding an Object's Default Anchor Point

When rotating objects in an editable layer, the default anchor varies depending upon how many objects you are rotating and the kind of objects you select. If you select:

- A single object (not a polyline), the default anchor point is the object's centroid
- A single polyline or several objects, the default anchor point is the center of the polyline’s or the selected objects minimum bounding rectangle (MBR)
- Multiple objects, the default anchor point is the center of the MBR of the selected objects

### Data Disaggregation Dialog Changes

Now, when your editable table has a different table structure from your input table, you can specify the column as well as the value information in the Data Disaggregation dialog box.

If the tables you are combining have the same table structure, the process works perfectly. When you are working with two tables with different table structures, the Data Disaggregation options are slightly different.

When the input table has a different table structure from the output table, the Data Disaggregation dialog box displays a Column Name field to accommodate the table structure.

![Image of Data Disaggregation dialog box]

The **AREA PROPORTION** radio button is active if the selected field is numeric. Also the Value entry field is enabled when you select the Value radio button and the drop-down list contains “none”.
Dot Density Theme Enhancements

When you create a dot density map, the size of the dots have been changed. Large dots are now 3 screen pixels wide and small pixels are 2 pixels wide. This change is evident in the Customize Dot Density Settings dialog box.

Object Clean Gaps Modification

We have changed the way we handle gaps in polygons. When there is a gap between two adjacent regions, MapInfo Professional will add the gap to the region with the longest shared edge.

The CLEAN command available from the OBJECTS menu enables you to remove any self-intersections in your region data and optionally alter region data to remove overlaps and/or gaps. CLEAN is available whenever there are objects selected, and the table that the objects are in is editable.

Note: All of the objects selected must be closed objects (e.g., regions, rectangles, rounded rectangles or ellipses).

To use the Clean command:

1. Open any Map window that includes a region layer.
2. Make the region layer editable if it is not already (on the MAP menu click LAYER CONTROL).
3. Select the objects that you want to clean. Ideally, all the objects in the table would be selected.
4. On the OBJECTS menu, click CLEAN. The Clean Objects dialog box displays.

5. Click the ENABLE OVERLAP REMOVAL check box to remove any overlapping areas. The area of overlap will be retained in the region that has the largest area; the overlap will be removed from any other overlapping regions.
6. Click the ENABLE GAP REMOVAL check box to remove any gaps between regions, where the area of the gap is less than the area provided. The area of the gap will be added to the adjacent region with the longest shared edge. Specify a maximum gap area and the area units you want to use.
7. Click OK.

Setting Map Bounds for DBMS Tables

In this release you can specify the bounds for a RDBMS table when you make the table mappable for live access databases. By allowing you set the map bounds, you can better control the visibility of your data, which is particularly important when downloading large tables. Also in this release,
when you make an Oracle Spatial table mappable, MapInfo Professional automatically determines
the appropriate coordinate system and bounds, based on the SDO_GEOM_METADATA for the
selected table and spatial column. For other RDBMSs, the product still requires the information to
be specified in the Make Table Mappable dialog.

Making a DBMS Table Mappable

To make a DBMS table mappable:

1. On the TABLE menu point to MAINTENANCE and click MAKE DBMS TABLE MAPPABLE. The
   Select DBMS Table dialog box displays. Here, you select the DBMS table you want to
   make mappable.
2. Open the appropriate remote connection if you have not done so already. The Open Table
dialog box displays.
3. Select the table from the list and click OK. The Make Table Mappable dialog box displays.

4. The rest of the Make Table Mappable dialog box works as it always has. The Table
   Bounds button on this dialog box is new.
   - **TABLE BOUNDS** — Allows you to choose the options that determine how your default
     view and your entire view table bounds are calculated. The bounds options you
     specify in this dialog box define both views. Select one of these options and click OK
     to implement those bounds options.

**USE DATA BOUNDS** — By default MapInfo Professional calculates the bounds as the
minimum bounding rectangle of all the data in the layer. This requires scanning the
table and calculating this value. This process can take some time so a progress bar
displays, showing you the progress of this operation. You can cancel it, if necessary.
**USE COORDSYS BOUNDS** — You can use the coordinate system bounds, but usually
we do not recommend it. The coordinate system bounds are usually much larger than
the actual data bounds, which may make finding your displayed data difficult. You are
usually zoomed out too far to be able to locate your data easily.
USE CUSTOM BOUNDS — Here, you can set your own custom bounds based on the size and location of your data. Click this option to modify or set the bounds of your data.

Saving a Buffer as a Table

You can now save a buffer to its own table or to an existing table. On the TABLE menu, click the BUFFER option to use this new capability.

Saving your Buffer as a New Layer

As of this release you can save a buffer as a new table (layer) or as part of another layer in your map. This process is similar to the Voronoi process described in Saving your Voronoi Polygon as a New Layer on page I-59. This process is also similar to the Combine Using Column process, except that there is no “Group By” functionality for buffers.

Note: The table must be mappable to use this feature.

To create the buffer as a distinct layer:

1. To create a selection to buffer, select the object in the map. This step is not required if you want to buffer all objects in a particular table.
2. On the TABLE menu, click BUFFER. The Table Buffer dialog box displays.
3. Do one of the following:
   • To buffer the selected object, leave the SELECTION object selected in the BUFFER OBJECTS IN TABLE drop-down list box.
   • To buffer objects from a particular table, select the table in the BUFFER OBJECTS IN TABLE drop-down list box.
4. Select the type of table you want to place the buffer into from the STORE RESULTS IN TABLE drop-down list box. Select one of the following:
   • NEW TABLE — allows you to save the buffer in a new table
   • <TABLENAMES> — allows you to save the buffer in one of the currently open tables

After you make this selection, click NEXT to continue.

Note: You cannot save a buffer to the Cosmetic Layer.

5. Do one of the following:
   • If you chose the NEW TABLE option, go to Saving a Buffer to a New Table on page I-56.
   • If you chose <TABLENAMES>, go to Saving a Buffer to an Existing Table on page I-58.

Saving a Buffer to a New Table

You can create a buffer and save it as a new table (layer) in your map. You must complete the instructions in Saving your Buffer as a New Layer on page I-56 before you begin this operation.
1. Use the Create New Table and check boxes to indicate where you want the new buffer to display. You can click more than one check box.
   - OPEN NEW BROWSER — Click this check box to display the new buffer in a new Browser window only.
   - OPEN NEW MAPPER — Click this check box to display the new buffer in a new Map window.
   - ADD TO CURRENT MAPPER — Click this check box to display the new buffer in the current Map window.

2. Choose the table structure for the new table, using only one of these options:
   - CREATE NEW — Click this check box to specify a new table structure and create the new fields in the New Table Structure dialog box.
   - USE TABLE — Click this check box to create the new table structure based on the fields in an existing table. You can base your new table structure on any open table.

3. Click CREATE. The New Table Structure dialog box displays.
   If you selected CREATE NEW in the last step, the New Table Structure dialog box displays no fields and you need to add the fields you need.

4. Click the ADD FIELD button and enter the field name, select the field type, and enter the field width for each new field in your table. Continue this process until your table structure is complete.

5. Click CREATE to create the table and display the buffer according to the display instructions you specified. The Create New Table dialog box displays prompting you to save the name of the new table.

6. Select the directory for this table and type the name of the new table in the File Name field. Click SAVE.
Saving a Buffer to an Existing Table

You can create a buffer and save it as a layer in an existing table in your map. You must complete the instructions in Saving your Buffer as a New Layer on page I-56 before you begin this operation.

1. When you choose to store the table results in the existing table, the Data Aggregation dialog box displays.

   ![Data Aggregation Dialog Box]

   Click a field here

   Specify the data aggregation method here.

   Note: If you selected tables with disparate values, there may be additional fields in this dialog box. You need to reconcile these table values using this dialog box.

2. In the Data Aggregation dialog box, click a field and specify an aggregation method:
   - **BLANK** — Click this radio button to indicate that this field should remain blank.
   - **VALUE** — Click this radio button to indicate that this field should contain a specific value or should retain its existing value. If the field should contain a specific value, enter that value into the Value field.
   - **SUM** — Click this radio button to add the field values from the original objects to create a field total for the field in the new column. (Applies to numeric fields only.)
   - **AVERAGE** — Click this radio button to average the field values from the original objects. (Applies to numeric fields only.)
   - **WEIGHTED BY** — Click this radio button to give more weight to one value over another when averaging. You can choose a numeric field in your table as the weighting factor or choose area (where the weighted average is based on the relative geographic area of the regions to be combined). Applies to numeric fields only.

3. To add no data to the existing table, select the **NO DATA** check box. This disables the Blank and Value radio buttons.

4. After you have completed these selections and entries, click **OK**.

5. The Buffer Objects dialog displays. From here the process is the same as described in Creating a Buffer as described in the MapInfo Professional 7.5 User Guide (Unabridged).

   Note: The values in the Buffer Objects dialog box are saved at the end of the operation. If you perform another Buffer operation using the Table Buffering option or the Objects Buffering option using the same base table, MapInfo Professional restores the previous values.

New Voronoi Capabilities

Some of our cellular phone tower customers, who have been using the Voronoi polygon feature, have asked to be able to save their Voronoi polygons into a new layer. We have added this functionality to accommodate this request.
Saving your Voronoi Polygon as a New Layer

The Table Voronoi operation provides an another way to create Voronoi polygons from a table and provides a mechanism to place the results into a new table. This process is not directly available using the Objects Voronoi operation.

**Note:** You cannot place Voronoi polygons in the Cosmetic Layer.

To set up a Voronoi polygon in new table or in an existing table:

1. Open and display the table for which you want to create Voronoi polygons.
   **Note:** If you want to use a selection to create the Voronoi polygon, hold down the **SHIFT** key and select the points you want. This is not required. If you do not make a selection at this point, MapInfo Professional will use all of the points on the selected layer to create the polygon.

2. To create a boundary for the Voronoi polygon layer you are creating, use the Target Object feature described in Overlaying Nodes as described in the MapInfo Professional 7.5 User Guide (Unabridged). This is not required.

3. On the **TABLE** menu, click **VORONOI**. The Table Voronoi dialog box displays.

4. Select the layer you want to create the Voronoi polygon with in the **PERFORM VORONOI USING OBJECTS FROM TABLE** drop-down list. If you selected points you want to use to create this polygon, choose the “Selection” entry in this list.

5. Select the table type for the results of the Voronoi polygon from the **Store results in table** drop-down list:
   - **NEW TABLE** — allows you to save the Voronoi polygon in a new table
   - **<TABLENAMES>** — allows you to save the Voronoi polygon into one of the currently open tables that contain point objects

6. After you make this selection, click **NEXT** to continue. Do one of the following:
   - If you selected the **NEW TABLE** option, go to **Save the Voronoi Polygon to a New Table** on page I-59.
   - If you selected the **<TABLENAMES>** option, go to **Save the Voronoi Polygon to an Existing Table** on page I-61.

**Save the Voronoi Polygon to a New Table**

To save the Voronoi Polygon to a new table:

1. In the New Table dialog box, follow these directions:
2. Use the **CREATE NEW TABLE AND** check boxes to indicate where you want the new Voronoi polygon to display. You can click more than one option. The options include:
   - **OPEN NEW BROWSER** — Click this check box to display the new Voronoi polygon in a new Browser window only.
   - **OPEN NEW MAPPER** — Click this check box to display the new Voronoi polygon in a new Map window.
   - **ADD TO CURRENT MAPPER** — Click this check box to display the new Voronoi polygon in the current Map window.

3. Choose one of these options to specify the table structure for the new table:
   - **CREATE NEW** — Click this option to create a new table structure and add the new fields in the New Table Structure dialog box.
   - **USE TABLE** — Click this option to create the new table structure based on the fields in an existing table. You can base your new table structure on any open table.

4. Click **CREATE**. The New Table Structure dialog box displays.

5. In the New Table Structure dialog box, you can add and remove fields to create a new table structure. Click the **Add** button and type a name, field type, and field width in the fields and drop-down list provided to create a new field in the new table.

6. When you have completed the table structure, click **CREATE** to create the table and display the Voronoi polygon according to the display settings you specified. The Create New Table dialog box displays so you can save the name of the new table.

7. Type the name you want the new table to have in the File Name field and click **SAVE** to save it. You can choose a new directory in this dialog box as well.
Save the Voronoi Polygon to an Existing Table

1. When you choose to store the table results in the existing table, the Data Aggregation box displays.

   ![Data Aggregation dialog box]

   Select the field here

   Specify the data aggregation method here.

   If the columns in the tables you are combining do not match, specify the source column in this field.

   **Note:** If you selected tables with disparate values, there may be additional fields in this dialog box. You need to reconcile these table values using this dialog box.

2. To specify details of the new table structure, highlight each field in turn and do one of the following:
   - **BLANK** — Use this option to indicate that this field should remain blank.
   - **VALUE** — Use this option to indicate that this field should contain a specific value or should retain its existing value. If the field should contain a specific value, enter that value into the Value field.

   **Note:** Other aggregation methods may be available based on the data in the tables. See *Aggregating and Disaggregating Data* as described in the *MapInfo Professional 7.5 User Guide (Unabridged)* for these details.

3. If the new table information should add no data to the existing table, select the **NO DATA** check box to disable the other field options.

4. After you have completed these selections and entries, click **OK**.

Add In Enhancements

These enhancements are third-party tools that we have integrated into MapInfo Professional to provide reporting and grid handling capabilities.

Crystal Reports Changes

As part of this release, the installer checks to see if you are also using our popular TargetPro application. If you are, we have corrected a problem some MapInfo Professional/TargetPro users reported that affected their access to the appropriate Crystal Reports documentation.
Vertical Mapper Integration

MapInfo Corporation has purchased Vertical Mapper, a raster-based tool for performing spatial queries and geostatistical analysis on grid layers. Vertical Mapper has 3D features and analysis tools including:

- Import tools for grid-based formats
- Grid layer creation and reclassification (Square Area and Kernel Smoothing)
- Grid layer reprojection
- Grid layer resizing, splicing, and trimming
- Multiple interpolation routines (Triangulation, IDW, Natural Neighbor, Rectangular, Kriging, and Custom Point Estimation)
- Cross-Sections
- Grid Contouring
- 3D Viewing and Analysis
- Point-To-Point Visibility
- View Shed Analysis
- Data Aggregation Tools
- Spatial Correlation Tools
- Tools for converting grid layers to vector layers
- Tools for converting vector layers to grid layers

This is an excellent tool, particularly for customers who use grid layers for elevation studies or need to show or demonstrate “vertical” information. Vertical Mapper does not ship with MapInfo Professional automatically.

Menu Enhancements

We provide these menu enhancements to make it easier to use the Window menu features.

Window Menu Changes

There are several changes to the Window menu in MapInfo Professional. We have added a check mark to show the active window as shown in the next figure.
If there are more than nine windows open at the same time, the entry “More Windows” displays.

**Note:** The only way to change the order of the windows in the Window menu list is to close open windows.

## Tool Enhancements

We have added tools and made changes to existing tools to help you work more efficiently.

### New Tools for MapInfo Professional 7.5

#### Cogoline Tool

This tool, also called Create Line by Length, draws a line of a specified length and angle, which the product now saves by default to the current editable layer. If there is no editable layer, MapInfo Professional saves the line to the Cosmetic Layer, as before -- but it now sets the Cosmetic layer to be editable, so that you can select and edit the resulting lines. We have also expanded the number of units associated with the Length field to include: millimeters, centimeters, meters, kilometers, nautical miles, inches, yards, links, rods, and chains as well as feet and miles.

#### Register Vector Tool

This tool allows you to put control points into a vector image and reference points into a Map window and then performs an affine transformation to line them up. An affine transformation changes the relationship between the coordinate system you use to draw a map and the coordinate system you use to display it. The interface is similar to the Raster Registration tool. You might use this tool after importing an Autocad or ESRI Shape file which contains the wrong coordinate system, placing the table in the wrong geographic location.
Workspace Packager

The Workspace Packager is a new tool that saves a copy of the current workspace and saves a copy of all data referenced by the workspace in a new location. You can use this tool to manage and update internal workspace references and update .tab files to point only to the “packaged” copies of the data. You can open the new workspace no matter where the folder has been moved or copied to, even a different computer. Add the Workspace Packager tool using the Tool Manager (available in the Tools menu).

Enhancements to Existing Tools in MapInfo Professional 7.5

Line Snap (Trim/Extend) Tool Enhanced

Use the Line Snap tool to trim or extend a line (or a single-segment polyline) that intersects with another line in the Map window. This tool helps you make cleaner intersections when working with lines. For instructions for using this tool, click the Tools menu, point to Line Snap Tool, and click About Line Snap.

Map Window Manager Tool Enhanced

You can now change the titles of the Map, Browser, Graph, Layout and Redistrict windows using the Window Manager tool. We have changed the name of the Map Window Manager to the Window Manager, since this tool no longer applies to Map windows alone. We have maintained the Set Default View option from previous versions of this tool. This option allows you to select a layer from an open map window, and make the default zoom and center settings for the layer’s base table match those of the map window. The default zoom and center settings are written to the table’s .map file.

Note: You cannot change the default view for a raster image table, unless it is a seamless table. The Autoscroll option has been removed from this tool, since we now provide this functionality in the Options window.

TOC Utility Updated

The TOC Utility produces seamless tables from Table of Contents [TOC/THF] files (formats defined by the National Imaging and Mapping Agency (NIMA)). To improve conversion speed for large image sets, we added an option that prevents MapInfo Professional from opening a new map window for each newly-created seamless table. We have also made some internal changes to give programmers the tools they need to call functions in a separate module, TOCCore.MBO. You can use this module to batch process large numbers of TOC/THF files without having to locate each file using the GUI interface.
EasyLoader Changes

Our company is no longer providing Merant ODBC Drivers for MapInfo Professional. We have made enhancements to the EasyLoader program to perform the same role with drivers provided by the standard ODBC install. This change in drivers is handled during the MapInfo Professional installation process. To ensure that you install all of the necessary drivers for ODBC Connectivity, see Custom Workstation Installation in Chapter 1 on page I-14.

MapBasic Enhancements

There are changes to the Move and Offset functionality, the addition of Web Map Service, and the changes to the Make Table Mappable functionality that affect the MapBasic code. See New and Enhanced MapBasic Statements and Functions in Appendix C on page I-78 for details on the new statements and functions available in this release.
This Appendix contains a comprehensive list of the shortcuts available in the MapInfo Professional application. You can create custom shortcuts by editing the MAPINFO.MNU file using a text editor.

**CAUTION:** Making changes to the MAPINFO.MNU file will cause default shortcuts to stop working. Make these changes carefully and record your changes so you can change them back, if necessary.

In this Appendix:

- Shortcuts for File Menu Items .............................. I-67
- Shortcuts for Edit Menu Items ............................. I-67
- Shortcut to Tools Menu Items ............................. I-67
- Shortcuts to Objects Menu Items ......................... I-68
- Shortcuts for Query Menu Items .......................... I-68
- Shortcuts for Options Menu Items ........................ I-68
- Shortcuts for Map Menu Items ............................ I-69
- Shortcut for Layout Menu Item ............................ I-69
- Shortcuts for Windows Menu Items ...................... I-69
- Shortcuts by Keystroke ..................................... I-70
# Shortcuts for File Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Open...</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>File &gt; Save Table...</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>File &gt; Save Workspace</td>
<td>CTRL+K</td>
</tr>
<tr>
<td>File &gt; Print...</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>File &gt; Exit</td>
<td>ALT+F4</td>
</tr>
</tbody>
</table>

# Shortcuts for Edit Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit &gt; Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Edit &gt; Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Edit &gt; Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Edit &gt; Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Edit &gt; Clear</td>
<td>DEL</td>
</tr>
<tr>
<td>Edit &gt; Reshape</td>
<td>CTRL+R</td>
</tr>
<tr>
<td>Edit &gt; New Row</td>
<td>CTRL+E</td>
</tr>
<tr>
<td>Edit &gt; Get Info</td>
<td>F7</td>
</tr>
</tbody>
</table>

# Shortcut to Tools Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Run MapBasic Program</td>
<td>CTRL+U</td>
</tr>
</tbody>
</table>
Shortcuts to Objects Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects &gt; Set Target</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Objects &gt; Clear Target</td>
<td>CTRL+DELETE</td>
</tr>
</tbody>
</table>

Shortcuts for Query Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query &gt; Unselect All</td>
<td>CTRL+W</td>
</tr>
<tr>
<td>Query &gt; Find...</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Query &gt; Find Selection</td>
<td>CTRL+G</td>
</tr>
</tbody>
</table>

Shortcuts for Options Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options &gt; Line Style</td>
<td>SHIFT+F8</td>
</tr>
<tr>
<td>Options &gt; Region Style...</td>
<td>CTRL+F8</td>
</tr>
<tr>
<td>Options &gt; Symbol Style</td>
<td>ALT+F8</td>
</tr>
<tr>
<td>Options &gt; Text Style</td>
<td>F8</td>
</tr>
</tbody>
</table>
Shortcuts for Map Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map &gt; Layer Control...</td>
<td>CTRL+L</td>
</tr>
<tr>
<td>Map &gt; Create 3D Map</td>
<td>F10</td>
</tr>
<tr>
<td>Map &gt; Create Prism Map</td>
<td>F11</td>
</tr>
<tr>
<td>Map &gt; Create Thematic Map</td>
<td>F9</td>
</tr>
<tr>
<td>Map &gt; Modify Thematic Map</td>
<td>ALT+F9</td>
</tr>
<tr>
<td>Map &gt; Previous View</td>
<td>ALT+LEFT ARROW</td>
</tr>
</tbody>
</table>

Shortcut for Layout Menu Item

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout &gt; Previous View</td>
<td>ALT+LEFT ARROW</td>
</tr>
</tbody>
</table>

Shortcuts for Windows Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window &gt; New Browser</td>
<td>F2</td>
</tr>
<tr>
<td>Window &gt; New Mapper</td>
<td>F3</td>
</tr>
<tr>
<td>Window &gt; New Grapher</td>
<td>F4</td>
</tr>
<tr>
<td>Window &gt; New Layout</td>
<td>F5</td>
</tr>
<tr>
<td>Window &gt; Redraw Window</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Window &gt; Tile Windows</td>
<td>SHIFT+F4</td>
</tr>
<tr>
<td>Window &gt; Cascade Windows</td>
<td>SHIFT+F5</td>
</tr>
</tbody>
</table>
## Shortcuts by Keystroke

<table>
<thead>
<tr>
<th>Menu Items</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Exit</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Options &gt; Symbol Style</td>
<td>ALT+F8</td>
</tr>
<tr>
<td>Map &gt; Modify Thematic Map</td>
<td>ALT+F9</td>
</tr>
<tr>
<td>Map &gt; Previous View and Layout &gt; Previous View</td>
<td>ALT+LEFT ARROW</td>
</tr>
<tr>
<td>File &gt; Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Window &gt; Redraw Window</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>File &gt; New Row</td>
<td>CTRL+E</td>
</tr>
<tr>
<td>Query &gt; Find...</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Options &gt; Region Style...</td>
<td>CTRL+F8</td>
</tr>
<tr>
<td>Query &gt; Find Selection</td>
<td>CTRL+G</td>
</tr>
<tr>
<td>Query &gt; Invert Selection</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>File &gt; Save Workspace</td>
<td>CTRL+K</td>
</tr>
<tr>
<td>Map &gt; Layer Control...</td>
<td>CTRL+L</td>
</tr>
<tr>
<td>File &gt; New Table...</td>
<td>CTRL+N</td>
</tr>
<tr>
<td>File &gt; Open...</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>File &gt; Print...</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>File &gt; Reshape</td>
<td>CTRL+R</td>
</tr>
<tr>
<td>File &gt; Save Table...</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Objects &gt; Set Target</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Tools &gt; Run MapBasic Program</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>File &gt; Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Query &gt; Unselect All</td>
<td>CTRL+W</td>
</tr>
<tr>
<td>File &gt; Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>File &gt; Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Objects &gt; Clear Target</td>
<td>CTRL+DELETE</td>
</tr>
<tr>
<td>Window &gt; New Browser</td>
<td>F2</td>
</tr>
<tr>
<td>Window &gt; New Mapper</td>
<td>F3</td>
</tr>
<tr>
<td>Menu Items</td>
<td>Keystrokes</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Window &gt; New Grapher</td>
<td>F4</td>
</tr>
<tr>
<td>Window &gt; New Layout</td>
<td>F5</td>
</tr>
<tr>
<td>File &gt; Get Info</td>
<td>F7</td>
</tr>
<tr>
<td>Options &gt; Text Style</td>
<td>F8</td>
</tr>
<tr>
<td>Map &gt; Create Thematic Map</td>
<td>F9</td>
</tr>
<tr>
<td>Map &gt; Create 3D Map</td>
<td>F10</td>
</tr>
<tr>
<td>Map &gt; Create Prism Map</td>
<td>F11</td>
</tr>
<tr>
<td>Window &gt; Tile Windows</td>
<td>SHIFT+F4</td>
</tr>
<tr>
<td>Window &gt; Cascade Windows</td>
<td>SHIFT+F5</td>
</tr>
<tr>
<td>Options &gt; Line Style</td>
<td>SHIFT+F8</td>
</tr>
<tr>
<td>Edit &gt; Delete</td>
<td>DEL</td>
</tr>
</tbody>
</table>
Fill Patterns Used in MapInfo Professional

In the Region Style dialog box, you have the option of selecting fill patterns for regions. This appendix shows the fill patterns and their ID numbers.

Sections in this Appendix:

- Fill Pattern Table ........................................... I-73
- New Fill Patterns (Added in This Release) ............. I-74
This is a list of the original fill patterns we supply with MapInfo Professional in the Region Style dialog box.

<table>
<thead>
<tr>
<th>MB ID</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>None</td>
<td>27</td>
<td></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>28</td>
<td></td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>29</td>
<td></td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>30</td>
<td></td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>31</td>
<td></td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>32</td>
<td></td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>33</td>
<td></td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>34</td>
<td></td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>35</td>
<td></td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>36</td>
<td></td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>37</td>
<td></td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>38</td>
<td></td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>39</td>
<td></td>
<td>62</td>
<td></td>
</tr>
</tbody>
</table>
### New Fill Patterns (Added in This Release)

This is a list of the new fill patterns we supply with MapInfo Professional. You see them when you scroll down the list of fill patterns in the Region Style dialog box.

<table>
<thead>
<tr>
<th>MB ID</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>72</td>
<td><img src="image1.png" alt="Image" /></td>
<td>107</td>
<td><img src="image2.png" alt="Image" /></td>
<td>142</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>17</td>
<td><img src="image4.png" alt="Image" /></td>
<td>40</td>
<td><img src="image5.png" alt="Image" /></td>
<td>63</td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>18</td>
<td><img src="image7.png" alt="Image" /></td>
<td>41</td>
<td><img src="image8.png" alt="Image" /></td>
<td>64</td>
<td><img src="image9.png" alt="Image" /></td>
</tr>
<tr>
<td>19</td>
<td><img src="image10.png" alt="Image" /></td>
<td>42</td>
<td><img src="image11.png" alt="Image" /></td>
<td>65</td>
<td><img src="image12.png" alt="Image" /></td>
</tr>
<tr>
<td>20</td>
<td><img src="image13.png" alt="Image" /></td>
<td>43</td>
<td><img src="image14.png" alt="Image" /></td>
<td>66</td>
<td><img src="image15.png" alt="Image" /></td>
</tr>
<tr>
<td>21</td>
<td><img src="image16.png" alt="Image" /></td>
<td>44</td>
<td><img src="image17.png" alt="Image" /></td>
<td>67</td>
<td><img src="image18.png" alt="Image" /></td>
</tr>
<tr>
<td>22</td>
<td><img src="image19.png" alt="Image" /></td>
<td>45</td>
<td><img src="image20.png" alt="Image" /></td>
<td>68</td>
<td><img src="image21.png" alt="Image" /></td>
</tr>
<tr>
<td>23</td>
<td><img src="image22.png" alt="Image" /></td>
<td>46</td>
<td><img src="image23.png" alt="Image" /></td>
<td>69</td>
<td><img src="image24.png" alt="Image" /></td>
</tr>
<tr>
<td>24</td>
<td><img src="image25.png" alt="Image" /></td>
<td>47</td>
<td><img src="image26.png" alt="Image" /></td>
<td>70</td>
<td><img src="image27.png" alt="Image" /></td>
</tr>
<tr>
<td>25</td>
<td><img src="image28.png" alt="Image" /></td>
<td>48</td>
<td><img src="image29.png" alt="Image" /></td>
<td>71</td>
<td><img src="image30.png" alt="Image" /></td>
</tr>
<tr>
<td>26</td>
<td><img src="image31.png" alt="Image" /></td>
<td>49</td>
<td><img src="image32.png" alt="Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MB ID</td>
<td>Image</td>
<td>MB ID</td>
<td>Image</td>
<td>MB ID</td>
<td>Image</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td>-------</td>
<td>---------</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>88</td>
<td><img src="image" alt="Pattern 88" /></td>
<td>123</td>
<td><img src="image" alt="Pattern 123" /></td>
<td>158</td>
<td><img src="image" alt="Pattern 158" /></td>
</tr>
<tr>
<td>89</td>
<td><img src="image" alt="Pattern 89" /></td>
<td>124</td>
<td><img src="image" alt="Pattern 124" /></td>
<td>159</td>
<td><img src="image" alt="Pattern 159" /></td>
</tr>
<tr>
<td>90</td>
<td><img src="image" alt="Pattern 90" /></td>
<td>125</td>
<td><img src="image" alt="Pattern 125" /></td>
<td>160</td>
<td><img src="image" alt="Pattern 160" /></td>
</tr>
<tr>
<td>91</td>
<td><img src="image" alt="Pattern 91" /></td>
<td>126</td>
<td><img src="image" alt="Pattern 126" /></td>
<td>161</td>
<td><img src="image" alt="Pattern 161" /></td>
</tr>
<tr>
<td>92</td>
<td><img src="image" alt="Pattern 92" /></td>
<td>127</td>
<td><img src="image" alt="Pattern 127" /></td>
<td>162</td>
<td><img src="image" alt="Pattern 162" /></td>
</tr>
<tr>
<td>93</td>
<td><img src="image" alt="Pattern 93" /></td>
<td>128</td>
<td><img src="image" alt="Pattern 128" /></td>
<td>163</td>
<td><img src="image" alt="Pattern 163" /></td>
</tr>
<tr>
<td>94</td>
<td><img src="image" alt="Pattern 94" /></td>
<td>129</td>
<td><img src="image" alt="Pattern 129" /></td>
<td>164</td>
<td><img src="image" alt="Pattern 164" /></td>
</tr>
<tr>
<td>95</td>
<td><img src="image" alt="Pattern 95" /></td>
<td>130</td>
<td><img src="image" alt="Pattern 130" /></td>
<td>165</td>
<td><img src="image" alt="Pattern 165" /></td>
</tr>
<tr>
<td>96</td>
<td><img src="image" alt="Pattern 96" /></td>
<td>131</td>
<td><img src="image" alt="Pattern 131" /></td>
<td>166</td>
<td><img src="image" alt="Pattern 166" /></td>
</tr>
<tr>
<td>97</td>
<td><img src="image" alt="Pattern 97" /></td>
<td>132</td>
<td><img src="image" alt="Pattern 132" /></td>
<td>167</td>
<td><img src="image" alt="Pattern 167" /></td>
</tr>
<tr>
<td>98</td>
<td><img src="image" alt="Pattern 98" /></td>
<td>133</td>
<td><img src="image" alt="Pattern 133" /></td>
<td>168</td>
<td><img src="image" alt="Pattern 168" /></td>
</tr>
<tr>
<td>99</td>
<td><img src="image" alt="Pattern 99" /></td>
<td>134</td>
<td><img src="image" alt="Pattern 134" /></td>
<td>169</td>
<td><img src="image" alt="Pattern 169" /></td>
</tr>
<tr>
<td>100</td>
<td><img src="image" alt="Pattern 100" /></td>
<td>135</td>
<td><img src="image" alt="Pattern 135" /></td>
<td>170</td>
<td><img src="image" alt="Pattern 170" /></td>
</tr>
<tr>
<td>101</td>
<td><img src="image" alt="Pattern 101" /></td>
<td>136</td>
<td><img src="image" alt="Pattern 136" /></td>
<td>171</td>
<td><img src="image" alt="Pattern 171" /></td>
</tr>
<tr>
<td>102</td>
<td><img src="image" alt="Pattern 102" /></td>
<td>137</td>
<td><img src="image" alt="Pattern 137" /></td>
<td>172</td>
<td><img src="image" alt="Pattern 172" /></td>
</tr>
<tr>
<td>MB ID</td>
<td>Image</td>
<td>MB ID</td>
<td>Image</td>
<td>MB ID</td>
<td>Image</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>103</td>
<td><img src="image103.png" alt="Image" /></td>
<td>138</td>
<td><img src="image138.png" alt="Image" /></td>
<td>173</td>
<td><img src="image173.png" alt="Image" /></td>
</tr>
<tr>
<td>104</td>
<td><img src="image104.png" alt="Image" /></td>
<td>139</td>
<td><img src="image139.png" alt="Image" /></td>
<td>174</td>
<td><img src="image174.png" alt="Image" /></td>
</tr>
<tr>
<td>105</td>
<td><img src="image105.png" alt="Image" /></td>
<td>140</td>
<td><img src="image140.png" alt="Image" /></td>
<td>175</td>
<td><img src="image175.png" alt="Image" /></td>
</tr>
<tr>
<td>106</td>
<td><img src="image106.png" alt="Image" /></td>
<td>141</td>
<td><img src="image141.png" alt="Image" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
New and Enhanced MapBasic Statements and Functions

These are the new statements and functions available for the MapInfo Professional 7.5 product.

Sections in this Appendix:

New statements and functions
- Objects Move Statement ........................................... I-79
- Objects Offset Statement .......................................... I-80
- Offset() Function .................................................. I-81
- SphericalOffset() Function ....................................... I-81
- CartesianOffset() Function ....................................... I-82
- OffsetXY() Function ............................................... I-83
- SphericalOffsetXY() Function .................................... I-84
- CartesianOffsetXY() Function .................................... I-85

Enhanced statements
- LayerInfo( ) function ............................................. I-85
- Register Table Statement ......................................... I-87
- Server Create Map Statement .................................... I-91
- TableInfo( ) function ............................................. I-92
Objects Move Statement

Purpose

Objects Move moves the objects obtained from the current selection within the input table.

Syntax

```
Objects Move
Angle angle
Distance distance
[Unit unit]
[Type {Spherical | Cartesian}]
```

Description

Objects Move moves the objects within the input table. The source objects are obtained from the current selection. The resulting objects replace the input objects. No data aggregation is performed or necessary, since the data associated with the original source objects is unchanged.

The object is moved in the direction represented by angle, measured from the positive X-axis (east) with positive angles being counterclockwise, and offset at a distance given by the distance parameter. The distance is in the units specified by unit parameter, if present. If the Units clause is not present, then the current distance unit is the default. By default, MapBasic uses miles as the distance unit; to change this unit, see the Set Distance Units statement.

The optional Type sub-clause lets you specify the type of distance calculation used to create the offset. If the Spherical type is used, then the calculation is done by mapping the data into a Latitude/Longitude On Earth projection and using distance measured using Spherical distance calculations. If the Cartesian type is used, then the calculation is done by considering the data to be projected to a flat surface and distances are measured using cartesian distance calculations. If the Type sub-clause is not present, then the Spherical distance calculation type is used. If the data is in a Latitude/Longitude Projection, then Spherical calculations are used regardless of the Type setting. If the data is in a NonEarth Projection, the Cartesian calculations are used regardless of the Type setting.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

Example

```
Objects Move Angle 45 Distance 100 Units "mi" Type Spherical
```
Objects Offset Statement

**Purpose**

Objects Offset copies objects, obtained from the current selection, offset from the original objects.

**Syntax**

```
Objects Offset
    [Into Table intotable]
    Angle angle
    Distance distance
    [Units unit]
    [Type {Spherical | Cartesian}]
    [Data column = expression [, column = expression ...]]
```

**Description**

Objects Offset makes a new copy of objects offset from the original source objects. The source objects are obtained from the current selection. The resulting objects are placed in the Into Table, if the Into clause is present. Otherwise, the objects are placed into the same table as the input objects are obtained from (i.e., the base table of the selection).

The object is moved in the direction represented by angle, measured from the positive X-axis (east) with positive angles being counterclockwise, and offset at a distance given by the distance parameter. The distance is in the units specified by unit parameter, if present. If the Units clause is not present, then the current distance unit is the default. By default, MapBasic uses miles as the distance unit; to change this unit, see the Set Distance Units statement.

The optional Type sub-clause lets you specify the type of distance calculation used to create the offset. If the Spherical type is used, then the calculation is done by mapping the data into a Latitude/Longitude On Earth projection and using distance measured using Spherical distance calculations. If the Cartesian type is used, then the calculation is done by considering the data to be projected to a flat surface and distances are measured using cartesian distance calculations. If the Type sub-clause is not present, then the Spherical distance calculation type is used. If the data is in a Latitude/Longitude Projection, then Spherical calculations are used regardless of the Type setting. If the data is in a NonEarth Projection, the Cartesian calculations are used regardless of the Type setting.

If you specify a Data clause, the application performs data aggregation.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.
Example

Objects Offset Into Table c:\temp\table1.tbl Angle 45 Distance 100 Units “mi”
Type Spherical

Offset() Function

Purpose
Returns a copy of the input object offset by the specified distance and angle.

Syntax

```
Offset(object, angle, distance, units)
```

where:
- `object` is the object being offset,
- `angle` is the angle to offset the object,
- `distance` is the distance to offset the object, and
- `units` is a string representing the unit in which to measure `distance`.

Return Value
- Object

Description
This function produces a new object that is a copy of the input `object` offset by `distance` along `angle` (in degrees with horizontal in the positive X-axis being 0 and positive being counterclockwise). The `unit` string, similar to that used for `ObjectLen` or `Perimeter`, is the unit for the distance value. The `DistanceType` used is Spherical unless the Coordinate System is NonEarth. For NonEarth, Cartesian `DistanceType` is automatically used. The coordinate system used is the coordinate system of the input object.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

Example

```
Offset(Rect, 45, 100, "mi")
```

SphericalOffset() Function

Purpose
Returns a copy of the input object offset by the specified distance and angle using a spherical `DistanceType`. 
Syntax

\texttt{SphericalOffset(object, angle, distance, units)}

where:

- \texttt{object} is the object being offset,
- \texttt{angle} is the angle to offset the object,
- \texttt{distance} is the distance to offset the object, and
- \texttt{units} is a string representing the unit in which to measure \texttt{distance}.

Return Value

Object

Description

This function produces a new object that is a copy of the input \texttt{object} offset by \texttt{distance} along \texttt{angle} (in degrees with horizontal in the positive X-axis being 0 and positive being counterclockwise). The \texttt{unit} string, similar to that used for \texttt{ObjectLen} or \texttt{Perimeter}, is the unit for the distance value. The DistanceType used is \texttt{Spherical}. If the Coordinate System of the input object is NonEarth, an error will occur, since Spherical DistanceTypes are not valid for NonEarth. This is signified by returning a NULL object. The coordinate system used is the coordinate system of the input object.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (for example, the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

Example

\texttt{SphericalOffset(Rect, 45, 100, "mi")}

\texttt{CartesianOffset()} Function

Purpose

Returns a copy of the input object offset by the specified distance and angle using a \texttt{Cartesian} DistanceType.

Syntax

\texttt{CartesianOffset(object, angle, distance, units)}

where:

- \texttt{object} is the object being offset,
- \texttt{angle} is the angle to offset the object,
- \texttt{distance} is the distance to offset the object, and
- \texttt{units} is a string representing the unit in which to measure \texttt{distance}.
**Return Value**
Object

**Description**
This function produces a new object that is a copy of the input `object` offset by `distance` along `angle` (in degrees with horizontal in the positive X-axis being 0 and positive being counterclockwise). The `unit` string, similar to that used for `ObjectLen` or `Perimeter`, is the unit for the distance value. The `DistanceType` used is Cartesian. If the Coordinate System of the input object is Lat/Long, an error will occur, since Cartesian DistanceTypes are not valid for Lat/Long. This is signified by returning a NULL object. The coordinate system used is the coordinate system of the input object.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

**Example**

```
CartesianOffset(Rect, 45, 100, "mi")
```

**OffsetXY() Function**

**Purpose**
Returns a copy of the input object offset by the specified X and Y offset values.

**Syntax**
```
OffsetXY(object, xoffset, yoffset, units)
```

where:
- `object` is the object being offset,
- `xoffset` and `yoffset` are the distance along the x and y axes to offset the object, and
- `units` is a string representing the unit in which to measure `distance`.

**Return Value**
Object

**Description**
This function produces a new object that is a copy of the input `object` offset by `xoffset` along the X-axis and `yoffset` along the Y-axis. The `unit` string, similar to that used for `ObjectLen` or `Perimeter`, is the unit for the distance values. The `DistanceType` used is Spherical unless the Coordinate System is NonEarth. For NonEarth, Cartesian DistanceType is automatically used. The coordinate system used is the coordinate system of the input object.
There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

Example

```
OffsetXY(Rect, 92, -22, "mi")
```

### SphericalOffsetXY() Function

**Purpose**

Returns a copy of the input object offset by the specified X and Y offset values using a spherical DistanceType.

**Syntax**

```
SphericalOffsetXY(object, xoffset, yoffset, units)
```

where:

- `object` is the object being offset,
- `xoffset` and `yoffset` are the distance along the x and y axes to offset the object, and
- `units` is a string representing the unit in which to measure distance.

**Return Value**

Object

**Description**

This function produces a new object that is a copy of the input `object` offset by `xoffset` along the X-axis and `yoffset` along the Y-axis. The `unit` string, similar to that used for `ObjectLen` or `Perimeter`, is the unit for the distance values. The DistanceType used is Spherical. If the Coordinate System of the input object is NonEarth, an error will occur, since Spherical DistanceTypes are not valid for NonEarth. This is signified by returning a NULL object. The coordinate system used is the coordinate system of the input object.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.
Example

SphericalOffsetXY(Rect, 92, -22, "mi")

**CartesianOffsetXY() Function**

**Purpose**

Returns a copy of the input object offset by the specified X and Y offset values using a cartesian DistanceType.

**Syntax**

```plaintext
CartesianOffsetXY(object, xoffset, yoffset, units)
```

where:

- `object` is the object being offset,
- `xoffset` and `yoffset` are the distance along the x and y axes to offset the object, and
- `units` is a string representing the unit in which to measure distance.

**Return Value**

Object

**Description**

This function produces a new object that is a copy of the input object offset by `xoffset` along the X-axis and `yoffset` along the Y-axis. The `unit` string, similar to that used for ObjectLen or Perimeter, is the unit for the distance values. The DistanceType used is Cartesian. If the Coordinate System of the input object is Lat/Long, an error will occur, since Cartesian DistanceTypes are not valid for Lat/Long. This is signified by returning a NULL object. The coordinate system used is the coordinate system of the input object.

There are some considerations for Spherical measurements that do not hold for Cartesian measurements. If you move an object that is in Lat/Long, the shape of the object remains the same, but the area of the object will change. This is because you are picking one offset delta in degrees, and the actual measured distance for a degree is different at different locations.

For the Offset functions, the actual offset delta is calculated at some fixed point on the object (e.g., the center of the bounding box), and then that value is converted from the input units into the Coordinate System's units. If the coordinate system is Lat/Long, the conversion to degrees uses the fixed point. The actual converted distance measurement could vary at different locations on the object. The distance from the input object and the new offset object is only guaranteed to be exact at the single fixed point used.

**Example**

```plaintext
CartesianOffsetXY(Rect, 92, -22, "mi")
```

**LayerInfo( ) function**

We have added a new Layer_Info_Type to accommodate the new WMS functionality.

**Purpose**

Returns information about a layer in a Map window.

**Syntax**

```plaintext
LayerInfo(map_window_id, layer_number, attribute)
```
map_window_id is a Map window identifier

layer_number is the number of a layer in the current Map window (e.g., 1 for the top layer); to determine the number of layers in a Map window, call MapperInfo( )

attribute is a code indicating the type of information to return; see table in the MapBasic 7.0 documentation

Note: For information on the Return Value, the Restrictions, Attribute Codes, Description and the Example, see the MapBasic 7.0 documentation.

<table>
<thead>
<tr>
<th>attribute code</th>
<th>LayerInfo( ) Return Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAYER_INFO_TYPE</td>
<td>SmallInt value, indicating this layer's file type:</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_NORMAL for a normal layer;</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_COSMETIC for the Cosmetic layer;</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_IMAGE for a raster image layer;</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_THEMATIC for a thematic layer.</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_GRID for a grid image layer.</td>
</tr>
<tr>
<td></td>
<td>LAYER_INFO_TYPE_WMS for a layer from a Web Map Service</td>
</tr>
</tbody>
</table>
Register Table Statement

Note: Itemsbolded in the syntax section of this part represent the enhanced part of the statement.

Purpose
Builds a MapInfo Professional table from a spreadsheet, database, text file, raster, or grid image.

Syntax
Register Table source_file
(Type "NATIVE" | Type "DBF" [Charset char_set] |
Type "ASCII" [Delimiter delim_char] [Titles] [CharSet char_set] | Type "WKS" [Titles] [Range range_name] |
Type "WMS" [Coordsys coordsys_string] [CharSet char_set] |
[Into destination_file] |
Type "XLS" [Titles] [Range range_name] |
Type "Access" Table table_name [Password pwd] [CharSet char_set] |
Type ODBC Connection {Handle ConnectionNumber | ConnectionString} Toolkit toolkitname Cache (On | OFF) |
Type "GRID" |
Type "RASTER" [ControlPoints (MapX1, MapY1) (RasterX1, RasterY1), (MapX2, MapY2) (RasterX2, RasterY2), (MapX3, MapY3) (RasterX3, RasterY3), [...]] [CoordSys ...] |
Type "SHAPEFILE" [Charset char_set] CoordSys... [PersistentCache (On | Off)] [Symbol...] [Linestyle Pen(...)] [Regionstyle Pen(...) Brush(...)] [Interactive] [Into destination_file]

source_file is a string that specifies the name of an existing database, spreadsheet, text file, raster, or grid image. If you are registering an Access table, this argument must identify a valid Access database.

char_set is the name of a character set; see the separate CharSet discussion.

delim_char specifies the character used as a column delimiter. If the file uses Tab as the delimiter, specify 9. If the file uses commas, specify 44.

range_name is a string indicating a named range (e.g., “MyTable”) or a cell range (e.g., an Excel range can be specified as “Sheet1!R1C1:R9C6” or as “Sheet1!A1:F9”).

table_name is a string that identifies an Access table.

pwd is the database-level password for the database, to be specified when database security is turned on.

ConnectionNumber is an integer value that identifies an existing connection to an ODBC database.

ConnectionString is a string used to connect to a database server. See the Server Connect function.

toolkitname is “ODBC” or “ORAINET.”

SQLQuery is the SQL query used to define the MapInfo table.
ControlPoints are optional, but can be specified if the type is Grid or Raster. If the ControlPoints token is specified, it must be followed by at least 3 pairs of Map and Raster coordinates which are used to georegister an image. If the ControlPoints are specified, they will override and replace any control points associated with the image or an associated World file.

The CoordSys clause is optional, but can be specified if the type is Grid or Raster. If a CoordSys is specified, it will override and replace any coordsys associated with the image. This is useful when registering a raster image that has an associated World file.

In the case of Shapefiles, the CoordSys clause is mandatory. The compiler will indicate an error if it is missing.

PersistentCache On specifies if .map and .id files generated during the opening of Shapefiles are saved on hard disk after closing a table. If PersistentCache is set to Off, then these .map and .id files will be deleted after closing a table and will be generated each time the table is opened.

Symbol (...) clause specifies the symbol style to be used for a point object type created from a shapefile

Linestyle Pen (...) clause specifies the line style to be used for a line object type created from a shapefile

Regionstyle Pen (...) Brush(...) clause specifies the line style and fill style to be used for a region object type created from a shapefile

The Interactive keyword is optional, but can be specified if the type is Grid or Raster. If the Interactive keyword is specified, the user will be prompted for any missing control point or projection information. If the Interactive keyword is not specified, a .tab file will be generated without user input and will be created as though the user had selected “Display” when opening a raster image from the Open dialog box.

destination_file specifies the name to give to the MapInfo table (.tab file). This string may include a path; if it does not include a path, the file is built in the same directory as the source file.

Description

Before you can use a non-native file (e.g., a dBASE file) in MapInfo, you must register the file. The Register Table statement tells MI Pro to examine a non-native file (e.g., filename.DBF) and build a corresponding table file (filename.tab). Once the Register Table operation has built a table file, you can access the file as an MapInfo table.

The Register Table statement does not copy or alter the original data file. Instead, it scans the data, determines the datatypes of the columns, and creates a separate table file. The table is not opened automatically. To open the table, use an Open Table statement.

Note: Each data file need only be registered once. Once the Register Table operation has built the appropriate table file, subsequent MI Pro sessions simply Open the table, rather than repeat the Register Table operation.

The Type clause specifies where the file came from originally. This consists of the keyword Type, followed by one of the following character constants: NATIVE, DBF, ASCII, WKS, XLS, Raster, Access, or Grid. The other information is necessary for preparing certain types of tables. If the type of file being registered is a grid, the coordsys string will be read from the grid file and a MapInfo .tab file will be created. If a raster file is being registered, the .tab file that is generated will be the same as if the user selected “Display” when opening a raster image from the Open dialog box.
If the type of file being registered is a grid, the coordsys string will be read from the grid file and a MapInfo .tab file will be created. If a raster file is being registered, the .tab file that is generated depends upon georegistration information can be found in the image file or associated World file.

The CharSet clause specifies a character set. The char_set parameter should be a string such as “MacRoman” or “WindowsLatin1”. If you omit the CharSet clause, MI Pro uses the default character set for the hardware platform that is in use at run-time. See the CharSet clause discussion for more information.

The Delimiter clause is followed by a string containing the delimiter character. The default delimiter is a TAB. The Titles clause indicates that the row before the range of data in the worksheet should be used as column titles. The Range clause allows the specification of a named range to use. The Into clause is used to override the table name or location of the .tab file. By default, it will be named the same as the data file, and stored in the same directory. However, when reading a read-only device such as a CD-ROM, you need to store the .tab file on a volume that is not read-only.

**Registering Access Tables**

When you register an Access table, MI Pro checks for a counter column with a unique index. If there is already a counter column, MI Pro registers that column in the .tab file. The column is read-only.

If the Access table does not have a counter column, MI Pro modifies the Access table by adding a column called MAPINFO_ID with the counter datatype. In this case, the counter column does not display in MapInfo.

**Note:** Do not alter the counter column in any way. It must be exclusively maintained automatically by MapInfo.

Access datatypes are translated into the closest MapInfo datatypes. Special Access datatypes, such as OLE objects and binary fields, are not editable in MapInfo Professional.

**Registering ODBC Tables**

Before accessing a table live from a remote database, it is highly recommended that you first open a map table (e.g., canada.tab) for the database table. If you don't open a map table, the entire database table will be downloaded all at once, which could take a long time.

Open a map table and zoom in to an area that corresponds to a subset of rows you wish to see from the database table. For example, if you want to download rows pertaining to Ontario, zoom in to Ontario on the map. As a result, when you open the database table, only rows within the map window's MBR (minimum bounding rectangle), in this case Ontario, will be downloaded.

This is a list of known problems/issues with live access:

- Every table must have a single unique key column.
- FastEdit is not supported.
- With MS ACCESS if the key is character, it will not display rows where the key value is less than the full column width e.g., if the key is char(5) the value 'aaaaa' will look like a deleted row.
- For Live Access, the ReadOnly checkbox on the save table dialogue will be grayed out.
- Changes made by another user are not visible until a browser is scrolled or somehow refreshed. Inserts by another user are not seen until either: 1). An MBR search returns the
row or 2). PACK command is issued In addition if cache is on another users updates may not appear until the cache is invalidated by a pan or zooming out.

- There will be a problem if a client side join (through SQL Select menu item or MapBasic) is done against 2 or more SPATIALWARE tables that are stored in different coordinate systems. This is not an efficient thing to do (it is better to do the join in the SQL statement that defines the table) but it is a problem in the current build.
- Oracle 7 tables that are indexed on a decimal field larger than 8 bytes will cause MI Pro to crash when editing.
- If the Cache OFF statement is before the connection string an error will be generated at compile time.

Registering Shapefiles

When you register shapefiles, they can be opened in MapInfo Professional with read-only access. Since a shapefile itself does not contain projection information, you must specify a CoordSys clause. It is also possible to set styles that will be used when shapefile objects are displayed in MapInfo Professional. Projection and style information is stored as metadata in the TAB file.

Examples

Example 1

Register Table “c:\mapinfo\data\rpt23.dbf”
Type “DBF”
Into “Report23”

Open Table “c:\mapinfo\data\Report23”

Example 2

Open Table “C:\Data\CANADA\Canada.tab” Interactive
Map From Canada
set map redraw off
Set Map Zoom 1000 Units “mi”
set map redraw on
Register Table “odbc_cancaps”
TYPE ODBC
TABLE “Select *  From informix.can_caps”
CONNECTION
DSN=ius_adak;UID=informix;PWD=informix;DATABASE=sw;HOST=adak;
SERVER=adak_tli;SERVICE=sqlexec;PROTOCOL=onsoctcp;”
Into
”D:\MI\odbc_cancaps.tab”
Open Table “D:\MI\odbc_cancaps.tab” Interactive
Map From odbc_cancaps

Example 3

Registering a completely georeferenced raster image (the raster handler can return at least 3 control points and a projection)

Register Table "GeoRef.tif" type "raster" into "GeoRef.tab"

Example 4

Registering a raster image that has an associated World file containing control point information, but no projection.
Example 5

Registering a raster image that has no control point or projection information.

Register Table "NoRegistration.BMP" type "raster" controlpoints (1000,2000) (1,2), (2000,3000) (2, 3), (5000,6000) (5,6) coordsys earth projection 9, 62, "m", -96, 23, 29.5, 45.5, 0, 0 into "NoRegistration.tab"

Example 6

The following example registers a shapefile.

Register Table "C:\\Shapefiles\\CNTYLN.SHP" TYPE SHAPEFILE Charset "WindowsLatin1" Coordsys Earth Projection 1, 33 PersistentCache Off linestyle Pen (2,26,16711935) Into "C:\\Temp\\CNTYLN.tab" Open Table "C:\\Temp\\CNTYLN.tab" Interactive Map From CNTYLN

See Also

Open Table, Create Table

Server Create Map Statement

**Note:** Items bolded in the syntax section of this part represent the enhanced part of the statement

**Purpose**

This function identifies the spatial information for a server table. It does not alter the table to add the spatial columns.

A new object type clause in the Server Create Map statement allows you to specify objects as regions, lines, or all objects. If no object type clause is specified, the default is points.

**Syntax**

```plaintext
Server ConnectionNumber Create Map
   For DBMSTableName
   Type { see Maptypes below }
   CoordSys ...
   [MapBounds {Data|Coordsys|Values (x1, y1) (x2, y2)} ]
   [ObjectType { Point | Line | Region | ALL } ]
   [Symbol (...) ]
   [Linestyle Pen(...) ]
   [Regionstyle Pen(...) Brush(...) ]
   [StyleType style_number (0 or 1) [ Column column_name ]
```

**ConnectionNumber** An integer value that identifies the specific connection.

**DBMSTableName** The table identifier for the DBMS table. This is case sensitive and should contain the schema/owner.

**MapTypes** One of the mappable DBMS datatype options listed here:

- **MICODE MICODEColName (XCoordColName, YCoordColName)** — MICODE spatial index key column and numeric X and Y coordinate columns. Column names are case sensitive.
• XYINDEX (XCoordColName, YCoordColName) — Numeric X and Y coordinate columns.
• ORA_SP SDO_Spatial_Column_Name — Oracle Spatial
• IUS_SW ST_Spatial_Column_Name — SpatialWare IUS Blade
• IUS_MM_SW columnname — MapInfo MapMarker Geocoding DataBlade for SpatialWare
• IUS_MM_XY columnname — MapInfo MapMarker Geocoding DataBlade for XY
• SPATIALWARE — SpatialWare for SQL Server

CoordSys ... This clause specifies the coordinate system and projection to be used. For Oracle Spatial, this is not required because it is determined from the Oracle Server metadata.

ObjectType clause This clause specifies the type of object in the table, defaults to points.

Symbol (...) clause This clause specifies the symbol style to be used for a point object type

Linestyle Pen (...) clause This clause specifies the line style to be used for a line object type

Regionstyle Pen (...) Brush(...) clause This clause specifies the line style and fill style to be used for a region object type

StyleType sets per row symbology. The Column token and argument need to be present when StyleType is set to 1 (one). When style_number is set to zero, the Column token is ignored and the rendition columns in the MAPCATALOG are cleared.

Description

The Server Create Map statement makes a table linked to a remote database mappable. For a SpatialWare or Oracle Spatial table, you can make the table mappable for points, lines, or regions. For all other tables, you can make a table mappable for points only. Any MapInfo table may be displayed in a Browser, but only a mappable table may have graphical objects attached. Only mappable tables can display in Map windows.

Note: If Oracle9i is the server and the coordinate system is specified Lat/Long without specifying the datum, the default datum World Geodetic System 1984 (WGS 84) is assigned as the coordinate system. This behavior is consistent with the Server Create Table statement and EasyLoader.

The MapBounds option allows you to specify what to store for the entire/default table view bounds in the MapCatalog. The default is Data which calculates the bounds of all the data in the layer. (For programs compiled before 7.5, the default will be CoordSys.)

The Coordsys MapBounds option stores the coordinate system bounds. This is not recommended as it may cause the entire layer.default view to appear empty if the coordsys bounds are significantly greater than the bounds of the actual data. Most users are zoomed out too far to see their data using this option.

The Values option lets you specify your own bounds values for the MapCatalog.

TableInfo( ) function

Purpose

Returns information about an open table.

Syntax

TableInfo( table_id , attribute )
**table_id** is a String representing a table name, a positive Integer table number, or 0 (zero)

**attribute** is an Integer code indicating which aspect of the table to return

**Note:** For information on the Return Values, the Restrictions, Attribute Codes, Descriptions and the Examples, see the MapBasic 7.0 documentation.

<table>
<thead>
<tr>
<th>attribute code</th>
<th>TableInfo( ) returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB_INFO_TYPE</td>
<td>SmallInt result, indicating the type of table. The returned value will match one of these values:</td>
</tr>
<tr>
<td>TAB_TYPE_BASE</td>
<td>(if a normal or seamless table)</td>
</tr>
<tr>
<td>TAB_TYPE_RESULT</td>
<td>(if results of a query)</td>
</tr>
<tr>
<td>TAB_TYPE_IMAGE</td>
<td>(if table is a raster image)</td>
</tr>
<tr>
<td>TAB_TYPE_VIEW</td>
<td>(if table is actually a view; for example, StreetInfo tables are actually views)</td>
</tr>
<tr>
<td>TAB_TYPE_LINKED</td>
<td>(if this table is linked).</td>
</tr>
<tr>
<td>TAB_TYPE_WMS</td>
<td>(if table is from a Web Map Service)</td>
</tr>
</tbody>
</table>
Part II: MapInfo Professional 7.8 Supplement

This part contains the supplement for the MapInfo Professional 7.8 product. We are including this in this document so that you can have one resource for new features for the post-7.0 MapInfo Professional product.

Topics:

- Upgrading to MapInfo Professional 7.8 ......................... II-96
- What’s New in MapInfo Professional 7.8 ......................... II-112
- Working with Coordinate Systems and Projections ........... II-156
- High-Resolution Custom Symbols ............................. II-186
- New and Enhanced MapBasic Statements and Functions ...... II-190
Thank you for upgrading to MapInfo Professional® 7.8!

This section covers the upgrade to MapInfo Professional 7.8 and includes instructions for installing the product. In addition, there are instructions in preparing for the installation and for handling issues that may arise as part of the upgrade process.

Sections in this Chapter:

- System Requirements for MapInfo Professional 7.8 . . . . . . II-97
- Before You Upgrade to MapInfo Professional 7.8 . . . . . . . . II-98
- Upgrading MapInfo Professional 7.8 . . . . . . . . . . . . . . . . II-98
- Setting your Database Connection Preferences . . . . . . . . II-103
- Modifying, Repairing, or Removing MapInfo Pro . . . . . . . . II-104
System Requirements for MapInfo Professional 7.8

These are the system requirements for MapInfo Professional 7.8:

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>Memory</th>
<th>Disk Space</th>
<th>Monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98 SE, Windows 2000 Professional SP 4, Windows NT 4.0 Workstation SP 6a</td>
<td>32 MB of RAM with a minimum of a Pentium PC</td>
<td>MapInfo Professional 103 MB Data 450 MB</td>
<td>16- or 24-bit color SVGA recommended</td>
</tr>
<tr>
<td>Windows XP Professional SP 1a, Windows XP Home SP 1a</td>
<td>64 MB of RAM with a minimum of a Pentium PC</td>
<td>MapInfo Professional 103 MB Data 450 MB</td>
<td>16- or 24-bit color SVGA recommended</td>
</tr>
</tbody>
</table>

Note: The Installer requires that your TEMP variable be set to a valid directory.

Handling Database Connectivity

MapInfo Professional supports the following relational database engines:

- SQL Server 2000 (SpatialWare 4.8.1)
- Informix 9.4 (SpatialWare 4.5.2) on Solaris 32-bit
- Oracle Spatial 10G, 9iR2 and 8.17
- Oracle Locator 9iR2

Further, using ODBC drivers, you can access your data from MapInfo Professional using:

- Oracle ODBC Driver 9.2.0.6
- SQL Server
- Informix 3.82

To make your database work more productive, MapInfo Professional 7.8 provides an interface for opening remote tables called the RDBMS Toolkit. This toolkit gives you the ability to save tables to a remote database using Save Copy As and to create new tables on remote databases. Additionally it gives you the means to create a new table from existing tables. The RDBMS Toolkit is available on the MapInfo web site.

You can also open tables of data from the following databases and make them mappable but only for point data:

- Oracle 9iR2
- MS Access XP
- MS SQL Server 2000
- Informix 9.4
Before You Upgrade to MapInfo Professional 7.8

Before upgrading MapInfo Professional, record your serial number in an easy-to-remember place, such as the title page of the User Guide or Supplement. You need a valid serial number to complete the upgrade. Also, please complete the postage-paid registration card and return it to MapInfo Corporation. Additionally, you can register online by accessing the Contact Info option on the CD Browser.

If the MapInfo Professional 7.8 installer detects an existing version of the product, 6.0 or earlier, or detects that the product had been installed at some time, the installer copies the MAPINFOW.WOR, STARTUP.WOR and MAPINFOW.PRF from the operating system's system directory to <user profile root>\Application Data\MapInfo\MapInfo.

Application data (appdata) files are the non-executable data files that MapInfo Professional uses during operation.

Navigating the MapInfo Professional 7.8 CD Browser

The initial screen of the MapInfo Professional 7.8 CD Browser includes these options:

- **Install Products**: From this option you can install MapInfo Professional (including DBMS support and translators), free data, access to the documentation, and Install Utilities, including: ECW Compressor, GPS, and Meta Data Browser.
- **What’s New**: Display a list and description of new and enhanced features.
- **Online Reference**: MapInfo Professional 7.8 provides the following online reference documents: The MapInfo Professional Supplement, MapBasic Reference, Crystal Reports User’s Guide, the MapInfo Professional Printing Guide, as well as the Adobe Acrobat Reader.
- **Run MapInfo Tutorial**: From this option you can access the MapInfo Tutorial from the MapInfo web site to learn more about the basic features of MapInfo Professional.
- **Other Products**: Display information about MapBasic, MapInfo Discovery, and MapInfo Pro for SQL Server.
- **Contact Information**: Where ever you are, MapInfo is there to help you. Contact us at any of these locations or visit us on the world wide web at www.mapinfo.com!
- **Register Online**: We have simplified the registration process. Simply click this entry and the wizard walks you through the registration process quickly.
- **Browse CD**: From this option you can review the contents of the CD. There are additional utilities that may be useful to you that are only available when you browse.
- **Exit**: From this option you can close the CD Browser application.

Upgrading MapInfo Professional 7.8

**CAUTION**: We strongly recommend that you exit from all Windows programs before beginning the upgrade process.

You must have Administrator rights to run the Installer on NT/2000 and Windows XP.
If your Windows Start menu does not have a MapInfo program folder, the upgrade process creates this folder. If your Windows Start menu already has a MapInfo program folder, the upgrade process creates a new MapInfo icon within that folder.

MapInfo Professional now provides its application data files to each user. Called a Per-User install, this functionality runs the first time you run MapInfo Professional or MapInfo Professional client on a machine, and each time the MapInfo Professional Installer is run thereafter. The application data files include, among others, the Pen Styles file, Custom Symbols files, Graph Support files, and Thematic Legend templates. These files allow different users to have custom settings.

To upgrade MapInfo Professional:

1. On the LAUNCHER menu, click INSTALL PRODUCTS from the MapInfo Professional 7.8 CD Browser.
2. Click MAPINFO PROFESSIONAL INSTALLER. The Install Shield Wizard dialog box displays. Click NEXT to continue the upgrade process and display the License Information dialog box.
3. Click "I ACCEPT THE TERMS IN THE LICENSE AGREEMENT" to accept the terms and click NEXT to continue the upgrade. The Customer Information screen displays.
4. Type your name, organization name, and serial number in these required fields. Click NEXT to continue. The Setup Type dialog box displays.
5. Review the following installation types and determine which instructions are appropriate for your upgrade. Click one of the following and click NEXT to continue:
   - TYPICAL WORKSTATION INSTALLATION. Click this option if you will be using MapInfo Professional as a desktop application requiring no remote database access or connectivity. See Typical Workstation Installation (7.8) on page II-99 to continue these upgrade instructions.
   - CUSTOM WORKSTATION INSTALLATION. Click this option if you require ODBC or Oracle Spatial connectivity support. See Custom Workstation Installation (7.8) on page II-100 to continue the upgrade instructions.
   - NETWORK INSTALLATION. Click this option if you are upgrading your MapInfo Professional network product. See Network Installation (7.8) on page II-102 to continue the upgrade instructions. These instructions are for network administrators only. After you upgrade MapInfo Professional on the network, follow the instructions for upgrading MapInfo Professional on client equipment in Setting Up Client Workstations (7.8) on page II-103.

If you have already upgraded to MapInfo Professional 7.8 or if the product has been previously installed, the Program Maintenance Screen displays. Select MODIFY, REPAIR, or REMOVE to continue. For assistance in completing this process, see Modifying, Repairing, or Removing MapInfo Pro on page II-104. If you find that you need to install ODBC drivers after installing MapInfo Professional, select the MODIFY option to add them.

**Typical Workstation Installation (7.8)**

Choose this option to install MapInfo Professional program files, Online Help, Tools, Universal Translator, and Crystal Reports. The ArcLink translation utility is not installed with this option.

**CAUTION:** Make sure you have completed the directions in Upgrading MapInfo Professional 7.8 on page II-98 before beginning these instructions.
To continue upgrading a typical workstation:

1. In the Setup Type dialog box, click **TYPICAL WORKSTATION INSTALLATION**; the Destination Folder screen displays.
   
   **Note:** If you have an earlier version (or versions) of MapInfo Professional installed and you do not want to overwrite that version, create a new directory name in the next step.

2. Do one of the following:
   - Click **NEXT** to accept the destination folder indicated
   - Click **CHANGE** to create a new path in the Change Current Destination Folder dialog box. Type the new path in the Folder name field and click **OK** to continue. Click **NEXT** to continue.
   
   The Ready to Install the Program screen displays. Review your selections to ensure that the path is correct before moving on. Click **BACK** to return to the previous screens to make changes.

3. Click **INSTALL** to begin the upgrade. The Installing MapInfo Professional 7.8 screen displays with a progress bar indicating the status of the upgrade process.

4. After the upgrade is complete, the prompt: “Would you like to check our web site for any current updates to our product?” displays. If you have an Internet connection, check **YES** to be connected to the page of the MapInfo Corporation web site containing information about product updates. This ensures that you have the most up-to-the minute MapInfo Professional product available.

5. When the Install Shield Wizard Complete screen displays, choose **FINISH** to return to the Install Products screen.
   
   **Note:** When you open MapInfo Professional 7.8 for the first time, the final installation and configuration process takes place. This happens automatically and does not require any additional work.

### Custom Workstation Installation (7.8)

Choose this upgrade type to select components and drivers within the MapInfo Professional 7.8 installation program. This is particularly useful if you need to install MapInfo ODBC Connectivity support and Oracle Spatial Object support.

**CAUTION:** Make sure you have completed the directions in **Upgrading MapInfo Professional 7.8 on page II-98** before beginning these instructions.

To continue upgrading using the custom workstation instructions:

1. In the Setup Type dialog box, click **CUSTOM WORKSTATION INSTALLATION**; the Custom Setup dialog box displays.
A feature description, and the space required for the feature and its sub-features displays in the Feature Description area.

2. In the Custom Setup dialog box you decide what components are to be installed and the directory you want them to install to. Click the feature icon to select the feature for installation.

The options for a Custom Setup include:

- MapInfo Professional Program Files
- Tools (which refer to the MapInfo Utility Tools, Crystal Reports etc.)
- Translators (Universal Translators, ArcLink)
- Help Files
- MapInfo ODBC Connectivity Support
- Oracle Spatial Object Support

3. To select a feature, click the Down Arrow beside it; a menu displays.

4. For each feature you want to install, select one of the following:
   - This feature will be installed on local hard drive.
   - This feature, and all subfeatures, will be installed on local hard drive
   - This feature will not be available

   **Note:** For some features, there are additional options pertaining to use of the feature from the network. Choose the option that describes your systems implementation of this feature.

When you select the first or second options in the bullets described above, the feature will be installed on your local hard drive in the default folder. This path displays in the INSTALL TO: entry below the CUSTOM SETUP list pane. To specify another path, select CHANGE button to the right of this path. When you do the Current Destination folder dialog box displays allowing you to choose a new path.

To see if you have enough space on your hard drive or other mapped resources, click the SPACE button. The Disk Space Requirement dialog box displays the disk size, the amount of available space, and the amount of space the selected install would take.
Note: You can choose to not install a component. To do this, skip the feature entry entirely.

5. After you select all the custom options you want to install, click NEXT to display the READY TO INSTALL THE PROGRAM dialog box.

6. Click the INSTALL button to begin the installation of MapInfo Professional with the features you selected. The INSTALLING MAPINFO PROFESSIONAL 7.8 screen displays with a progress bar indicating the status of the upgrade process.

7. Install MapInfo Professional according to your selections.

8. At the end of the upgrade, the prompt: “Would you like to check our web site for any current updates to our product?” displays. If you have an Internet connection, click YES to access the MapInfo Corporation web site containing information about product updates.

9. When the InstallShield Wizard Complete screen displays, choose FINISH to return to the Install Products screen.

Note: When you open MapInfo Professional 7.8 for the first time, the final installation and configuration process takes place. This happens automatically and does not require any additional work.

Adding ODBC Drivers

You add the ODBC drivers as part of the Custom Installation process. You can set your database connection preferences in Setting your Database Connection Preferences on page II-103.

Network Installation (7.8)

Installing MapInfo Professional 7.8 on a network involves two separate procedures:

- Installing the product on a network drive (presumably done by the Network Administrator).
- Setting up users with program manager icons, etc. (presumably done by the user).

Make sure you have completed the directions in Upgrading MapInfo Professional 7.8 on page II-98 before beginning these directions.

Choose this installation ONLY if you are a Network Administrator and have full rights to the network.

To continue upgrading MapInfo Professional 7.8 on a network:

1. Click NETWORK INSTALLATION; the Administrator Selection Screen displays.

   The options for a Network Setup include:

   - MAPINFO PROFESSIONAL PROGRAM FILES
   - TOOLS, TRANSLATORS
   - HELP FILES

   A feature description, and the space required for the feature, displays in the Feature Description area. Click the option icon to install it.

2. When you select a feature, a menu displays allowing you to choose to install and/or run the feature and its subfeatures from various locations, including your local hard drive or from CD.

   If you select the hard drive option, the feature will be installed in the path indicated; on your local hard drive in the folder indicated; to specify a different location, choose CHANGE to display the Current Destination folder screen.
If you choose to install an option to your hard drive, the SPACE button is enabled; choose this button to display the Disk Space Requirement dialog box.

**Note:** You can choose to not install a feature by skipping it.

See [Installing MapInfo Professional 7.8 on a Network Drive on page II-103](#) for additional details.

3. After the upgrade is complete, the prompt: "Would you like to check our web site for any current updates to our product?" displays. If you have an Internet connection, check YES to be connected to the page of the MapInfo Corporation Web site containing information about product updates.

4. When the InstallShield Wizard Complete screen displays, choose FINISH to return to the Install Products screen.

### Installing MapInfo Professional 7.8 on a Network Drive

The procedure for installing MapInfo Professional on a network drive is the same as the regular installation procedure except for the following:

- Select Network Installation in the Setup Type screen.
- Continue as in a Workstation Installation, selecting features, destination locations, etc.

The Network Installation alone does not install any files to the local hard drive.

### Setting Up Client Workstations (7.8)

To permit a user to use this network installation of MapInfo Professional, run SETUP.EXE:

1. Map a drive to the MapInfo Professional Install directory.
2. Select RUN from the START menu.
3. Run SETUP.EXE from the [MapInfo install directory]\AddClient. The MapInfo Professional 7.8 Client Welcome screen displays.
4. Click NEXT. The License Information screen displays.
5. Click "I ACCEPT THE TERMS OF THE LICENSE AGREEMENT" and select NEXT. The Customer Information screen displays with the network install values as the default.
6. Modify for the current instance and select NEXT.
7. Click INSTALL to continue the installation.
8. Click FINISH to complete the client installation.

### Setting your Database Connection Preferences

If you have a favorite database connection setting, we have established a Startup preference setting to create that connection automatically at the beginning of your session.

To set Database Connection Startup preference:

1. In the OPTIONS menu, click PREFERENCES and then STARTUP to display the STARTUP PREFERENCES dialog box.
2. Click the Set button to display the Select DBMS Connection list.

3. Do one of the following:
   • Select an entry in the list and click OK to accept the preference.
   • To establish a new database connection and apply the preference, click the New button and select the connection type you want to search for.
     • If you select ODBC, the Select Data Source dialog box displays and you can search for the database from this dialog box. Select the database connection and click OK to return to the Startup Preferences dialog box.
     • If you select ORACLE SPATIAL, the MAPINFO ORACLE CONNECT dialog box displays. Enter the user name, password, and server name of the database you are adding. Click OK to save your entries and return to the STARTUP PREFERENCES dialog box.
   Once you have selected a DBMS connection, it displays in the DEFAULT DBMS CONNECTION field and is set to connect each time you open MapInfo Professional.

Keep in mind that you can also make a DBMS connection from any of these three dialog boxes: OPEN, CREATE NEW TABLE, and SAVE COPY AS.

Modifying, Repairing, or Removing MapInfo Pro

Use the Program Maintenance feature of the CD Browser to modify, repair, or remove MapInfo Professional 7.8.

To access Program Maintenance:

1. Click INSTALL PRODUCTS from the MapInfo Professional CD Browser.
2. Click MAPINFO PROFESSIONAL. The Welcome screen displays. Choose NEXT. The Program Maintenance screen displays.
3. Choose modify, repair, or remove MapInfo Professional 7.8 based on your needs.
   • Click **MODIFY** to display the Custom Setup dialog box. See the instructions for **Custom Workstation Installation (7.8)** on page II-100 for more about this process.
   • Click **REPAIR** to repair installation errors in the program.
   • Click **REMOVE** to remove an existing copy of MapInfo Professional 7.8 from your system. The installer displays the **REMOVE THE PROGRAM** dialog box. Click **REMOVE** to uninstall the product’s programs from your system.

You can also access the Program Maintenance screen from the **START** menu by clicking **CONTROL PANEL** and then **ADD/REMOVE PROGRAMS** and finally **MAPINFO PROFESSIONAL 7.8**.

**Controlling Advanced System Settings (7.8)**

MapInfo Professional has some advanced system settings—settings that cannot be configured through a dialog box. These settings allow you to control several low-level, technical aspects of how MapInfo Professional runs. Most MapInfo Professional users do not need to worry about these advanced settings.

For example, MapInfo Professional has a Dynamic Data Exchange (DDE) time-out setting, which controls how long MapInfo Professional tries to communicate with other applications during DDE communications. If you run a MapBasic application, and that application encounters time-out errors during DDE, you may want to increase the DDE time-out setting.

If you need to modify one of MapInfo Professional's advanced system settings (such as the DDE time-out setting), use the following procedure.

**Modifying the Windows Registry (7.8)**

MapInfo Professional stores system settings in the Windows registry. To edit the Windows 98 registry, use the REGEDIT program. To edit the Windows 2000 registry, use the REGEDT32 program.

**CAUTION:** Be very careful when editing the registry; damaging the registry can cause serious problems in your operating system.

For example, to set MapInfo Professional’s Dynamic Data Exchange (DDE) time-out setting, locate the following key in the registry:

```
HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo\MapInfo\Common
```

Within that key, edit the DDeTimeout value. If there is no value by that name, create a new value of type string (this data type is referred to as REG_SZ on Windows NT), and assign the name DDeTimeout to the value. Set the value’s data to be a number, representing the number of milliseconds (e.g., enter 30000 to specify a time-out of 30,000 milliseconds, or 30 seconds).

For more information on editing the registry, see the online help for REGEDIT or REGEDT32.
Descriptions of Advanced Registry Settings (7.8)

This section describes advanced settings that are stored in the registry.

DDeTimeout = number
This setting controls MapInfo Professional’s time-out setting in DDE conversations where MapInfo Professional is the client (the application that initiates a conversation). The number represents milliseconds. The default value is 10,000 milliseconds (ten seconds). If you run a MapBasic application that attempts to initiate a DDE conversation, but the conversation fails because the server application does not respond within the time-out period, you may need to increase the DDeTimeout number.

OffscreenBitmap = number
The number is 0 (zero) or 1 (one). A value of 1 (the default) indicates that MapInfo Professional will process off-screen bitmaps when drawing a map. This means that if you cover a Map window, and then bring the Map window to the front again, the map redraws instantly. If you set this setting to zero, MapInfo Professional will not process off-screen bitmaps. This means that when you bring a Map window to the front, you may have to wait as MapInfo Professional redraws the map.

If you are using a video driver that is uncommon or buggy, and if you encounter video problems with Map windows, you may be able to eliminate those problems by setting the OffscreenBitmap number to 0.

MaxFiles = number
This setting must be an integer from 10 to 100, indicating how many files MapInfo Professional can open simultaneously. This setting does not limit the number of tables you can open, but it does limit the number of tables you can edit at one time (the number of tables that have unsaved edits). The default value is 29. If you need to work with more files simultaneously, set number to 100.

MaxORACLETILES = number
A value from 0 = unlimited tiles to infinity.

Improving Performance for MapInfo Professional 7.8
To improve MapInfo Professional’s performance, increase the speed of the processor in the machine. A video accelerator card will increase the speed of the redraw. It will not speed up the initial draw of the map, but all subsequent redraws will be faster. A faster disk cache will also improve performance, as will adding memory.

Controlling the Location of Application Data Files During Installation (7.8)

By default, the setup program for MapInfo Professional installs application data files to locations that make sense for the typical user. After installing the product, the user is free to move one or more of the application data files to another predefined location and MapInfo Professional will find that file. For example, the administrator of a machine might move MAPINFOW.PEN from the per user area (its default location) into the install directory so all users on that machine will share the same set of pens.

For IT personnel responsible for a large number of MapInfo Professional installs it is not practical to manually move application data files to realize the desired configuration.
To solve this problem we have developed a solution that allows IT personnel to specify the location of application data files by creating a setting file called MODE.INI prior to installing MapInfo Professional.

1. Copy the installation files to a read-write location.
2. Create a MODE.INI file in the root directory of the installer.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>per user, roaming</td>
<td>&lt;Current User&gt;\Application Data</td>
</tr>
<tr>
<td>2</td>
<td>per user, not roaming</td>
<td>&lt;Current User&gt;\Local Settings\Application Data</td>
</tr>
<tr>
<td>3</td>
<td>per machine</td>
<td>&lt;All Users&gt;\Application Data</td>
</tr>
<tr>
<td>4</td>
<td>program directory</td>
<td>&lt;Install Dir&gt;</td>
</tr>
</tbody>
</table>

3. Open MODE.INI into any text editor.
4. Edit MODE.INI, modifying the code associated with the application data file/folder whose location you wish to change.
5. Install MapInfo Professional.

The following is a list of predefined locations for application data files supported by MapInfo Professional, and the corresponding numeric code to be used in MODE.INI.

The following is a list of application data files/groups and their default locations:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAPINFOW.CLR</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.PEN</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.FNT</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>MAPINFOW.ABB</td>
<td>program directory</td>
</tr>
<tr>
<td>MAPINFOW.PRJ</td>
<td>program directory</td>
</tr>
<tr>
<td>MAPINFOW.MNU</td>
<td>program directory</td>
</tr>
<tr>
<td>CustSymb</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>ThmTmplt</td>
<td>per user, roaming</td>
</tr>
<tr>
<td>GraphSupport</td>
<td>per machine</td>
</tr>
</tbody>
</table>

**MODE. INI File Example**

Create a text file with the following syntax:

```
GraphSupport = 3
CustSymb = 1
ThmTmplt = 1
MAPINFOW.CLR = 1
MAPINFOF.FNT = 1
```
Installing Data

To help you get started, MapInfo provides you with some United States-based and world-wide maps you can use as a background to your data. Use these instructions to install this free data.

To install the free data provided with MapInfo Professional 7.8:

1. Choose **INSTALL PRODUCTS** from the CD Browser.
2. Choose **FREE DATA** to display the MapInfo Professional Data screen. In this screen, you can also review the data specifications, access new data over the web and learn about what data is available from MapInfo Corporation.
3. Choose **INSTALL FREE DATA**. The Welcome screen displays.
4. Choose **NEXT** to continue. The License Information screen displays.
5. Choose **YES** to accept the terms of the agreement and to continue the installation process. The Choose Destination Location screen displays.
6. Select the product for which you will be installing the data. Select one of the following:
   - MapInfo Professional
   - MapInfo Run Time
   Click **NEXT** to continue.
7. Specify the directory where the data will be installed. Use the Browse button to select a directory if necessary or accept the default directory.
   Click **NEXT** to continue.
8. Choose one of these options:
   - **CUSTOM INSTALL**: Choose which datasets to install. Select the check box beside each dataset you want to install. The size of each dataset displays, as well as space required and space available.
     To see the subcomponents of the data you selected, click **CHANGE**.
   - **TYPICAL INSTALL**: Install all datasets.
     Choose **NEXT** to continue. Respond **YES** to the “Would you like setup to display workspace Icons” prompt if you want to create an icon for each data set you choose.
9. The Select Program Folder screen displays if you chose to set up Workspace icons. Select the program folder where the icons will be created. Choose **NEXT**.
10. The Start Copying Files screen displays. Review the selections you have chosen and click **BACK** to return to any screen to change your selections. When you are ready to begin the installation, click **NEXT**.
11. The Setup Complete dialog box displays; click **FINISH**.

Getting More Data

To learn more about our data products, click the **GET MORE DATA** option in the MapInfo Professional Data screen during the Data Installation process or click **MAPINFO DATA PRODUCTS ON THE WEB** in the Help Menu. If you have a Browser installed, you will be automatically connected
Installing Related Programs, Hardware, and Resources (7.8)

This section contains the instructions for installing the ECW Compressor, the MetaData Browser, the Blue Marble GPS, and the documentation associated with MapInfo Professional. We also include information about the Microsoft Intellimouse and how to use it.

Installing ECW Compressor (7.8)

The ECW raster handler allows you to open and display raster images compressed in the ECW format. We recommend that you exit all Windows programs before installing.

1. Choose **INSTALL PRODUCTS** from the MapInfo Professional 7.8 CD Browser.
2. Choose **ECW COMPRESSOR**. The Welcome screen displays. Choose **NEXT** to continue the installation process.
3. The Software License screen displays. Choose **YES** to accept the terms of the agreement and to continue the installation process.
4. The Choose Destination Location screen displays. Specify the directory where ECW Compressor will be installed.
5. The Select Program Folder screen displays. Select a folder. Choose **NEXT** to continue.
6. The Setup Complete screen displays: choose to display the ReadMe file and/or create a shortcut on your desktop. Choose **FINISH**.

Installing Metadata Browser (7.8)

The Metadata Browser allows you to search data clearinghouse web sites for data products that meet your geographic analysis needs. We recommend that you exit all Windows programs before installing Metadata Browser.

1. Choose **INSTALL PRODUCTS** from the MapInfo Professional 7.8 CD Browser.
2. Choose **METADATA BROWSER**; the Introduction screen displays.
3. Choose **NEXT** to continue the installation process. The License Agreement screen displays.
4. Choose **YES** to accept the terms of the agreement and to continue the installation process. The Choose Install Folder screen displays.
5. Specify the directory where Metadata Browser will be installed. Select **CHOOSE** to display a list of directories.
6. Choose the Shortcut location. You have the option to put the icon in a new group, into the MapInfo group, in the Start menu, on the Desktop, or to display no icon.
7. Click **INSTALL** to begin the installation.
8. After installation is complete, select **DONE**.
Using the Microsoft IntelliMouse™ to Move Around the Windows (7.8)

MapInfo Professional 7.8 supports the Microsoft IntelliMouse™ as follows:

**Document Scrolling:** In the Map, Layout, Browser, and MapBasic windows, hold down the **CONTROL** key and move the wheel to scroll the document vertically; the effect is the same as clicking on the arrow at the end of the scroll bar.

**Document Panning:** In the Map and Browser windows, hold down the wheel button on the IntelliMouse™ and move the mouse to pan the document. Release the button to end the panning. There are three panning speeds. The speed of the panning is based on the cursor’s distance from the starting point, indicated by the origin mark. In the Map window, the distance moved at each speed is a percentage of the zoom distance.

For example, the amount to move at slow speed is .005 * ZoomDistance, medium speed is .01 * ZoomDistance, and super speed is .1 * ZoomDistance. In the Browser, the window is scrolled by 1, 3, and 7 lines or columns for slow, medium and super speeds. When the cursor is within 15 pixels of the starting point, there is no panning.

**AutoScroll:** In the Map and Browser windows, click and release the wheel button to activate AutoScroll. When the mouse cursor is moved away from the starting point the document starts to scroll in whatever direction you move the mouse. When the cursor is returned to the starting point, scrolling stops. AutoScroll is turned off by any mouse click or key stroke. AutoScroll is also turned off when MapInfo Professional loses the focus, for example, when you **ALT-TAB** to another application.

**Zoom:** In the Map and Layout windows, move the wheel forward to zoom in on the document. Roll back the mouse wheel to zoom out on the document. The wheel has a series of settings; each “click” is the same as one click with a zoom tool. The mouse wheel does not recenter the view. There are other keyboard commands that allow you to zoom in and out more precisely. Review the *MapInfo Professional 7.8 User’s Guide (Unabridged)* on your MapInfo Professional 7.8 Installation CD for more information.

Installing Global Positioning Software (GPS) (7.8)

To install Global Positioning Software from Blue Marble:

1. From the CD menu, click **INSTALL PRODUCTS** and then **FREE UTILITIES**.
2. Click **INSTALL GPS SUPPORT**. You will be prompted to exit all applications before installing. Choose **OK**.
3. The MapInfo Special Edition dialog box displays. Choose **OK**.
4. The Select Destination Location screen displays. Specify the directory where GPS will be installed.
5. The Software License screen displays. Choose **YES** to accept the terms of the agreement and to continue the installation process.
6. The Add to the Start Menu dialog box displays: click **YES** to add a shortcut to the **START** menu.
7. The ReadMe displays; choose **OK** to exit the ReadMe.
Installing the Online References

MapInfo Professional 7.8 provides the following online reference documents: MapInfo Professional Supplement, MapBasic Reference Guide, Crystal Reports User’s Guide, ArcLink, and EasyLoader documentation, as well as the Adobe Acrobat Reader.

To install the documentation locally:

1. Install the Acrobat Reader.
2. Copy the files from the [CD_ROM]\PDF_DOCS folder to a local directory.
3. From Windows Explorer, double-click any of the PDF files to automatically launch the Acrobat Reader and the online book.

Note: If you have any questions about the use of the Acrobat Reader, contact Adobe support at www.Adobe.com.

Troubleshooting your Installation

The Installer must be run from a drive with a letter such as G: and not from an explicit UNC path. For example, you might have the MapInfo Professional CD in your computer as USERSPC. Other users may share this device as USERSPC; however, it would not contain a drive letter. The MapInfo Professional Installation program requires a drive letter. To remedy this situation:

1. Right-click the shared directory or CD-ROM and select MAP NETWORK DRIVE.
2. Choose a drive letter to map.
3. Run the Installation Program again from the newly mapped drive letter.

Removing MapInfo Professional 7.8 from your System using Control Panel

Remove MapInfo Professional 7.8 by accessing the CD Browser, Program Maintenance screen, or by choosing the Add/Remove Programs option from the Control Panel in Windows, 98, 2000, Windows NT or Windows XP.

Removing MapInfo Professional 7.8 from your System using the CD Browser

To uninstall MapInfo Professional 7.8:

1. Choose INSTALL PRODUCTS from the CD Browser.
2. Choose MAPINFO PROFESSIONAL. The Welcome screen displays. Choose NEXT.
3. The Program Maintenance Screen displays. Choose REMOVE.
Thank you for upgrading to the most advanced computer mapping product in the MapInfo family! As the field of computer mapping continues to expand, MapInfo leads the way with new products that are designed to fulfill your computer mapping needs from the most basic to the most specialized with MapMarker, our premier address matching product.

Sections in this Chapter:

- New Major Features of MapInfo Professional 7.8 ........ II-113
- Raster Enhancements ........................................... II-129
- Mapping Enhancements ......................................... II-130
- 3D Enhancements ................................................ II-135
- Datum Enhancements ........................................... II-135
- Printing Enhancements ......................................... II-137
- Database Enhancements ....................................... II-138
- Tool Enhancements ............................................. II-139
- Documentation Enhancements ............................... II-149
- Licensing Enhancements ..................................... II-150
- MapBasic Enhancements ......................................... II-151
New Major Features of MapInfo Professional 7.8

There are several exciting new features in Microsoft XP Logo Certified MapInfo Professional 7.8. These innovations are the results of requests from many of our customers and are in response to changes and growth in the computer mapping industry. We are very excited to bring these changes to you in this release.

Adding WFS Client Support

MapInfo Professional 7.8 provides a Web Feature Service (WFS) client to retrieve geospatial GML (Geography Markup Language)2 data using HTTP GET and HTTP POST requests over the Internet or through a private intranet. The WFS client was developed in accordance with the 1.0.0 OpenGIS® Web Feature Service Implementation Specification, which is available online: http://www.opengis.org/docs/02-058.pdf

WFS is similar to WMS (Web Mapping Service), in that both can provide geographic data via the Internet. But while a WMS server provides raster maps, a WFS server provides raw coordinate data that the client uses to produce a map.

A WFS is similar to a Web Map Service, which allows a client to overlay map images from multiple services over the Internet or through a local intranet. For more details on Web Map Services, see the MapInfo Professional v7.8 User’s Guide.

Note: The MapInfo WFS client has been developed in accordance with OGC WFS Specification 1.0.0. Using this client you cannot retrieve data from sites that are compliant with earlier or later versions of the OGC specification.

This version of the WFS client supports GML2 (OGC GML V2.1.1). The OGS WFS Specification states that all servers should support GML2, but may also support other formats. The server provides information on the formats available, and the client makes the request for the data in the format it can use. If the server does not support GML2, it will not be supported by the MapInfo WFS client.

GML2 does not contain any style information. You can provide style information to associate with a particular WFS table.

A WFS request contains a description of query operations that can be applied to one or more features. The client generates the request and posts it to a WFS using HTTP. The web feature server then reads and executes the request.

The GetCapabilities operation queries the WFS server for capabilities. Then the MapInfo Professional WFS client can generate a query appropriate for the WFS server and table.

Each table in the WFS server can result in a single MapInfo table. The mapping is always 1-to-1 (unlike WMS, which is many-to-1).

The TAB file retrieved from a WFS server resembles a read-only DBMS linked table. It contains a MAP file and a DAT file, and acts like a read-only native table. Information is stored so that the table can be refreshed from the WFS server.
The sequence of actions can be summarized as follows:

1. After sending a GetCapabilities request to a WFS server, the server returns a list of WFS layers (FeatureTypes) that it can provide.
2. The user picks a WFS layer to fetch from the server, MapInfo Pro then sends a DescribeFeatureType request to the server. This response is an XML schema that describes the feature.
3. The user can then select which columns and/or rows to fetch.
4. MapInfo Pro sends a GetFeature request to the WFS. If the user did not select a subset of columns, all columns will be requested by default.
5. The response is a GML document containing the feature collection. Each feature represents one “record” in the MapInfo table.

MapInfo has added a list of WFS servers to the client to help you get started in using this new functionality.

Note: Since the data you retrieve using the WFS is remote, it may change from time to time. You can refetch your WFS data manually using the refresh process. See Refreshing a WFS Layer on page II-120 for these instructions.

Accessing Web Feature Services

If a MapInfo WFS table is open, the user interface automatically enables the refresh process. During the refresh process, users can not change the query that is sent to the WFS server. The data will be refetched from the server using the original query. This refreshed information can then be saved to the table.

Note: You must have a working Internet connection whenever you retrieve WFS data.

Opening a Web Feature Service

To open a Web Feature Service:

1. On the FILE menu, select OPEN WEB SERVICE > OPEN WFS or click 🌐 to open the WFS SERVER MAP PROPERTIES dialog box. This opens the default WFS server.
2. Select a server from the **WFS Server** drop-down list, then click **OK**.

**Note:** The WFS Servers that display in the **WFS Server** list are based on a list we have compiled for you. MapInfo has no control over the availability of these servers at any given time. The availability of WFS data depends upon the status of the server and the status of the maps on those servers. You can customize this list to suit your needs.

To see the details of a particular WFS Server, including the Server URL, the Server Name, version, and usually a server supplied description, click **Details**.

3. If you do not see the server you are looking for in the **WFS Server** list, select **Servers** to display the WFS Servers List.
A check mark to the left of the Description indicates the default WFS server, which is selected when you first launch **OPEN WFS**.

You can also choose **SET DEFAULT** to change the default WFS server.

If you do not see the server you are looking for, you can add a server. See **Adding a WFS Server** on page II-121.

**Note:** If you work with a WFS Server that is not the default, MapInfo Professional remembers that new server for the rest of the session and recalls it whenever you return to the **OPEN WFS TABLE** dialog box.
Selecting a WFS Layer

1. After selecting a specific server, select a WFS layer from the WFS SERVER drop-down list.

   Figure: WFS Server Map Properties with Layer Highlighted

   ![WFS Server Map Properties](image)

2. To specify which columns of data to retrieve from the table, click COLUMN FILTER and click the right arrow to move the column name from Available to Selected. If * is shown in the Selected column, all columns of data will be returned. Then click OK to return to the WFS SERVER MAP PROPERTIES dialog box.
3. You can use the **UP** and **DOWN** buttons to change the order of the selected columns. As listed from top to bottom, the selected columns will be ordered from left to right order in the new table. For example, you could use the Up arrow to move LAT and LONG to the top of the list, even if they originally were not in that position.

4. To specify which rows of data to retrieve from the table, click **ROW FILTER**. You can then refine your results using comparison operators based on table data or using spatial operators based on the Geometry object. The default action is to return all rows of data.

Note: The name of the Geometry object and the available spatial operators depends entirely on the server. The WFS client has no control over the availability of that content.

5. Assume that you performed a preliminary WFS query that identified environmentally protected areas in the state of Massachusetts. By default, all rows of data will be returned. But you could use the Row Picker to filter the results and target only those areas in which the Fee Owner (FEE_OWNER column) is the Metropolitan District Commission (MDC) with AREA_ACRES equal to or greater than 20 acres. Select the appropriate Comparison operators and optionally, Conjunction operators, from the drop-down lists.

Figure: Row Picker with Comparison Operators

Then click **OK** to return to the **WFS SERVER MAP PROPERTIES** dialog box.

6. From the same preliminary query that identified environmentally protected areas in the state of Massachusetts, you could also perform a spatial search based on the Geometry object. For example, after zooming in on the mapper window and selecting several objects, you can filter results based on the BBOX spatial operator. The Value drop-down
list always has a choice for ALL and will display CURRENT_MAPPER if one or more windows are open. You will also see a SELECTION choice if one or more objects have been selected from the mapper or browser window.

**Note:** Note that the name of the Geometry object (for example, GEOM) and the available spatial operators depends on the server.

**Figure: Row Picker with Spatial Operators**

7. Click OK to return to the **WFS SERVER MAP PROPERTIES** dialog box. If this checkbox is not selected, all features (as defined by ROW FILTER) will be returned.

8. Select an appropriate file name from the **TABLE FILENAME** entry box. See **Handling Retrieved WFS Data on page II-120** for detailed information on specifying file names and folders for saved tables.

9. From the **PREFERRED VIEW** drop-down list in the **WFS SERVER MAP PROPERTIES** dialog box, select the preferred view for the returned results. New Mapper is the default. Then click OK to generate results. The results (filtered by selected column and row names) are displayed in the specified window.

**Controlling WFS Maximum Features**

To limit the number of features returned by the WFS server, select the Max Features checkbox in the WFS Server Map Properties dialog box and enter a number. By limiting the number of downloaded features, it may take less time to download and display a table than it would for downloading the entire table. This may allow you to quickly judge the value of the data. However, you cannot control which features are downloaded.

**Note:** While, the OGS WFS Specification mandates that WFS servers must support Max Features, some WFS servers seem not to support it.

**Changing a WFS Coordinate System**

The **PROJECTIONS** button is enabled only if the projection provided by the WFS server cannot be properly interpreted by the WFS client. If the projection provided by the WFS server can be properly understood, this button will be disabled and can be ignored.

If the **PROJECTIONS** button is active, you must use it to specify a known projection from the list of supported projections so that the GML2 image can be imported correctly. Select the coordinate system that you believe matches to the data returned by the server.

1. After selecting a layer in the **WFS SERVER PROPERTIES MAP** dialog box, click **PROJECTION** (if the button is enabled) to display the **CHOOSE PROJECTIONS** dialog box.
2. From the **CHOOSE PROJECTION** dialog box, select the **CATEGORY** and **CATEGORY MEMBER** that corresponds to the projection of the returned data. Click **OK** to return to the **WFS SERVER PROPERTIES MAP** dialog box.

### Changing WFS Styles

The styles are initialized to the default object styles, which are set using **OPTIONS > PREFERENCES > STYLES**. You can change the object styles as shown in the following steps. Objects in the created WFS table will use the established styles.

1. From the **WFS SERVER PROPERTIES MAP** dialog box, click **Symbol Style** to open the **Symbol Style** dialog box. From here you can change the font, point size, symbol, color, and other attributes of the symbol.

2. Click **Line Style** to open the **Line Style** dialog box. From here you can change the style, color, width, and other attributes of the line style.

3. From the **WFS SERVER PROPERTIES MAP** dialog box, click **Region Style** to open the **Region Style** dialog box. From here you can change the fill and border attributes of the region style.

### Handling Retrieved WFS Data

Use the **TABLE FILENAME** field to specify the name and path that you want to save the GML2 data to, once it is retrieved. The default is the selected layer’s given name with the .TAB extension. You may wish to change this and give the table a more meaningful file name. The default directory is determined by the preference (**OPTIONS > PREFERENCES > DIRECTORIES > WFS TABLES**). You can select the **...** button to open a dialog box that allows you to specify a file name and navigate to a folder.

Use the **USE PREFERRED VIEWS** field to indicate where and how you want to display the retrieved data. Options include: Automatic, Browser, Current Mapper, New Mapper, and No View. New Mapper is the default selection.

### Refreshing a WFS Layer

To refetch the data for a WFS layer:

1. On the **TABLE** menu, click **WFS TABLE REFRESH** to display the **SELECT WFS TABLE** dialog box.

2. From **SELECT WFS TABLE**, select the appropriate WFS table and click **SELECT**, to refresh the WFS layer.
3. Click **OK** to exit the dialog box.

### Adding a WFS Server

If you do not see the server you are looking for in the **WFS SERVERS LIST** dialog box, you can add a server.

**Note:** The servers we display in this document are some examples of servers that worked in our laboratory tests. Please contact your service provider if you have difficulties with WFS server access.

1. From the **WFS SERVERS LIST** dialog box, click **ADD** to display the **WFS SERVER INFORMATION** dialog box. This same dialog box appears when you click the **EDIT** button in the **WFS SERVERS LIST**.

2. Type the URL you want to add in the **SERVER URL** field. Click **TEST URL** to ensure that MapInfo Professional can find the server. Click **GET DESCRIPTION** to get the server-provided description, or type in your own description. Click **OK** to return to the **WFS SERVERS LIST** dialog box.

3. In the **WFS SERVERS LIST** dialog box, click **SET DEFAULT** to select a default server in the list. The default server will be selected the first time you open the **WFS TABLE** dialog box. When you set a default WFS server, a check mark displays beside it. If you do not select a default server, MapInfo Professional displays the first server in the list when you begin your WFS Server session.

4. To edit a WFS server, select the server from the **WFS SERVERS LIST** dialog box and click **EDIT** to open the WFS Servers Information dialog box. From here you can test the URL and get detailed information on the server.

5. To remove a WFS server, select the server from the **WFS SERVERS LIST** dialog box and click **REMOVE**. This removes the server from the list.

6. When you have completed your work in the **WFS SERVERS LIST**, click **OK** to return to the **Open WFS SERVER MAP PROPERTIES** dialog box.

### Controlling WFS Server Timeout Values

You can set several optional registry entries to control how long the WFS client will attempt to connect to the server before timing out. These are optional entries, and if not set, the indicated default values are used. Server timeout values can not be set through the MapInfo application interface.

These registry entries are DWORD values, with the decimal value representing the number of seconds for the timeout. The registry entries reside in:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Mapinfo\MapInfo\Common
```
WFS Server Timeout Entries

<table>
<thead>
<tr>
<th>Registry Entry</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WFSConnectTimeout</td>
<td>Connect Timeout - the amount of time allowed to establish an Internet connection request. If the request takes longer than this value, a timeout occurs.</td>
<td>60 seconds</td>
</tr>
<tr>
<td>WFSSendTimeout</td>
<td>Send Timeout - the amount of time allowed to send an Internet request. If the request takes longer than this value, a timeout occurs.</td>
<td>60 seconds</td>
</tr>
<tr>
<td>WFSReceiveTimeout</td>
<td>Receive Timeout - the amount of time allowed to begin to receive a response from a request. The download can take longer than the timeout, but the response has to occur within the timeout setting.</td>
<td>300 seconds</td>
</tr>
</tbody>
</table>

WFS-Related Error Messages

The MapInfo Pro WFS client will return appropriate error messages. Data returned to the WFS client depends on the availability and status of the WFS server and the characteristics and status of the maps on the WFS server. These conditions are beyond the control of MapInfo.

The following table lists and explains WFS-related error messages.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>The WFS Server issued the following exception: &lt;message from server&gt;</td>
<td>The raw data following the colon is transmitted by the WFS server. This may help you analyze the problem. The WFS server generated an error. For clarification, contact the service provider of the WFS server.</td>
</tr>
<tr>
<td>The following error was issued while attempting to access the WFS server: &lt;message from server&gt;</td>
<td>There could be a problem with the URL, the server may not be available, or it may have timed out.</td>
</tr>
<tr>
<td>The WFS Server returned no data in response to the request.</td>
<td>MapInfo issued a service request, but nothing was received from the server.</td>
</tr>
<tr>
<td>Unable to retrieve capabilities from the WFS Server.</td>
<td>The server did not return a list of FeatureTypes in response to the GetCapabilities request. This message usually appears paired with another message in the same window.</td>
</tr>
</tbody>
</table>
## WFS-Related Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>The WFS Server returned HTML data rather than the requested format. The</td>
<td>The raw data following the colon is transmitted by the WFS server. This may help you analyze the problem.</td>
</tr>
<tr>
<td>specified address may not be a WFS Server or the server could not process</td>
<td>The server you are accessing may not be a WFS server. You may see this message after accessing a WFS</td>
</tr>
<tr>
<td>the request: &lt;message from server&gt;</td>
<td>server and seeing a list of WFS layers. This can occur because the Capabilities document provided by</td>
</tr>
<tr>
<td></td>
<td>the server may contain additional URLs that redirect you to another server (not the one you explicitly</td>
</tr>
<tr>
<td></td>
<td>selected). That “redirected” server may be down or have another problem.</td>
</tr>
<tr>
<td>The WFS Server returned data which was neither in the requested format nor</td>
<td>The raw data following the colon is transmitted by the WFS server. This may help you analyze the problem.</td>
</tr>
<tr>
<td>a recognized WFS service exception: &lt;message from server&gt;</td>
<td>The exception message from the server could not be understood. For example, the exception message may</td>
</tr>
<tr>
<td></td>
<td>not have been in XML format.</td>
</tr>
<tr>
<td>Error accessing temporary file.</td>
<td>It is possible that your disk is full or you might have deleted the temp file while MapInfo Pro was</td>
</tr>
<tr>
<td></td>
<td>running.</td>
</tr>
<tr>
<td>In response to a DescribeFeatureType request, the WFS Server returned an</td>
<td>MapInfo could not interpret the schema returned by the server. This message is usually preceded by</td>
</tr>
<tr>
<td>invalid feature type.</td>
<td>either another MapInfo error message or raw data transmitted by the WFS server. This may help you</td>
</tr>
<tr>
<td></td>
<td>analyze the problem.</td>
</tr>
<tr>
<td>Unable to read WFS Table Description XML file.</td>
<td>The most likely cause of this error, is that the user edited the XML file that was created by MapInfo.</td>
</tr>
<tr>
<td>Unable to retrieve WFS Server GetFeature.</td>
<td>This message is usually preceded by either another MapInfo error message or raw data transmitted by</td>
</tr>
<tr>
<td></td>
<td>the WFS server. This may help you analyze the problem.</td>
</tr>
<tr>
<td>An error occurred while processing GML returned from the WFS server.</td>
<td>The server provided GML that MapInfo could not interpret.</td>
</tr>
<tr>
<td>The WFS Server returned capabilities in an unsupported versions: &lt;message</td>
<td>The raw data following the colon is transmitted by the WFS server, and identifies the WFS version in</td>
</tr>
<tr>
<td>from server&gt;</td>
<td>the Capabilities document, as reported by the server. This may help you analyze the problem.</td>
</tr>
<tr>
<td>The layer is not supported because it has more than one FeatureType.</td>
<td>The MapInfo WFS client expects one FeatureType in the schema. However, the schema returned by the</td>
</tr>
<tr>
<td></td>
<td>server contained more than one FeatureType.</td>
</tr>
<tr>
<td>You need to select a WFS layer.</td>
<td>After selecting a server In the WFS Server Map Properties dialog box, you must also select a WFS</td>
</tr>
<tr>
<td></td>
<td>layer. If you click OK before selecting a WFS layer, you will get this error message.</td>
</tr>
<tr>
<td>Error: Unable to communicate with the WFS server while trying to determine</td>
<td>This message can appear when pressing the OK button on the WFS Sever Map Properties dialog. This</td>
</tr>
<tr>
<td>the table structure.</td>
<td>means that the DescribeFeatureType failed.</td>
</tr>
</tbody>
</table>
Adding GetFeatureInfo Support to Web Map Service

The Info Tool now provides GetFeatureInfo support for Web Map Service (WMS). When you click on the WMS layer with the Info tool, the Info tool window displays information about the features of each layer that you have retrieved from a WMS server.

By default, when you open a WMS layer and add it to a map, it is selectable when it meets the following criteria:

- The WMS server must support GetFeatureInfo.
- The WMS server must return GetFeatureInfo data in a format that is supported by MapInfo Professional. These formats are text/plain and the xml and gml formats returned by MapXtreme® Java edition and MapXtreme® 2004, respectively.
- The WMS servers must specify that at least one of the WMS layers within the WMS table can be queried.

The WMS layer can also be made selectable using the MapBasic statement:

```
set map layer layer_id selectable on
```

After making the WMS layer selectable, the Info tool can be used. Information will be returned only from layers that are queryable. The WMS table treeview in the OPEN WMS TABLE and WMS TABLE PROPERTIES dialog boxes display an Information icon next to queryable layers to indicate that the InfoTool will work on those layers.

### WFS-Related Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please select a supported projection.</td>
<td>This message appears if the selected WFS layer has Unsupported Projection, and the user did not select the PROJECTION button to specify a projection.</td>
</tr>
<tr>
<td>Error: Unable to create XML file for WFS table.</td>
<td>This message can appear when pressing the OK button on the WFS Sever Map Properties dialog. This means there is a problem creating the XML file used to open a WFS table.</td>
</tr>
<tr>
<td>Error: The WFS server does not return data in the required GML2 format.</td>
<td>The user selected a WFS server that does not support GML2 as an output format.</td>
</tr>
</tbody>
</table>
The supported GetFeatureInfo formats include:

- text/plain
- text/xml (as returned by WMS servers using MapXtreme® Java Edition)
- application/x-mapinfo-gml3 (as returned by WMS servers using MapXtreme® 2004)
- application/x.cubestor-gml.1 (as returned by WMS servers using CubeWerx CubeSERV® WMS)
- application/vnd.ogc.gml

In some cases, the WMS server may return an error when the user clicks on the map. Error messages are displayed in the info tool window itself. Examples of errors include:

- The WMS Server does not support GetFeatureInfo requests.
- The WMS Server does not return GetFeatureInfo data in a format supported by MapInfo Professional.
- There are no queryable layers in the WMS table for the GetFeatureInfo request.
- The WMS Server returned data in <returned-format> format rather than the requested format of <requested-format>
- Unable to retrieve feature information from the WMS Server.

**Controlling WMS Server Timeout Values**

You can set several optional registry entries to control how long the WMS client will attempt to connect to the server before timing out. These are optional entries, and if not set, the indicated default values are used. Server timeout values can *not* be set through the MapInfo application interface.

These registry entries are DWORD values, with the decimal value representing the number of seconds for the timeout. The registry entries reside in:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Mapinfo\MapInfo\Common
```
Clearer WMS Error Messages

We have enhanced the error messages that display while using the Web Map Service capabilities to ensure that they are more indicative of the problems.

Data returned to the WMS client depends on the availability and status of the WMS server and on the characteristics and status of the maps on the WFS server. These conditions are beyond the control of MapInfo.

The following table lists and explains WMS-related error messages. Some messages consist of two parts, separated by a colon. The information up to the colon is generated by the MapInfo WMS client. The raw data following the colon comes directly from the WMS server. For clarification on those messages, please contact the service provider of the WFS server.

<table>
<thead>
<tr>
<th>WMS-Related Error Messages</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Parsing Error: &lt;message from XML parser&gt;</td>
<td>The most likely cause is badly formed XML from the server. The raw data following the colon is transmitted by the MSXML 4.0 parser.</td>
</tr>
<tr>
<td>The WMS Server issued the following exception: &lt;message from server&gt;</td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The WMS server generated an error. For clarification, contact the service provider of the WFS server.</td>
</tr>
<tr>
<td>The following error was issued while attempting to access the WMS server: &lt;message from server&gt;</td>
<td>There could be a problem with the URL, the server may not be available, or it may have timed out.</td>
</tr>
<tr>
<td>The WMS Server returned no data in response to the request.</td>
<td>MapInfo issued a service request, but nothing was received from the server.</td>
</tr>
</tbody>
</table>

WMS Server Timeout Entries

<table>
<thead>
<tr>
<th>Registry Entry</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WMSConnectTimeout</td>
<td>Connect Timeout – the amount of time allowed to establish an Internet connection request. If the request takes longer than this value, a timeout occurs.</td>
<td>60 seconds</td>
</tr>
<tr>
<td>WMSSendTimeout</td>
<td>Send Timeout – the amount of time allowed to send an Internet request. If the request takes longer than this value, a timeout occurs.</td>
<td>60 seconds</td>
</tr>
<tr>
<td>WMSReceiveTimeout</td>
<td>Receive Timeout – the amount of time allowed to begin to receive a response from a request. The download can take longer than the timeout, but the response has to occur within the timeout setting.</td>
<td>300 seconds</td>
</tr>
</tbody>
</table>
Saving Your Workspace as an XML-Based MWS File

This version of MapInfo Professional enables you to save the maps in your workspace out to an XML format for use with MapXtreme 2004 applications. When saving a workspace to MWS format, only the map windows and legends are saved. All other windows are discarded as MapXtreme 2004 applications cannot read that information. Once your workspace is saved in this format, it can be opened with the Workspace Manager utility that is included in the MapXtreme 2004 installation.

### WMS-Related Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to retrieve capabilities from the WMS Server.</td>
<td>The GetCapabilities request from the server failed. This message usually appears paired with another message in the same message window.</td>
</tr>
<tr>
<td>The WMS Server returned HTML data rather than the requested format. The specified address may not be a WMS Server or the server could not process the request: <code>&lt;message from server&gt;</code></td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The server you are accessing may not be a WMS server. You may see this message after accessing a WFS server and seeing a list of WFS layers. This can occur because the Capabilities document provided by the server may contain additional URLs that redirect you to another server (not the one you explicitly selected). That “redirected” server may be down or have another problem.</td>
</tr>
<tr>
<td>The WMS Server returned data which was neither in the requested format nor a recognized WMS service exception: <code>&lt;message from server&gt;</code></td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The exception message from the server could not be understood. For example, the exception message may not have been in XML format.</td>
</tr>
<tr>
<td>Error accessing temporary file.</td>
<td>It is possible that your disk is full or you might have deleted the temp file while MapInfo Pro was running.</td>
</tr>
<tr>
<td>The WMS Server does not return GetFeatureInfo data in a format supported by MapInfo.</td>
<td>The server may not support GetFeatureInfo.</td>
</tr>
<tr>
<td>The WMS Server does not support GetFeatureInfo requests.</td>
<td>The server may not provide GetFeatureInfo in a format understood by MapInfo Pro.</td>
</tr>
<tr>
<td>There are no queryable layers in the WMS table for GetFeatureInfo request.</td>
<td>The server may not have a queryable layer. It is possible that a queryable layer changed between the time that you first created the WMS table and subsequently reopened the table.</td>
</tr>
<tr>
<td>The WMS Server returned data in <code>&lt;formatA&gt;</code> rather than the requested format of <code>&lt;formatB&gt;</code>.</td>
<td>MapInfo requested data in the format that the server claims it supports, however the server is returning a different format. For clarification, contact the service provider of the WFS server.</td>
</tr>
<tr>
<td>Unable to retrieve feature information from the WMS server.</td>
<td>The GetFeatureInfo request from the server failed. This message usually appears paired with another message in the same message window.</td>
</tr>
</tbody>
</table>
or with an application developed using MapXtreme 2004. The file is valid XML so can also be viewed using any XML viewer or editor. MWS files created with MapInfo Professional 7.8 can be validated using schemas supplied with MapXtreme 2004.

**Note:** You will not be able to read files saved in MWS format in MapInfo Professional 7.8. In MapInfo Professional, you can set the visibility of a modifier theme without regard to its reference feature layer, so you can turn the visibility of the main reference layer off but still display the theme. In MapXtreme 2004, the modifier themes (Dot Density, Ranges, Individual Value) are only drawn if the reference feature layer is visible. To ensure that modifiers marked as visible in MapInfo Professional display in tools like Workspace Manager, we force the visibility of the reference feature layer so that its modifier themes display.

To save a workspace in the MWS format:

1. Create the workspace you want to save.
2. From the FILE menu, select **SAVE WORKSPACE**. The Save Workspace dialog box displays.
3. In the **SAVE AS TYPE** drop-down list, select **MAPINFO WORKSPACE FORMAT (*.MWS)** and type the name of the workspace in the File name field. Click **SAVE** to continue. The Select Mapper Windows dialog displays.

**Figure: Select Mapper Windows**

![Select Mapper Windows dialog](image)

**Note:** The Select Mapper Window dialog box does not display if there is only one window open.

4. Click on the map windows you wish to save and then select one from the drop down list to be the default window. and click **OK**. Your workspace is now saved and available for use in MapXtreme 2004 applications.

**What is Saved**

The following information is included in the MWS workspace file:

- Tab files’ name and alias
- Coordsys information
- Map center and zoom settings
- Layer list with implied order
- Map size as pixel width and height
- Map resize method
- Style overrides
- Raster layer overrides
• Label and label edit information
• Individual value themes
• Dot density themes
• Graduated symbol themes
• Bar themes
• Range themes
• Pie themes
• Grid themes as MapXtreme 2004 grid layers with a style override
• Themes and label expressions based upon a single attribute column.

What is Not Saved
The following information is not saved in the MWS workspace file:

• Any non-map windows (browsers, charts, redistricters, 3D map windows, Prism maps)
• Distance, area, or XY and military grid units
• Snap mode, autoscroll, and smart pan settings
• Printer setup information
• Any table that is based on a query
• Any theme that is generated from a complex expression

Note: A complex expression includes any operator or multiple referenced tables.

• Any queries
• Export options
• Line direction arrows
• Whether object nodes are drawn or not
• Hot links for labels and objects

Raster Enhancements

We have upgraded the raster handlers in MapInfo Professional to improve the look and performance of your raster files. We have:

• Upgraded the LeadTools to version 13
• Upgraded to a newer version of MrSID SDK (3.2), to provide support for MG3 files
• Updated the current raster handlers to handle multi-threading; specifically for ECW and the Government handlers (ADRG, ASRP, CADRG, CIB, NITF)

Get a Clear Picture of your U.S. Data with the AirPhotoUSA Map Handler 4.0 for MapInfo Professional. AirPhotoUSA provides raster images at different elevations for particular areas in the United States. The AirPhotoUSA map handler allows MapInfo users to open and display the imagery contained in AirPhotoUSA Map files as a layer in MapInfo. These files are treated just like any other raster file in MapInfo Professional. The MAPINFOW.PRJ file has been updated to accommodate the AirPhotoUSA enhancements.
Mapping Enhancements

Removed: 256 Character Limit in Text Boxes

MapInfo Layout or Mapper windows, which were previously limited to 256 characters, can now contain a maximum of 2047 characters. Text object rotation is restricted to under 256 bytes. Labels, however, are still restricted to 256 bytes.

More Dot Density Choices for Thematic Maps

For thematic maps, you can now select Circle or Square dot thematics and specify the dot density width (in pixels) of the square or circle. In general, squares look clearer at small sizes. At larger sizes, it may be more appropriate to use circles.

In the Creating a Thematic Map - Step 3 of 3 dialog box, select the CUSTOMIZE SETTINGS button to display the CUSTOMIZE DOT DENSITY SETTINGS dialog box. Here you can change the number of units that each dot represents, and also select the dot shape (square or circle) size, and color. You can specify a circle size from 2 to 25 pixels in width. For a square, the size can range from 1 to 25 pixels.

Figure: Customize Dot Density Settings

Snap and Thin Settings now Saved in Metadata

The Snap and Thin settings remove self-intersections and overlaps in your data based on values you establish. When you complete your selections and entries in the Set Values for Node Snap & Thinning dialog box, MapInfo Professional now saves these values to the table’s metadata. This allows the Snap and Thin changes to be retrieved in the dialog after the table is saved or the user has left MapInfo Professional.

New Preference for Visible Snap Area

The visible snap radius was added in MapInfo Professional 7.5. This snap radius was always visible when Snap mode was on.

The MAP WINDOW PREFERENCES dialog box now has a DISPLAY SNAP RADIUS checkbox that controls whether or not the snap radius is displayed when Snap mode is on. The snap tolerance (in pixels) can also be selected.

1. From the OPTIONS menu, select PREFERENCES, then MAP WINDOW to display the MAP WINDOW PREFERENCES dialog box:
Under the Snap Options section, you can change the Snap Tolerance to make the snap radius larger or smaller (measured in pixels).

If you clear **DISPLAY SNAP RADIUS**, the radius will not be displayed when snap mode is turned on.

**Adding User-Defined Custom Symbols**

A new button on the **SYMBOL STYLE** dialog box allows users to add new custom symbols to the current collection. After selecting **OPTIONS > SYMBOL STYLE** and **CUSTOM SYMBOLS** from the **FONT** drop-down list, the **ADD** button is activated.

**Figure: Symbol Style**

When the user clicks the **ADD** button, the **ADD CUSTOM SYMBOLS** dialog box allows the user to navigate to the appropriate directory and select one or more .BMP files.
After you click **OK**, the **RESULTS** dialog box confirms where the custom symbols were added. The destination CustSymb directory is determined by the during installation. If you executed the MapBasic command to reload custom symbols from a particular directory, then the **ADD CUSTOM SYMBOLS** dialog box will add to that directory instead. See the Reload Symbols statement in the MapBasic Reference Guide, Version 7.8.

If one or more files cannot be copied, the **RESULTS** dialog box reports the failure. The copy can fail for a number of reasons, including:

- you may have attempted to overwrite an existing .BMP file of the same name.
- the destination file name is too long (greater than MAX_PATH, which is 260 characters for a 32-bit Windows system).
- the destination directory may not exist.
- the security permissions on your system prevent copying.

After the symbols have been copied, they are immediately available in the **SYMBOL** drop-down list.

Figure: Symbol Style with Custom Symbols Selected

New High-Resolution Custom Symbols

MapInfo has added some new high-resolution (24-bit color) custom symbols and updated some existing custom symbols. These are installed along with other custom symbols in the CustSymb directory. The symbols in the Symbol drop-down list are sized to fit into each square cell, so the high resolution images are only approximations of the final image. To change the size of the image, change the font size.

You can see a list of the new high-resolution custom symbols in **High-Resolution Custom Symbols in Appendix B on page II-186**.

Selecting Sample Size for Cartographic Legend Window

You can control the sample legend sizes that appear in Cartographic Legend windows. You can choose the smaller sample sizes that were used with MapInfo version 7.0 and earlier, or choose the larger legend sample sizes that were introduced in MapInfo version 7.5. This feature does **not** affect Thematic Legend windows.
When creating Legends, the Create Legend window - Step 2 of 3 dialog box allows you to select a **SMALL** or **LARGE STYLE SAMPLE SIZE**. When adding frames to a Legend window, the style sample size is indicated. The default is **LARGE**.

**Figure: Create Legend - Step 2 of 3**

To change the style sample size of an existing Cartographic Legend window, select **Legend > Refresh**, then select **REFRESH STYLE SAMPLE SIZE** from the Refresh Legend window. Then select either **SMALL** and **LARGE** and click **OK** to refresh the legend. You may refresh other attributes (such as Layout and other Legend Window attributes at the same time.)

**Figure: Refresh Legend**

You can also change the default value for style sample size shown in Create Legend - Step 2 of 3. In the Legend Preferences window (**OPTIONS > PREFERENCES > LEGENDS**), select either Small or Large Style Sample Size. The initial default is Large. After changing the preferences, you can Refresh Styles through the user interface.
Changes to the AutoTrace Mode (Toggle Option for Line Following)

We have added a new feature to the AutoTrace line following mode to make it easier to use. You can now turn on the AutoTrace mode, session-wide, by pressing the letter T in any Map or Layout window. A new Status Bar entry displays showing that this mode is enabled.

The same rules that applied to AutoTrace previously still apply, specifically:

- To enable the AutoTrace mode, you must be using a “poly” tool such as Add Polygon or Add Polyline
- The Snap feature must be enabled to use the AutoTrace functionality
- We have not disabled the SHIFT/CTRL key functionality for this mode. When you AutoTrace a polygon, the path contains the least number of nodes necessary to complete the AutoTrace, which is similar to the SHIFT key behavior. If you want to trace the longer path, press the CTRL key to override default AutoTrace direction.

**Note:** When a closed polyline is being AutoTraced, the trace line never crosses the start and end points of the polyline (so the CTRL key has no effect).
Sample Data Changes Available

We have upgraded our sample data, specifically States.tab and USA.tab to include the Census 2000 data. Further, we have added a new ZIPs file (US_ZIPS.tab) to assist you with more accurate geocoding. This file contains the data from our popular ZipInfo product.

3D Enhancements

Improved PrismMap Lighting. We have corrected a problem that affected the way Prism Maps displayed. When you changed the viewpoint of the Prism Map, the colors might look washed out due to an error in the lighting calculation. We have corrected this issue so that PrismMaps have a consistent look regardless of the viewpoint.

Datum Enhancements

This section describes new and updated coordinate systems for MapInfo Professional version 7.8. The MAPINFOW.PRJ file has been updated to support these changes.

French RGF93 Coordinate System

The French RGF93 Coordinate System has been added.

When converting coordinates from one datum to another, MapInfo Professional has used the Molodensky (3-parameter) and Bursa-Wolf (7-parameter) methods. These are general-purpose methods that can transform coordinates from any datum to any other datum.

In previous versions of MapInfo Professional, we introduced datum conversion programs to support the specialized NADCON (North American Datum Conversion) and JGD2000 (Japanese Geodetic Datum Conversion) Coordinate Systems. With MapInfo Professional version 7.8, we now support the French Lambert RGF93 Coordinate Systems.

The National Geographic Institute (France) recently introduced a new coordinate system, RGF93, which is based on GRS 80 ellipsoid. In order to convert existing data that uses NTF (New Triangulation of France) datum, the National Geographic Institute provides a transformation "grid". This grid contains parameters that are used to transform NTF coordinates to RGF93 coordinates, and vice versa. MapInfo Professional uses a binary version of this grid file (GR3DF97a.bin) to perform this conversion.

For maximum accuracy of 5 cm or better when converting NTF into RGF93 datum, use a Bounded Lambert RGF93 coordinate system. It is especially necessary to use a bounded Lon\Lat system when converting Lon\Lat (NTF) to or from Lambert RGF93 as MapInfo Professional's accuracy with unbounded Lon\Lat defaults to 10 cm or 4 in.
The MAPINFOW.PRJ file includes a Bounded French Lambert RGF93 entry for this conversion. For information on creating Bounded Projections, see Accounting for Affine Transformations and Explicit Bounds in Projection Types of the MapInfo Professional 7.8 User Guide (Unabridged) on the Installation CD or use the CoordSysBounds.MBX tool supplied with MapInfo Professional to create bounds in tables.

Note: All transformations are done silently, without any indication of which datum conversion algorithm was used.

Australian Coordinate System Modifications

New Coordinate Systems

The following Australian State Grids coordinate systems have been added:

- VicGrid66 (AGD66), 3, 12, 7, 145, -37, -36, -38, 2500000, 4500000 (this is a renaming of “VIC Standard Grid”)
- VicGrid94 (GDA94), 3, 116, 7, 145, -37, -36, -38, 2500000, 2500000

The following “Other Australian Projections”, have been added:

- “Australian Lamberts Conformal Conic (AGD66)”, 3, 12, 7, 135, -24, -18, -36, 0, 0
- “Australian Lamberts Conformal Conic (AGD84)”, 3, 12, 7, 135, -24, -18, -36, 0, 0
- “Australian Lamberts Conformal Conic (GDA94)”, 3, 116, 7, 135, -24, -18, -36, 0, 0
- “Australian Antarctic Lambert”, 3, 104,7, 70, -50, -68.5, -74.5, 600000, 600000
- “Australian Antarctic Polar Stereographic”, 20, 104,7, 70, -71, 0.972769012892, 600000, 600000

Israeli Coordinate System Added

Several Israeli Coordinate Systems have been added.

Swedish Coordinate System Added

Several new varieties of the Swedish RT90 Coordinate System have been added.

New Swedish Coordinate Systems (SWEREF 99) Added

Several new Swedish Coordinate Systems have been added. These are based on a new standard coordinate system for Sweden named "SWEREF 99".

Reordered/Added Danish Coordinate Systems

The Danish Coordinate Systems have been re-ordered in the MAPINFOW.PRJ file so that the UTM Zone32 Euref89 coordinate systems appear at the top.
AirPhotoUSA Conterminous U.S. Coordinate System Now Available

You can now use the "AirPhotoUSA Conterminous U.S." coordinate system without making any changes. However, if you want MapInfo to recognize and give a name to that coordinate system, or to use it for other purposes, this can be added to the MAPINFOW.PRJ. For instructions, see AirPhotoUSA Conterminous U.S. Coordinate System Now Available on page II-137.

Printing Enhancements

New Scale Choices when Printing Maps

In response to customer requests, we have created a new map window preference to allow you to set the scale options for map printing. You can now set the map scale to display in Cartographic Scale automatically or you can choose your own map scale using this preference. By default, the Use Cartographic Scale option will not be set.

Note: When you select this preference, MapInfo Professional will preset your map printing scale based on the distance scale of the Earth and set the scale for the CHANGE VIEW, MAP PRINT OPTIONS and FRAME OBJECT dialog boxes.

To see the new map window preference:

1. From the OPTIONS menu, click PREFERENCES to display the PREFERENCES list.
2. Click the MAP WINDOW option to display the MAP WINDOW PREFERENCES dialog box.
3. Select the USE CARTOGRAPHIC SCALE check box to display your maps in Cartographic Scale automatically.

Note: When you make this change, the scale now displays in the Status Bar.
When you make this change, the options that display in the **CHANGE VIEW**, **MAP PRINT OPTIONS** and **FRAME OBJECT** dialog boxes use the cartographic scale on which the selected map is based. For example, the cartographic scale on which the selected map in the next figure is based is 1 : 24,630,000.

**Figure: Change View (with the Use Cartographic Scale Selection in Preferences)**

---

**Exporting to CSV Format Available**

We have added the ability to export files to the popular text file format, CSV. To see this change, open the table you want to export and from the Main Menu select **TABLE > EXPORT > EXPORT** to display the **EXPORT TABLE TO FILE** box. You can select Comma delimited (CSV) format from the **SAVE AS TYPE:** drop-down list.

**Figure: Export Table to File**

---

**Database Enhancements**

**Default Range Options When Importing MS Excel File**

The default range for data when opening an Excel file is the entire worksheet. However, if the **USE ROW ABOVE SELECTED RANGE FOR COLUMN TITLES** checkbox is selected, the default data range will begin at A2 (row 2). In this case, in the Excel Information window, both the Named Range and Current Value fields will indicate that data starts in row 2.
The starting row is changed from the first to the second only if the current starting row is the top row. Otherwise, no change will be made to the values.

If you clear the "Use Row Above Selected Range for Column Titles", both the Named Range and Current Value fields will revert to their previous values on the Entire Worksheet.

**Controlling Treatment of Imported Excel Tables**

When opening an Excel spreadsheet, you can now specify how each column is imported. For example, the user might want a 'Date' column in Excel to be a Text column in MapInfo Professional.

When you import an Excel spreadsheet into MapInfo, a **SET FIELD PROPERTIES** window allows you to reset the name, type and properties of any field (column) that is imported from the Excel table. The top section of the **SET FIELD PROPERTIES** window shows the Fields (column names) and Type (character, date, etc.) from the Excel spreadsheet. When you select one of these fields, the bottom part of the window allows you to change the MapInfo field name, data type, number of characters (for character and decimal fields) or number of decimals (for decimal fields only).

![Set Field Properties](image_url)

If you click **CANCEL**, the Excel table importing operation is cancelled.

**Tool Enhancements**

**Instructions for Adding New Tools to the Tool Manager**

When we add a new tool to the utilities list, you need to add it into the Tool Manager list to ensure that it is loaded when you want to use it. These instructions have not changed; we are providing them as a convenience.
To add a new tool to the Tool Manager list:

1. From the **TOOLS** menu, click **TOOL MANAGER**. The **TOOL MANAGER** list displays:

   **Figure: Tool Manager with Tools Selected**

2. To load a tool into the **TOOL MANAGER** list, select the check box beside it in the **LOADED** column. To ensure that the tool you are loading loads every time you open MapInfo Professional, select the check box in the **AUTOLOAD** column.

3. When each of the tools you want to load is selected in this manner, click **OK** to save your changes.

4. To use the tool, select **TOOLS** from the menu and scroll down to the tool you want to use in the list. Then select the submenu entry to begin using the tools.

**Enhanced Split Polyline at Node**

A single-section polyline can be split into two polylines at a selected node.

To split a single-section polyline:

1. From an editable layer, select a single-section polyline
2. Click the **RESHAPE** button from the Drawing Tools.
3. Select one node (other than the first or last node).
4. Select the **OBJECTS** menu, then **POLYLINE SPLIT AT NODE**
5. If a layer is not a cosmetic layer or if the polyline is in the Layout window, the **DATA DISAGGREGATION** dialog box will appear. Here the user can specify how data is disaggregated.
6. After selecting the data disaggregation method, click **OK**. The selected polyline will be split at the node into two polylines.

Error messages are displayed under the following conditions:

- You did not select a node of the polyline.
- You selected a beginning or ending node of the polyline.
- You selected more than one node of the polyline.
- The object that you selected is not a polyline object.
- You attempted to split a multi-segmented polyline (only single-section polylines can be split).
Using the Spider Graph Tool

The Spider Graph tool draws lines between objects in a single table, or the objects from two tables based on a join. It then creates a new table of lines that connect the objects from the original table(s) based on matching column names. By default, the lines are color-coded based on their table of origin. Also by default, the new table includes a distance column that stores the length of each line.

To use the Spider Graph tool:

1. Use the Tool Manager to make sure that the Spider Graph tool is loaded.
2. With the appropriate MapInfo tables open, select TOOLS > SPIDER GRAPH to activate the tool.

Note: The Spider Graph tool works with mappable vector tables only. It cannot be used with raster images.

3. From the SPIDER GRAPH dialog box, select the origin table from the left drop-down list. Then select the column name that will be used to join the origin table to the destination table.
4. Select the destination table from the right drop-down list. Then select the column name that will be used to join the destination table to the origin table.
5. Select the columns that you want to include in the resulting table. To select multiple columns, hold down the CTRL key while you click. If you do not choose any columns, Spider Graph will automatically include the join column specified for the origin table.
6. By default, the Spider Graph tool will color-code the resulting lines and add a distance column to the new table to record the length of each line. If you do not want these features, clear the appropriate checkbox. The distance lines will use units of miles by default. To change this, select another distance unit from the UNITS: drop-down list.

7. Click CREATE LINES and enter a new name for the resulting table in the SAVE COPY AS dialog box.
8. In the SAVE COPY AS window, use the SAVE IN: drop-down list to select the target folder for the resulting .TAB file. In the File name: area, type a file name for the resulting table.
9. Click SAVE.
Using the Distance Calculator Tool

The Distance Calculator tool (DistanceCalc.MBX) can be used to calculate the distance from a selected object (or group of objects) to the closest or farthest object(s). You can also specify criteria to limit the results.

To use the Distance Calculator tool:

1. Use the Tool Manager to make sure that the Distance Calculator tool is loaded.
2. With the appropriate MapInfo table open, select **TOOLS > DISTANCE CALCULATOR** to activate the tool.

   **Note:** The Distance Analysis tool works with mappable vector tables only. Distances cannot be calculated for raster images.

3. From the drop-down lists at the upper right part of the Distance Analysis dialog box, you then specify the origin and destination tables and their unique identifying columns. For example, you can calculate the distance between each customer site listed in the US_CUSTG table and the nearest big city listed in the CITY_125 table. The accompanying **LAYER CONTROL**, **SELECT**, **ZOOM**, **PAN**, and **SNAP** buttons function just as they do throughout the MapInfo Pro interface.

   **Note:** Some of the files used in this example are taken from the MapInfo Professional Tutorial data, which is now available on the MapInfo web site: http://www.mapinfo.com/miprotutorial.

4. When you click **CALCULATE DISTANCE**, the results of the distance query are displayed in the browser window. The results may then be cleared (CLEAR RESULTS) saved to a table (SAVE RESULTS), or appended to. To discard the current results and generate new results, select CLEAR RESULTS before recalculating distances.
To append more results, change table, column, and other criteria as desired, then click **CALCULATE DISTANCE**. The new results will be added to the bottom of the results table.

5. Optionally, you can also set destination criteria to limit the results. For example, after checking the **USE THE FOLLOWING CRITERIA** checkbox you could restrict your results according to selected criteria (for example, to cities with populations greater than a specified number).

6. Optionally, you can restrict the number of destination distances to find for each origin point. The default is 1.

7. You can also select the display distance units that are used for calculating distances. The default is miles.

Now when you click **CALCULATE DISTANCE**, the possible destination points are limited to the subset defined by your criteria.

The following example shows the closest distances between California customer sites in the **US_CUSTG** table and cities with over 2 million population.
1. Select LAYER CONTROL and make sure that the US_CUSTG table is the topmost selectable layer. This may mean that you need to uncheck the “Selectable” indicator for other layers.

2. Use the Boundary Select button to select California. This restricts results to origins (in this example, Customers) within the state of California.

3. Select “Selection from US_CUSTG” from the origin table drop-down list.

4. Select “Company” for the origin table identifying column.

5. Select “CITY-125” for the destination table.

6. Select “City” for the destination table identifying column.

7. After checking “Use the following criteria”, specify Tot_pop > 2000000 to target destination cities with a population greater than 2 million.

8. In “Enter the number of distances to find” the number 2 limits results to two destinations for each origin.

9. Make sure you CLEAR RESULTS to clear previous results from the Results Browser window; otherwise the new results would be appended to the previously displayed results.

10. Click CALCULATE DISTANCE.

---

**Universal Translator Upgrade Improves Log File Viewing**

We have upgraded our user interface for the Universal Translator tool to make it easier to view log files.

To use the new log file viewing features:

1. On the Main Menu, click TOOLS, select UNIVERSAL TRANSLATOR and select the UNIVERSAL TRANSLATOR submenu. The UNIVERSAL TRANSLATOR window displays.
2. Set up your **SOURCE** and **DESTINATION** entries as appropriate.

3. Click **OK** to perform the translation you selected. When the Universal Translator window redisplay, click the **VIEW LOG** button to display the log file. The entry in the log file that describes the translation is at the bottom of the file.

---

**Figure: Universal Translator**

<table>
<thead>
<tr>
<th>Universal Translator</th>
<th>New View Log button</th>
</tr>
</thead>
</table>

**Figure: mutlog.text - Notepad**

```
 Universal Translator output from run on Monday, July 13, 2004 7:52:50 AM
 (Note: FME in the text below refers to the underlying translation engine.)

Universal Translator engine 2004 (MapInfo universalTranslator) (20040611 - build 13222)
Machine host name is: nallindsa-wd
Opened native MapInfo file \c:\Program Files\MapInfo\Professional\Data\US_Hygs\States.tab'
Read coordinate system 'LL-83' from MapInfo data file (parameters are: DT_NAME NAD83 PROJ LL MAP_SCL 1 UNIT DEGREE)
Opened mapping file c:\temp\FME2CAD.txt for output
Mapping file generation was SUCCESSFUL.
Mapping file generation was SUCCESSFUL.
FME session duration: 0.3 seconds.
Feature manipulation engine 2004 (MapInfo universalTranslator) (20040611 - build 13222)
Machine host name is: nallindsa-wd
FME Configuration: Reader keyword is MapInfo
FME Configuration: Writer keyword is mwg
FME Configuration: Reader definition is 'mgw_def'
FME Configuration: Reader type is MapInfo
FME Configuration: Writer type is 'mgw'
FME Configuration: No destination coordinate system set
FME Configuration: Current working directory is \C:\Program Files\MapInfo\Professional\Data\\usrdata\'
FME Configuration: Temporary directory is \C:\temp
FME Configuration: The name is '\C:\Program Files\MapInfo\Professional\Data\\usrdata\'
System status: 464MB of virtual memory available
AutoCAD will produce an AutoCAD R2000 compatible file
No AutoCAD font directory specified.
No AutoCAD font directory specified.
All Text and Multi-Text entities will use the default font file 'default.ttf'.
Using MapInfo ODBC native reader (Revision: 14.0 $ (Date: 2003/11/07 23:20:27 ) to read MapInfo data from directory \C:\Program Files\MapInfo\Professional\Data\US_Hygsts\'
opened native MapInfo file \C:\Program Files\MapInfo\Professional\Data\US_Hygsts\States.tab'
Read coordinate system 'LL-83' from MapInfo data file (parameters are: DT_NAME NAD83 PROJ LL MAP_SCL 1 UNIT DEGREE)
Opened native MapInfo file \C:\Program Files\MapInfo\Professional\Data\US_Hygsts\States.tab'
Read coordinate system 'LL-83' from MapInfo data file (parameters are: DT_NAME NAD83 PROJ LL MAP_SCL 1 UNIT DEGREE)
Using AutoCAD writer (Revision: 14.1 $ (Date: 2004/02/27 00:47:54 ) to write autocad file \C:\Program Files\MapInfo\Professional\Data\\usrdata\'
Opened coordinate system 'LL-83' parameters: CS_NAME='LL-83' DT_NAME=NAD83 MAP_SCL=1.0 PROJ=LL UNIT=DEGREE
```
Universal Translator Upgrade Includes Finnish and JDG2000 Projections

To resolve a translation issue, we have added new algorithms for our KKJ datum to the Universal Translator to update the Finnish projection. Additionally the JDG2000 datum has been added to the Universal Translator.

New Tool: The Synchronize Windows Utility

The Synchronize Windows tool provides toolbar icons that allow you to automatically share changes made in one mapper window to all other mapper windows in a given MapInfo Professional session. For example, you might use this tool to look simultaneously at several sets of complex feature data covering the same location. In cases where a single map containing all the data would be more confusing than helpful, several synchronized maps can often display the information more clearly. The ability to embed thematic legends is useful to provide greater understanding of the data being presented.

The icons on the Sync Windows toolbar are shortcuts to commonly used functionality.

Figure: Sync Windows Toolbar

![Sync Windows Toolbar](image)

The Synchronize Windows tool consists of nine icons:

- **Clone Map Window** icon ![Clone Map Window](image)
  - Provides the same functionality as **Map > Clone View**.

- **Rename Current Map Window** icon ![Rename Current Map Window](image)
  - Allows you to rename the currently active Map window.

- **Tile Windows** icon ![Tile Windows](image)
  - Provides the same functionality as **Window > Tile Windows**.

- **Sync All Map Windows** icon ![Sync All Map Windows](image)
  - Provides a way to synchronize multiple map windows and embed thematic legends.

- **Create a Symbol on All Cosmetic Layers** icon ![Create a Symbol on All Cosmetic Layers](image)
  - Provides a way to draw a symbol in the same location across multiple map windows.

- **Create a Polyline on All Cosmetic Layers** icon ![Create a Polyline on All Cosmetic Layers](image)
  - Provides a way to draw a polyline in the same location across multiple map windows.

- **Create a Rectangle on All Cosmetic Layers** icon ![Create a Rectangle on All Cosmetic Layers](image)
  - Provides a way to draw a rectangle in the same location across multiple map windows.
CREATE A ELLIPSE ON ALL COSMETIC LAYERS icon

- Provides a way to draw an ellipse in the same location across multiple map windows.

CLEAR COSMETIC LAYERS icon

- Clears the Cosmetic layers of all of all synchronized mapper windows.

**Note:** This removes all features added to the Cosmetic layers, not just the 'synchronized' features added by this tool during this session.

**COGOLine (Create Line by Length) Utility Improvements**

We have enhanced the COGOLine Utility in response to user requests, particularly in the use of DMS coordinates and the creation of polylines.

In this implementation of the COGOLine tool, the Create Line By Length dialog displays coordinates in the units used by the current map projection (degrees, meters, feet, etc.). For example, if the current map displays degrees as the units, then the COGOLine tool displays the coordinates in decimal degrees, or in DMS coordinates as specified in the Map Options dialog box. Whether the DMS option is selected or not, the new COGOLine tool allows you to enter coordinates in DMS whenever the map has a Long/Lat projection.

**Note:** On a Longitude/Latitude map, you can type in coordinates using DMS or decimal degrees, even if you did not choose the **DEGREES MINUTES SECONDS** option in the **MAP OPTIONS** dialog box.

Customers asked us for the ability to create more complex lines using the COGOLine tool, so we added the capability to create polylines.

**Note:** If you do not see the **CREATE LINE BY LENGTH** entry in the **TOOLS** menu, see the instructions in the beginning of the Tool Enhancements section to add it.

To use the new Create Polyline feature in the **PROPERTIES OF NEW LINE** dialog box:

1. To run the COGOLine utility, do one of the following:
   - From the Main Menu, click **TOOLS** and select the **CREATE LINE BY LENGTH** entry and click **RUN COGOLINE** to display the **PROPERTIES OF NEW LINE** dialog box.
   - Select the **CREATE LINE BY LENGTH** icon from the **TOOLS** toolbar, and click the location in the map where you want the new line to begin. The **PROPERTIES OF NEW LINE** dialog box displays with the coordinate you selected in the **STARTING X** and **STARTING Y** fields.
2. Complete the **ANGLE**, **LENGTH**, and **ADVANCED OPTIONS** entries and selections necessary to create the polyline you want in the fields provided.

On a Longitude/Latitude map, the COGOLine utility allows you to type in coordinates using DMS or decimal degrees, even if you did not choose the **DEGREES MINUTES SECONDS** option in the **MAP OPTIONS** dialog box. We use the longitude example of 73 degrees, 30 minutes, 20 seconds West below to illustrate the proper entries.

- Decimal degrees, as in the example:
  -73.53
- Standard symbols with a space to separate them, as in the example:
  -73° 30' 20"
- Spaces only and no symbols, as in the example:
  -73 30 20
- Symbols and no spaces, as in the example:
  -73°30'20"

3. To draw a polyline, choose the **CREATE POLYLINE** radio button.
4. Click the **DRAW POLYLINE** button. The **PROPERTIES OF NEW LINE** dialog box redisplays with a new button, **EXTEND POLYLINE**. The end point of the previous line becomes the new starting point for the next segment.
5. Type new entries in the **ANGLE**, **LENGTH**, and **DEGREE** fields and select the **CLOCKWISE** or **COUNTERCLOCKWISE** options as appropriate. You can also enter new coordinates in the **STARTING X** and **Y** fields to create a non-congruous polyline.
6. When you have completed your polyline, click the **CLOSE** button.
Search and Replace Tool Updates Multiple Column Entries

We have updated a search and replace utility to MapInfo Professional to facilitate the replacement of multiple column entries in a selected table. This tool is particularly useful when names change or specific character data changes. To search a table, the file must be open. To add the Search and Replace Tool to the Tool menu, see Instructions for Adding New Tools to the Tool Manager on page II-139.

To use the search and replace tool:

1. Open the table for which you want to search and replace data. MapInfo Professional must be able to read the tables you want to search.
2. From the Tools Menu, select Search and Replace and click the Search and Replace submenu option. The Search & Replace dialog box displays.

Figure: Search & Replace

3. Select the table and columns you want to search from the Table To Search and Column To Search drop-down lists.
4. Type the text you want to find in the Search String field.
5. Type the new text you want to insert into the Replacement String field.
6. If the string you entered should be case sensitive, select the Case Sensitive check box.
7. Click OK to begin the search and replace process.

GeoTracker Upgrade Completed

We have upgraded the GeoTracker Geographic Utility, which is a free utility available on the Installation CD in the Install Products, Free Utilities section. New features of this GPS tool include:

- New support for up to 12 com ports
- Improved error management for Reconnect and Disconnect features
- Upgraded installation and help system with contact and web site information to facilitate communication
- Upgraded communication with MapInfo products by ignoring faulty DDE messages.

Documentation Enhancements

Upgraded the Coordinate Systems Section of the User Guide

Many of our customers have asked for a more in-depth discussion of the fundamentals of the coordinate system. We have consulted our internal geography experts and GIS mathematicians to provide a more thorough discussion of coordinate systems, projections, and affine
transformations. See Working with Coordinate Systems and Projections in Appendix A on page II-156 for this new resource. This section will also be accessible in the Unabridged User Guide on your installation CD.

**Printing Guide 7.8 Updated**

We have updated the Printing Guide for MapInfo Professional. You can find it in the PDF_DOCS directory on the Installation CD.

**Upgraded ProViewer Documentation Available**

We have upgraded our ProViewer documentation to make it easier to use. You can find it at our web site, http://www.mapinfo.com.

**Enhanced Line Style Editor Documentation Available**

In response to customer requests, we have upgraded our Line Style Editor documentation (MILISTED.PDF) and placed it on the MapInfo web site. It is also in the PDF_DOCS directory on the Installation CD.

**MapX Mobile Viewer Documentation To Be Available**

You can display MapInfo Professional 7.8 .TAB files and geosets on your MapX Mobile Viewer-enabled portable data assistant (PDA). You can also display workspaces if you save them as geosets using the MapX Geoset Utility. Documentation covering this functionality is available on the MapInfo web site.

**MapInfo Professional Tutorial and Data Available**

You can now retrieve the MapInfo Professional Tutorial and associated data from the MapInfo web site at http://www.mapinfo.com or by clicking the MapInfo Tutorial option on the Installation CD. We recommend that you download the tutorial data before you download the tutorial so you can get started right away.

**Licensing Enhancements**

**MapInfo Professional SCP Web License Utility Updated.** We have updated the MapInfo Professional SCP to handle MapInfo Professional v7.8 for SCP deployments.

**Check for Update in Pro and on Web.** When you install MapInfo Professional, you may notice that MapInfo Professional checks the MapInfo web site for any available updates. This ensures that you have the most current software available. This also ensures that users of MapInfo Professional 7.5 are alerted that the 7.8 version is available.
MapBasic Enhancements

This section describes the MapBasic enhancements that support MapInfo Pro version 7.8.

WFS Support

The TAB_INFO_TYPE attribute of the TableInfo() function has an additional return of TAB_TYPE_WFS. This indicates that the returned is from a Web Feature Service.

For a description of WFS, see Adding WFS Client Support on page II-113.

The WFS Refresh Table statement refreshes a WFS table from the server. The syntax is:

```
WFS Refresh Table alias
```

For a description of WFS, see Refreshing a WFS Layer on page II-120.

The full syntax for the WFS Refresh Table statement is described in the MapBasic Reference Guide, Version 7.8.

MGRS Conversion Functions

Two new MapBasic functions allow you to convert a point object to a MGRS (Military Grid Reference System) coordinate, and conversely, to convert an MGRS coordinate to a point object. MGRS is a military grid reference system developed for the USA. It is designed to be used within the WGS84 datum whenever possible.

The MGRSToPoint() function converts a string representing an MGRS coordinate to a point object in the current MapBasic coordinate system.

```
MGRSToPoint (string...)
```

For example, if the current MapBasic coordinate system is UTM Zone 38 (WGS84), then:

```
CentroidX(MGRSTOPOINT("38S1F1781853752"))=317,818.37754071
CentroidY(MGRSTOPOINT("38S1F1781853752"))=4,045,751.9605484
```

The PointToMGRS$( ) function converts an object value representing a point into a string representing an MGRS coordinate. Only point objects are supported.

```
PointToMGRS$ (inputobject)
```

**Note:** Set the MapBasic CoordSys to Long/Lat (WGS84) to avoid possible loss of precision.

The following example uses the USA_CAPS points table from Sample Data. Copy and paste the following code into a MapBasic window, then select the entire block and press ENTER. This opens the USA_CAPS table and displays a message window with the MGRS location for Albany, NY.

```
Open Table "USA_CAPS.TAB" Interactive
Map From USA_CAPS
Select * from USA_CAPS where Capital = "Albany"

Set CoordSys Earth Projection 1, 104
Print PointToMGRS$(selection.obj)
```
The full syntax for the MGRSToPoint( ) and PointToMGRS$( ) functions are described in the MapBasic Reference Guide, Version 7.8.

**Printing a Window to a File**

A MapInfo window can now be printed to a file. The PrintWin MapBasic command has been enhanced to make this possible. The change from the previous syntax is indicated in **bold**.

```
PrintWin [Window window_id] [Interactive] [File output_filename] [Overwrite]
```

The message window displays the MGRS string as shown below, which is the MGRS location for Albany, NY:


**Polyline Split at Node**

A single-section polyline can be split into two polylines at a selected node. The following example illustrates changes to the MapBasic syntax to support this feature. For more about this tool, see **Enhanced Split Polyline at Node on page II-140**.

```
Objects Pline Split At Node index
[Into Table name]
[Data column_name = expression
[ , column_name = expression ... ] ]
```


**Dot Density for Thematic Maps**

The MapBasic Shade statement now allows for circle/square dot density thematics with user defined size. For a description of this feature, see **Dot Density for Thematic Maps on page II-152**. The following example illustrates changes to the MapBasic syntax to support this feature. The change from the previous syntax is indicated in **bold**.

```
Shade [ Window window_id ]
{ layer_id | layer_name }
With expr
Density dot_value {Circle | Square}
Width dot_size
[ Color color ]
```

For example:

```
shade window 176942288 7 with Pop_1990 density 600000 circle width 4 color 255
```

The full syntax is described in the MapBasic Reference Guide, Version 7.8. For backwards compatibility, the older MapBasic syntax (version 7.5 or earlier) is still supported.
Cartographic Legend Sample Size

You can control the sample legend sizes that appear in Cartographic Legend windows. To support this feature, several MapBasic command have been enhanced. The change from the previous syntax is indicated in **bold**.

Set Cartographic Legend

```
[ Window legend_window_id ]
[ Refresh ]
[ Portrait | Landscape ]
[ Align]
[ **Style Size** {Small | Large}]
[ Frame Order { frame_id, frame_id, frame_id, ... } ]
```

Similarly, the Create Cartographic Legend statement has a new clause that creates the small or large legend sample size.

```
[ Style Size {Small | Large}]
```

Also the LegendInfo() function has a new LEGEND_INFO_STYLE_SAMPLE_SIZE attribute that returns the legend size information.

For a description of this feature, see **Selecting Sample Size for Cartographic Legend Window on page II-132**

Excel Column Import

When opening an Excel spreadsheet, you can now specify how each column is imported. For a description of this feature, see **Controlling Treatment of Imported Excel Tables on page II-139**. The following example illustrates changes to the MapBasic syntax to support this feature. The change from the previous syntax is indicated in **bold**.

```
Register Table source_file
...
{ Type "XLS" [Titles] [Range range_name] [Interactive] ...
```

The new optional **Interactive** keyword instructs the interface to display the Set Field Properties window when importing Excel files.

Excel CSV Export

An Excel table can be exported to a comma-delimited (CSV) file. For a description of this feature, see **Exporting to CSV Format Available on page II-138**. The following example illustrates changes to the MapBasic syntax to support this feature. The change from the previous Export statement syntax is indicated in **bold**.
Syntax 1 (for exporting MIF/MID files, DBF files, ASCII or CSV text files)

Export   table
    Into  file_name
    [ Type
        { "MIF" | "DBF" [ CharSet char_set ] | 
            "ASCII" [ CharSet char_set ] [ Delimiter "d " ] [ Titles ] ] } ]
         "CSV" [ CharSet char_set ] [ Titles ] ]
    [ Overwrite ]

Specifying the File Format

The optional Type clause specifies the format of the file you want to create. The new information is indicated in bold.

<table>
<thead>
<tr>
<th>Type Clause</th>
<th>File Format Specified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type &quot;MIF&quot;</td>
<td>MapInfo Interchange File format. For information on the MIF file format, see the MapInfo documentation.</td>
</tr>
<tr>
<td>Type &quot;DXF&quot;</td>
<td>DXF file (a format supported by CAD packages, such as AutoCAD).</td>
</tr>
<tr>
<td>Type &quot;DBF&quot;</td>
<td>dBASE file format. Note: Map objects are not exported when you specify DBF format.</td>
</tr>
<tr>
<td>Type &quot;ASCII&quot;</td>
<td>Text file format. Note: Map objects are not exported when you specify ASCII format.</td>
</tr>
<tr>
<td>Type &quot;CSV&quot;</td>
<td>Comma-delimited text file format. Note: Map objects are not exported when you specify CSV format.</td>
</tr>
</tbody>
</table>

When you export a table to an ASCII or CSV text file, the text file will contain delimiters. A delimiter is a special character that separates the fields within each row of data. CSV text files automatically use a comma (","), as the delimiter. No other delimiter can be specified for CSV export.

When you export to an ASCII or CSV text file, you may want to include the optional Titles keyword. If you include Titles, the first row of the text file will contain the table's column names. If you omit Titles, the column names will not be stored in the text file (which could be a problem if you intend to re-import the file later).

Running the MapInfo Professional Tutorial

The MapInfo Professional tutorial and tutorial sample data can now be accessed directly from the Help menu.

Using MapBasic, the Run Menu Command statement can execute the MapInfo HELP > MAPINFO PROFESSIONAL TUTORIAL ON THE WEB command.

Run Menu Command M_HELP_MAPINFO_WWW_TUTORIAL
Working with Coordinate Systems and Projections

Maps at their base are a visual representation in two dimensions of a section of the three-dimensional Earth. Being able to use maps in an electronic format in many ways frees us from the constrictions of the two-dimensional map because we can use mathematical formulas to compensate for the curvature of the Earth. In this chapter, we cover the coordinate systems and projections that are standard in MapInfo Professional and provide the tools with which you can create a custom projections to meet your organization’s needs. Whether you are a local government trying to establish new tax rolls or a large company trying to define your sales territory more precisely, creating a custom projection may be a solution you want to explore.

Sections in this Chapter:

- Working with Coordinate Systems .................. II-157
- Building Blocks of a Coordinate System ............ II-162
- New Projections in the MAPINFOW.PRJ File ........ II-178
- Understanding Affine Transformations .............. II-181
- Frequently Asked Questions ...................... II-184
- For More Information ............................. II-185
Working with Coordinate Systems

The terms “projection” and “coordinate system” are often used interchangeably, however they do not mean the same thing.

**Projection** - An equation or set of equations that contain mathematical parameters for a map. The exact number and nature of the parameters depends upon the type of projection. A projection is a method of reducing a map’s distortion caused by the curvature of the Earth, or more precisely, a projection compensates for the shortcomings of depicting maps in two dimensions when the coordinates exist in three dimensions.

**Coordinate System** - When parameters of a projection are assigned specific values, they become a coordinate system. A coordinate system is a collection of parameters that describe coordinates, one of which is a projection.

Elements of a Coordinate System

A coordinate system in MapInfo Professional is made up of many elements which need to be specified in advance. Once these elements are in place, you can be sure that your maps are as accurate as possible. These are the projection elements you need to set in the MAPINFOW.PRJ file:

- Projection Types
- Datums
- Units
- Coordinate System Origin
- Standard Parallels (Conic Projections)
- Oblique Azimuth (Hotine Oblique Mercator)
- Scale Factor (Transverse Mercator)
- False Easting and False Northing
- Range (Azimuthal Projections)

Understanding Coordinate Systems

You can make a map out of any globe without distorting the points on the surface by placing the globe into an imaginary cylinder.
When you add longitude and latitude lines at 15 degree increments to each side of the Equator and the Prime Meridian you create a reference grid. The lines furthest from the Prime Meridian are +180 degrees toward the right and -180 degrees to the left. This map projection is commonly called the Longitude/Latitude projection.

This is often considered the default projection. It is the most effective map for areas nearest the Equator but measurements further away tend to increase in distortion.

Because many people do not live near the Equator, other projections came into use to create more accurate local maps. Accuracy depends upon how you project the globe onto the cylinder. If you turn the cylinder so that it touches the Prime Meridian instead (or any line of longitude, 90 degrees away from the Equator) you have a Transverse Projection. The closer you are to the place the cylinder touches the globe, the more accurate the measurements are.
Transverse projections allow us to make maps that are more North-South line accurate, as long as you compensate for the distance from the new “Equator” which in this case is the Prime Meridian.

A third type of projection attempts to resolve the distortion problem in another way. Conic projections use a cone shape instead of a cylinder to create the “touch points”.

This type of projection is much more accurate for large regions or countries that wider in the East-West direction than in the North-South direction. There is much less distortion regionally because the touch points of a cone are closer to the map surface than those of a cylinder.
As you can see from the previous figure, the conic maps are best for small regional areas. The larger-scale map has too much distortion to be useful.

A fourth type of projection, the Azimuthal projection, does not use cones or cylinders but a simple circle that goes all the way around the globe over a particular point. This projection provides a “view from space” over a particular point.

Figure: Globe with Azimuthal Projection

This type of projection is most useful when you need to work with a particular hemisphere. A hemisphere need not be North-South or East-West based. The next figure uses the North Pole as the center point for the Azimuthal Projection.
You can use more than one projection that rotates a cylinder slightly along the Equator. This style is used in the Universal Transverse Mercator (UTM) projection. UTM maps the Earth with a transverse cylinder projection to create standard "UTM Zones". By rotating the cylinder around the globe in six degree increments, the UTM assures that all spots on the Earth are within 3 degrees of the center line. (The Gauss-Kruger system is a European system akin to UTM that also uses a transverse cylinder rotated in six degree steps).

Almost all projections you will use are one of these types. They are either cylindrical (regular or transverse), conic, or azimuthal projections and are customized by slightly different projection parameters. Projection parameters are options that describe how the projection is arranged.

You can further customize projections by specifying different parameters for the projection you want to use. For example, you can specify the longitude and latitude of any point on the Earth to create your own Azimuthal projection of that point. You can customize conic projections by specifying the parallel of latitude at which the cone should be tangent.
Building Blocks of a Coordinate System

In this section, we provide the tables required to create your own coordinate systems using map projections, datums, units, Origins, Standard Parallels, Azimuths, Scale Factors, False Eastings, False Northings, and Ranges. You might want to create your own coordinate system if accuracy is crucial to understanding your data or if your data is specified in relation to a non-standard point, and you would prefer to keep your data in that custom coordinate system.

Understanding Coordinate Systems, Projections, and their Parameters

By specifying a projection type and various required parameters, you create a mathematical algorithm for producing equivalent coordinates in degrees for the projected coordinate system. Each projection has specific parameters you can customize to make your maps more geographically accurate. The following table details each major coordinate system type and the parameters you can use to customize that system. The parameters are listed in the order they appear in the relevant projection entries in the MAPINFOW.PRJ file. To create your own coordinate system using a particular projection, you must add an entry into the MAPINFOW.PRJ file.

<table>
<thead>
<tr>
<th>Coordinate System</th>
<th>Projection Type</th>
<th>Datum</th>
<th>Units</th>
<th>Origin, Longitude</th>
<th>Origin, Latitude</th>
<th>Standard Parallel 1</th>
<th>Standard Parallel 2</th>
<th>Azimuth</th>
<th>Scale Factor</th>
<th>False Easting</th>
<th>False Northing</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Albers Equal-Area Conic</td>
<td>9</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azimuthal Equidistant</td>
<td>28</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X*</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cassini-Soldner</td>
<td>30</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cylindrical Equal Area</td>
<td>2</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eckert IV</td>
<td>14</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eckert VI</td>
<td>15</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equidistant Conic</td>
<td>6</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gall</td>
<td>17</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hotine Oblique Mercator</td>
<td>7</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lambert Azimuthal Equal-Area</td>
<td>4</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X*</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lambert Conformal Conic</td>
<td>3</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Longitude/Latitude</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In MapInfo Professional 6.0, we introduced an Oblique Azimuthal Equidistant projection that supports all Origin Latitudes, including the poles. In MapInfo Professional 6.5, we added a new Lambert Azimuthal Equal-Area projection that also supports all Origin Latitudes, including the poles.

Note: Each of these headings is described in detail in the next few pages.

### Projection Types

The following list names the projection types used in the MAPINFO.W.PRJ file.

<table>
<thead>
<tr>
<th>Coordinate System</th>
<th>Number</th>
<th>Projection Type</th>
<th>Datum</th>
<th>Origin, Longitude</th>
<th>Origin, Latitude</th>
<th>Standard Parallel 1</th>
<th>Standard Parallel 2</th>
<th>Azimuth</th>
<th>Scale Factor</th>
<th>False Easting</th>
<th>False Northing</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mercator</td>
<td>10</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miller</td>
<td>11</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mollweide</td>
<td>13</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Zealand Map Grid</td>
<td>18</td>
<td>X X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polyconic</td>
<td>27</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P.E.I. Double Stereographic</td>
<td>31</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regional Mercator</td>
<td>26</td>
<td>X X X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Robinson</td>
<td>12</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sinusoidal</td>
<td>16</td>
<td>X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereographic</td>
<td>20</td>
<td>X X X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swiss Oblique Mercator</td>
<td>25</td>
<td>X X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transverse Mercator</td>
<td>8</td>
<td>X X X X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* In MapInfo Professional 6.0, we introduced an Oblique Azimuthal Equidistant projection that supports all Origin Latitudes, including the poles. In MapInfo Professional 6.5, we added a new Lambert Azimuthal Equal-Area projection that also supports all Origin Latitudes, including the poles.

Note: Each of these headings is described in detail in the next few pages.
### MapInfo Professional Projection Types Table (continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Projection</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Eckert IV</td>
</tr>
<tr>
<td>15</td>
<td>Eckert VI</td>
</tr>
<tr>
<td>6</td>
<td>Equidistant Conic, also known as Simple Conic</td>
</tr>
<tr>
<td>17</td>
<td>Gall</td>
</tr>
<tr>
<td>7</td>
<td>Hotine Oblique Mercator</td>
</tr>
<tr>
<td>4</td>
<td>Lambert Azimuthal Equal-Area (polar aspect only)</td>
</tr>
<tr>
<td>29</td>
<td>Lambert Azimuthal Equal-Area</td>
</tr>
<tr>
<td>3</td>
<td>Lambert Conformal Conic</td>
</tr>
<tr>
<td>19</td>
<td>Lambert Conformal Conic (modified for Belgium 1972)</td>
</tr>
<tr>
<td>1</td>
<td>Longitude/Latitude</td>
</tr>
<tr>
<td>10</td>
<td>Mercator</td>
</tr>
<tr>
<td>11</td>
<td>Miller Cylindrical</td>
</tr>
<tr>
<td>13</td>
<td>Mollweide</td>
</tr>
<tr>
<td>18</td>
<td>New Zealand Map Grid</td>
</tr>
<tr>
<td>31</td>
<td>Prince Edward Island Double Stereographic</td>
</tr>
<tr>
<td>27</td>
<td>Polyconic</td>
</tr>
<tr>
<td>26</td>
<td>Regional Mercator</td>
</tr>
<tr>
<td>12</td>
<td>Robinson</td>
</tr>
<tr>
<td>16</td>
<td>Sinusoidal</td>
</tr>
<tr>
<td>20</td>
<td>Stereographic</td>
</tr>
<tr>
<td>25</td>
<td>Swiss Oblique Mercator</td>
</tr>
<tr>
<td>8</td>
<td>Transverse Mercator (also known as Gauss-Kruger)</td>
</tr>
<tr>
<td>21</td>
<td>Transverse Mercator (modified for Danish System 34 Jylland-Fyn)</td>
</tr>
<tr>
<td>22</td>
<td>Transverse Mercator (modified for Danish System 34 Sjaelland)</td>
</tr>
<tr>
<td>23</td>
<td>Transverse Mercator (modified for Danish System 34/45 Bornholm)</td>
</tr>
<tr>
<td>24</td>
<td>Transverse Mercator (modified for Finnish KKJ)</td>
</tr>
</tbody>
</table>

### Accounting for Affine Transformations and Explicit Bounds in Projection Types

You can modify projection type entries in the MAPINFOW.PRJ to add a constant value to account for affine transformations and explicit bounds. Valid values and their meanings are listed below:
Example:

In this example we use the Transverse Mercator coordinate system with the NAD 1983 datum. You might have this line in your MAPINFOW.PRJ file:

"UTM Zone 1 (NAD 83)", 8, 74, 7, -177, 0, 0.9996, 500000, 0

If you want to account for an affine transformation for this system, you would add the constant to the projection type and append the parameters of the affine transformation as listed below:

Units=meters; A=0.5; B=-0.866; C=0; D=0.866; E=0.5; and F=0

Therefore, the new entry to append the parameters of the affine transformation would be:

"UTM Zone 1 (NAD 83) - rotated 60 degrees", 1008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0

where:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1008</td>
<td>Achieved by adding the constant (1000) to the projection type (8)</td>
</tr>
<tr>
<td>7</td>
<td>Units for the affine transformation (7 = meters)</td>
</tr>
<tr>
<td>0.5, -0.866, 0, 0.866, 0.5, 0</td>
<td>Affine parameters (See Description of an Affine Transformation on page II-181.)</td>
</tr>
</tbody>
</table>

To supply explicit bounds to the coordinate system (x1, y1, x2, y2)=(-500000, 0, 500000, 1000000), the required line entries would be:

"UTM Zone 1 (NAD 83) - bounded", 2008, 74, 7, -177, 0, 0.9996, 500000, 0, -500000, 0, 500000, 1000000

where:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>Produced by adding the constant (2000) to the projection type (8)</td>
</tr>
<tr>
<td>-500000, 0, 500000, 1000000</td>
<td>Explicit bounds parameters</td>
</tr>
</tbody>
</table>
To customize the coordinate system using both the affine transformation and explicit bounds, the entry in the MAPINFOW.PRJ would be:

"UTM Zone 1 (NAD 83) - rotated and bounded", 3008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0, -500000, 0, 500000, 1000000

where:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3008</td>
<td>Produced by adding the constant (3000) to the projection type (8)</td>
</tr>
<tr>
<td>7</td>
<td>Units for the affine transformation (7 = meters)</td>
</tr>
<tr>
<td>0.5, -0.866, 0, 0.866, 0.5, 0</td>
<td>Affine parameters</td>
</tr>
<tr>
<td>-500000, 0, 500000, 1000000</td>
<td>Explicit bounds parameters (See Accounting for Affine Transformations and Explicit Bounds in Projection Types on page II-164.)</td>
</tr>
</tbody>
</table>

Note: For more about affine transformations, see Understanding Affine Transformations on page II-181.

Datums

A datum is established by tying a reference ellipsoid to a particular point on the earth. The following table lists these details for each datum:

- The number used to identify the datum in the MAPINFOW.PRJ file.
- The datum’s name
- The maps for which the datum is typically used
- The datum’s reference ellipsoid

<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adindan</td>
<td>Ethiopia, Mali, Senegal, Sudan</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>2</td>
<td>Afgooye</td>
<td>Somalia</td>
<td>Krassovsky</td>
</tr>
<tr>
<td>1007</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, A.C.T.</td>
<td>Australian National</td>
</tr>
<tr>
<td>1008</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, Tasmania</td>
<td>Australian National</td>
</tr>
<tr>
<td>1009</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, Victoria/NSW</td>
<td>Australian National</td>
</tr>
<tr>
<td>1006</td>
<td>AGD 84, 7 parameter</td>
<td>Australia</td>
<td>Australian National</td>
</tr>
<tr>
<td>3</td>
<td>Ain el Abd 1970</td>
<td>Bahrain Island</td>
<td>International</td>
</tr>
<tr>
<td>118</td>
<td>American Samoa</td>
<td>American Samoa Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>4</td>
<td>Anna 1 Astro 1965</td>
<td>Cocos Islands</td>
<td>Australian National</td>
</tr>
</tbody>
</table>
## Datums Table (continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>119</td>
<td>Antigua Island Astro 1943</td>
<td>Antigua, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>5</td>
<td>Arc 1950</td>
<td>Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>6</td>
<td>Arc 1960</td>
<td>Kenya, Tanzania</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>7</td>
<td>Ascension Island 1958</td>
<td>Ascension Island</td>
<td>International</td>
</tr>
<tr>
<td>9</td>
<td>Astro B4 Sorol Atoll</td>
<td>Tern Island</td>
<td>International</td>
</tr>
<tr>
<td>8</td>
<td>Astro Beacon “E”</td>
<td>Iwo Jima Island</td>
<td>International</td>
</tr>
<tr>
<td>10</td>
<td>Astro DOS 71/4</td>
<td>St. Helena Island</td>
<td>International</td>
</tr>
<tr>
<td>11</td>
<td>Astronomic Station 1952</td>
<td>Marcus Island</td>
<td>International</td>
</tr>
<tr>
<td>12</td>
<td>Australian Geodetic 1966 (AGD 66)</td>
<td>Australia and Tasmania Island</td>
<td>Australian National</td>
</tr>
<tr>
<td>13</td>
<td>Australian Geodetic 1984 (AGD 84)</td>
<td>Australia and Tasmania Island</td>
<td>Australian National</td>
</tr>
<tr>
<td>120</td>
<td>Ayabelle Lighthouse</td>
<td>Djibouti</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>110</td>
<td>Belgium</td>
<td>Belgium</td>
<td>International</td>
</tr>
<tr>
<td>14</td>
<td>Bellevue (IGN)</td>
<td>Efate and Erromango Islands</td>
<td>International</td>
</tr>
<tr>
<td>15</td>
<td>Bermuda 1957</td>
<td>Bermuda Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>16</td>
<td>Bogota Observatory</td>
<td>Colombia</td>
<td>International</td>
</tr>
<tr>
<td>121</td>
<td>Bukit Rimpah</td>
<td>Bangka and Belitung Islands (Indonesia)</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>17</td>
<td>Campo Inchauspe</td>
<td>Argentina</td>
<td>International</td>
</tr>
<tr>
<td>18</td>
<td>Canton Astro 1966</td>
<td>Phoenix Islands</td>
<td>International</td>
</tr>
<tr>
<td>19</td>
<td>Cape</td>
<td>South Africa</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>20</td>
<td>Cape Canaveral</td>
<td>Florida and Bahama Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>1005</td>
<td>Cape, 7 parameter</td>
<td>South Africa</td>
<td>WGS 84</td>
</tr>
<tr>
<td>21</td>
<td>Carthage</td>
<td>Tunisia</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>22</td>
<td>Chatham 1971</td>
<td>Chatham Island (New Zealand)</td>
<td>International</td>
</tr>
<tr>
<td>23</td>
<td>Chua Astro</td>
<td>Paraguay</td>
<td>International</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>122</td>
<td>Co-Ordinate System 1937 of Estonia</td>
<td>Estonia</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>24</td>
<td>Corrego Alegre</td>
<td>Brazil</td>
<td>International</td>
</tr>
<tr>
<td>123</td>
<td>Dabola</td>
<td>Guinea</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>124</td>
<td>Deception Island</td>
<td>Deception Island, Antarctica</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>1000</td>
<td>Deutsches Hauptdreicksnetz (DHDN)</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>25</td>
<td>Djakarta (Batavia)</td>
<td>Sumatra Island (Indonesia)</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>26</td>
<td>DOS 1968</td>
<td>Gizo Island (New Georgia Islands)</td>
<td>International</td>
</tr>
<tr>
<td>27</td>
<td>Easter Island 1967</td>
<td>Easter Island</td>
<td>International</td>
</tr>
<tr>
<td>115</td>
<td>EUREF 89</td>
<td>Europe</td>
<td>GRS 80</td>
</tr>
<tr>
<td>28</td>
<td>European 1950 (ED 50)</td>
<td>Austria, Belgium, Denmark, Finland, France, Germany, Gibraltat, Greece, Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland</td>
<td>International</td>
</tr>
<tr>
<td>29</td>
<td>European 1979 (ED 79)</td>
<td>Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland</td>
<td>International</td>
</tr>
<tr>
<td>108</td>
<td>European 1987 (ED 87)</td>
<td>Europe</td>
<td>International</td>
</tr>
<tr>
<td>125</td>
<td>Fort Thomas 1955</td>
<td>Nevis, St. Kitts, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>30</td>
<td>Gandajika Base</td>
<td>Republic of Maldives</td>
<td>International</td>
</tr>
<tr>
<td>116</td>
<td>GDA 94</td>
<td>Australia</td>
<td>GRS 80</td>
</tr>
<tr>
<td>33</td>
<td>Geodetic Reference System 1980 (GRS 80)</td>
<td>Worldwide</td>
<td>GRS 80</td>
</tr>
<tr>
<td>126</td>
<td>Graciosa Base SW 1948</td>
<td>Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)</td>
<td>International 1924</td>
</tr>
<tr>
<td>34</td>
<td>Guam 1963</td>
<td>Guam Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>35</td>
<td>GUX 1 Astro</td>
<td>Guadalcanal Island</td>
<td>International</td>
</tr>
<tr>
<td>150</td>
<td>Hartbeesthoek 94</td>
<td>South Africa</td>
<td>WGS 84</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------</td>
<td>-------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>127</td>
<td>Herat North</td>
<td>Afghanistan</td>
<td>International 1924</td>
</tr>
<tr>
<td>128</td>
<td>Hermannskogel</td>
<td>Yugoslavia (Prior to 1990), Slovenia, Croatia, Bosnia and Herzegovina, Serbia</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>36</td>
<td>Hito XVIII 1963</td>
<td>South Chile (near 53°S)</td>
<td>International</td>
</tr>
<tr>
<td>37</td>
<td>Hjorsey 1955</td>
<td>Iceland</td>
<td>International</td>
</tr>
<tr>
<td>38</td>
<td>Hong Kong 1963</td>
<td>Hong Kong</td>
<td>International</td>
</tr>
<tr>
<td>1004</td>
<td>Hungarian Datum (HD 72)</td>
<td>Hungary</td>
<td>GRS 67</td>
</tr>
<tr>
<td>39</td>
<td>Hu-Tzu-Shan</td>
<td>Taiwan</td>
<td>International</td>
</tr>
<tr>
<td>40</td>
<td>Indian</td>
<td>Thailand and Vietnam</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>41</td>
<td>Indian</td>
<td>Bangladesh, India, Nepal</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>129</td>
<td>Indian</td>
<td>Pakistan</td>
<td>Everest (Pakistan)</td>
</tr>
<tr>
<td>130</td>
<td>Indian 1954</td>
<td>Thailand</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>131</td>
<td>Indian 1960</td>
<td>Vietnam</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>132</td>
<td>Indian 1975</td>
<td>Thailand</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>133</td>
<td>Indonesian 1974</td>
<td>Indonesia</td>
<td>Indonesian 1974</td>
</tr>
<tr>
<td>42</td>
<td>Ireland 1965</td>
<td>Ireland</td>
<td>Modified Airy</td>
</tr>
<tr>
<td>134</td>
<td>ISTS 061 Astro 1968</td>
<td>South Georgia Island</td>
<td>International 1924</td>
</tr>
<tr>
<td>43</td>
<td>ISTS 073 Astro 1969</td>
<td>Diego Garcia</td>
<td>International</td>
</tr>
<tr>
<td>44</td>
<td>Johnston Island 1961</td>
<td>Johnston Island</td>
<td>International</td>
</tr>
<tr>
<td>45</td>
<td>Kandawala</td>
<td>Sri Lanka</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>46</td>
<td>Kerguelen Island</td>
<td>Kerguelen Island</td>
<td>International</td>
</tr>
<tr>
<td>47</td>
<td>Kertau 1948</td>
<td>West Malaysia and Singapore</td>
<td>Everest (W. Malaysia and Singapore 1948)</td>
</tr>
<tr>
<td>1016</td>
<td>KKJ</td>
<td>Finland</td>
<td>International</td>
</tr>
<tr>
<td>135</td>
<td>Kusaie Astro 1951</td>
<td>Caroline Islands, Federated States of Micrones</td>
<td>International 1924</td>
</tr>
<tr>
<td>48</td>
<td>L.C. 5 Astro</td>
<td>Cayman Brac Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>136</td>
<td>Leigon</td>
<td>Ghana</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>49</td>
<td>Liberia 1964</td>
<td>Liberia</td>
<td>Clarke 1880</td>
</tr>
</tbody>
</table>
### Datums Table (continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>113</td>
<td>Lisboa (DLx)</td>
<td>Portugal</td>
<td>International</td>
</tr>
<tr>
<td>50</td>
<td>Luzon</td>
<td>Philippines (excluding Mindanao Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>51</td>
<td>Luzon</td>
<td>Mindanao Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>52</td>
<td>Mahe 1971</td>
<td>Mahe Island</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>53</td>
<td>Marco Astro</td>
<td>Salvage Islands</td>
<td>International</td>
</tr>
<tr>
<td>54</td>
<td>Massawa</td>
<td>Eritrea (Ethiopia)</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>55</td>
<td>Merkich</td>
<td>Morocco</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>56</td>
<td>Midway Astro 1961</td>
<td>Midway Island</td>
<td>International</td>
</tr>
<tr>
<td>57</td>
<td>Minna</td>
<td>Nigeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>137</td>
<td>Montserrat Island Astro 1958</td>
<td>Montserrat, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>138</td>
<td>M'Poraloko</td>
<td>Gabon</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>58</td>
<td>Nahrwan</td>
<td>Masirah Island (Oman)</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>59</td>
<td>Nahrwan</td>
<td>United Arab Emirates</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>60</td>
<td>Nahrwan</td>
<td>Saudi Arabia</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>61</td>
<td>Naparima, BWI</td>
<td>Trinidad and Tobago</td>
<td>International</td>
</tr>
<tr>
<td>109</td>
<td>Netherlands</td>
<td>Netherlands</td>
<td>Bessel</td>
</tr>
<tr>
<td>31</td>
<td>New Zealand Geodetic Datum 1949 (NZGD 49)</td>
<td>New Zealand</td>
<td>International</td>
</tr>
<tr>
<td>63</td>
<td>North American 1927 (NAD 27)</td>
<td>Alaska</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>64</td>
<td>North American 1927 (NAD 27)</td>
<td>Bahamas (excluding San Salvador Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>65</td>
<td>North American 1927 (NAD 27)</td>
<td>San Salvador Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>66</td>
<td>North American 1927 (NAD 27)</td>
<td>Canada (including Newfoundland Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>67</td>
<td>North American 1927 (NAD 27)</td>
<td>Canal Zone</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>68</td>
<td>North American 1927 (NAD 27)</td>
<td>Caribbean (Turks and Caicos Islands)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>69</td>
<td>North American 1927 (NAD 27)</td>
<td>Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras, Nicaragua)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>70</td>
<td>North American 1927 (NAD 27)</td>
<td>Cuba</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>71</td>
<td>North American 1927 (NAD 27)</td>
<td>Greenland (Hayes Peninsula)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>72</td>
<td>North American 1927 (NAD 27)</td>
<td>Mexico</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>73</td>
<td>North American 1927 (NAD 27)</td>
<td>Michigan (used only for State Plane Coordinate System 1927)</td>
<td>Modified Clarke 1866</td>
</tr>
<tr>
<td>74</td>
<td>North American 1983 (NAD 83)</td>
<td>Alaska, Canada, Central America, Continental US, Mexico</td>
<td>GRS 80</td>
</tr>
<tr>
<td>139</td>
<td>North Sahara 1959</td>
<td>Algeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>107</td>
<td>Nouvelle Triangulation Francaise (NTF) Greenwich Prime Meridian</td>
<td>France</td>
<td>Modified Clarke 1880</td>
</tr>
<tr>
<td>1002</td>
<td>Nouvelle Triangulation Francaise (NTF) Paris Prime Meridian</td>
<td>France</td>
<td>Modified Clarke 1880</td>
</tr>
<tr>
<td>111</td>
<td>NWGL 10</td>
<td>Worldwide</td>
<td>WGS 72</td>
</tr>
<tr>
<td>117</td>
<td>NZGD 2000</td>
<td>New Zealand</td>
<td>GRS 80</td>
</tr>
<tr>
<td>1010</td>
<td>NZGD 49, 7 parameter</td>
<td>New Zealand</td>
<td>International</td>
</tr>
<tr>
<td>75</td>
<td>Observatorio 1966</td>
<td>Corvo and Flores Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>140</td>
<td>Observatorio Meteorologico 1939</td>
<td>Corvo and Flores Islands (Azores)</td>
<td>International 1924</td>
</tr>
<tr>
<td>76</td>
<td>Old Egyptian</td>
<td>Egypt</td>
<td>Helmert 1906</td>
</tr>
<tr>
<td>77</td>
<td>Old Hawaiian</td>
<td>Hawaii</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>78</td>
<td>Oman</td>
<td>Oman</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>79</td>
<td>Ordnance Survey of Great Britain 1936</td>
<td>England, Isle of Man, Scotland, Shetland Islands, Wales</td>
<td>Airy</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------</td>
<td>-----------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>1012</td>
<td>Russia PZ90</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>80</td>
<td>Pico de las Nieves</td>
<td>Canary Islands</td>
<td>International</td>
</tr>
<tr>
<td>81</td>
<td>Pitcairn Astro 1967</td>
<td>Pitcairn Island</td>
<td>International</td>
</tr>
<tr>
<td>141</td>
<td>Point 58</td>
<td>Burkina Faso and Niger</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>142</td>
<td>Pointe Noire 1948</td>
<td>Congo</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>143</td>
<td>Porto Santo 1936</td>
<td>Porto Santo and Madeiras Islands</td>
<td>International 1924</td>
</tr>
<tr>
<td>1000</td>
<td>Potsdam</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>82</td>
<td>Provisional South American 1956</td>
<td>Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela</td>
<td>International</td>
</tr>
<tr>
<td>36</td>
<td>Provisional South Chilean 1963</td>
<td>South Chile (near 53°S)</td>
<td>International</td>
</tr>
<tr>
<td>83</td>
<td>Puerto Rico</td>
<td>Puerto Rico and Virgin Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>1001</td>
<td>Pulkovo 1942</td>
<td>Germany</td>
<td>Krassovsky</td>
</tr>
<tr>
<td>84</td>
<td>Qatar National</td>
<td>Qatar</td>
<td>International</td>
</tr>
<tr>
<td>85</td>
<td>Qornoq</td>
<td>South Greenland</td>
<td>International</td>
</tr>
<tr>
<td>1000</td>
<td>Rauenberg</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>86</td>
<td>Reunion</td>
<td>Mascarene Island</td>
<td>International</td>
</tr>
<tr>
<td>112</td>
<td>Rikets Triangulering 1990 (RT 90)</td>
<td>Sweden</td>
<td>Bessel</td>
</tr>
<tr>
<td>1011</td>
<td>Rikets Triangulering 1990 (RT 90), 7 parameter</td>
<td>Sweden</td>
<td>Bessel</td>
</tr>
<tr>
<td>87</td>
<td>Rome 1940</td>
<td>Sardinia Island</td>
<td>International</td>
</tr>
<tr>
<td>88</td>
<td>Santo (DOS)</td>
<td>Espírito Santo Island</td>
<td>International</td>
</tr>
<tr>
<td>89</td>
<td>São Braz</td>
<td>São Miguel, Santa Maria Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>90</td>
<td>Sapper Hill 1943</td>
<td>East Falkland Island</td>
<td>International</td>
</tr>
<tr>
<td>91</td>
<td>Schwarzeck</td>
<td>Namibia</td>
<td>Modified Bessel 1841</td>
</tr>
<tr>
<td>144</td>
<td>Selvagem Grande 1938</td>
<td>Salvage Islands</td>
<td>International 1924</td>
</tr>
<tr>
<td>145</td>
<td>Sierra Leone 1960</td>
<td>Sierra Leone</td>
<td>Clarke 1880</td>
</tr>
</tbody>
</table>
### Datums Table (continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>146</td>
<td>S-JTSK</td>
<td>Czech Republic</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>1012</td>
<td>Russia SK42</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>1013</td>
<td>Russia SK95</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>92</td>
<td>South American 1969</td>
<td>Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay, Peru, Venezuela, Trinidad, and Tobago</td>
<td>South American 1969</td>
</tr>
<tr>
<td>93</td>
<td>South Asia</td>
<td>Singapore</td>
<td>Modified Fischer 1960</td>
</tr>
<tr>
<td>94</td>
<td>Southeast Base</td>
<td>Porto Santo and Madeira Islands</td>
<td>International</td>
</tr>
<tr>
<td>95</td>
<td>Southwest Base</td>
<td>Faial, Graciosa, Pico, Sao Jorge, Terceira Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>1003</td>
<td>Switzerland (CH 1903)</td>
<td>Switzerland</td>
<td>Bessel</td>
</tr>
<tr>
<td>147</td>
<td>Tananarive Observatory 1925</td>
<td>Madagascar</td>
<td>International 1924</td>
</tr>
<tr>
<td>96</td>
<td>Timbalai 1948</td>
<td>Brunei and East Malaysia (Sarawak and Sabah)</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>97</td>
<td>Tokyo</td>
<td>Japan, Korea, Okinawa</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>98</td>
<td>Tristan Astro 1968</td>
<td>Tristan da Cunha</td>
<td>International</td>
</tr>
<tr>
<td>99</td>
<td>Viti Levu 1916</td>
<td>Viti Levu Island (Fiji Islands)</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>148</td>
<td>Voirol 1874</td>
<td>Tunisia/Algeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>149</td>
<td>Voirol 1960</td>
<td>Algeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>100</td>
<td>Wake-Eniwetok 1960</td>
<td>Marshall Islands</td>
<td>Hough</td>
</tr>
<tr>
<td>101</td>
<td>World Geodetic System 1960 (WGS 60)</td>
<td>Worldwide</td>
<td>WGS 60</td>
</tr>
<tr>
<td>102</td>
<td>World Geodetic System 1966 (WGS 66)</td>
<td>Worldwide</td>
<td>WGS 66</td>
</tr>
<tr>
<td>103</td>
<td>World Geodetic System 1972 (WGS 72)</td>
<td>Worldwide</td>
<td>WGS 72</td>
</tr>
<tr>
<td>104</td>
<td>World Geodetic System 1984 (WGS 84)</td>
<td>Worldwide</td>
<td>WGS 84</td>
</tr>
<tr>
<td>105</td>
<td>Yacare</td>
<td>Uruguay</td>
<td>International</td>
</tr>
<tr>
<td>106</td>
<td>Zanderij</td>
<td>Surinam</td>
<td>International</td>
</tr>
</tbody>
</table>
Units

The following table lists the available measurement units and the number used to identify the unit in the MAPINFO.W.PRJ file:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Centimeters</td>
</tr>
<tr>
<td>31</td>
<td>Chains</td>
</tr>
<tr>
<td>3</td>
<td>Feet (also called International Feet)*</td>
</tr>
<tr>
<td>2</td>
<td>Inches</td>
</tr>
<tr>
<td>1</td>
<td>Kilometers</td>
</tr>
<tr>
<td>30</td>
<td>Links</td>
</tr>
<tr>
<td>7</td>
<td>Meters</td>
</tr>
<tr>
<td>0</td>
<td>Miles</td>
</tr>
<tr>
<td>5</td>
<td>Millimeters</td>
</tr>
<tr>
<td>9</td>
<td>Nautical Miles**</td>
</tr>
<tr>
<td>32</td>
<td>Rods</td>
</tr>
<tr>
<td>8</td>
<td>US Survey Feet (used for 1927 State Plane)***</td>
</tr>
<tr>
<td>4</td>
<td>Yards</td>
</tr>
</tbody>
</table>

*One International Foot equals exactly 30.48 cm.
**One Nautical Mile equals exactly 1852 meters.
***One US Survey Foot equals exactly 12/39.37 meters, or approximately 30.48006 cm.

Coordinate System Origin

The coordinate system origin is the point on the Earth (specified as longitude and latitude degrees) from which all coordinate distances are to be measured. X = 0 and Y = 0 at the origin point, unless a false easting and/or false northing is used (see below). It is chosen to optimize the accuracy of a particular coordinate system. As we move north from the origin, Y increases; X increases as we move east. These coordinate values are generally called northings and eastings.

For the Transverse Mercator projection, the origin’s longitude defines the central meridian. In constructing the Transverse Mercator projection a cylinder is positioned tangent to the earth. The central meridian is the line of tangency. The scale of the projected map is true along the central meridian.

In creating a Hotine Oblique Mercator projection it is necessary to specify a great circle that is not the equator nor a meridian. MapInfo Professional does this by specifying one point on the ellipsoid and an azimuth from that point. That point is the origin of the coordinate system.
**Standard Parallels (Conic Projections)**

In conic projections a cone is passed through the earth intersecting it along two parallels of latitude. These are the standard parallels. One is to the north and one is to the south of the projection zone. To use a single standard parallel specify that latitude twice. Both are expressed in degrees of latitude.

**Oblique Azimuth (Hotine Oblique Mercator)**

When specifying a great circle (such as the Hotine Oblique Mercator) using a point and an azimuth (arc), the azimuth is called the Oblique Azimuth and is expressed in degrees.

**Scale Factor (Transverse Mercator)**

A scale factor is applied to cylindrical coordinates to average scale error over the central area of the map while reducing the error along the east and west boundaries. The scale factor has the effect of recessing the cylinder into the earth so that it has two lines of intersection. Scale is true along these lines of intersection.

You may see the scale factor expressed as a ratio, such as 1:25000. In this case it is generally called the scale reduction. The relationship between scale factor and scale reduction is:

\[
\text{scale factor} = 1 - \text{scale reduction}
\]

In this case the scale factor would be 1-(1/25000) or 0.99996.

**False Easting and False Northing**

As you can see in the Longitude/Latitude Projection Map on page II-158, X and Y coordinate parameters are commonly designated in relationship to a single point. Points to the left of that center point are negative and points to the right are positive. Points above that center point are positive and points below that point are negative.

In the days of the tall ships, these calculations and computations were done by hand. Using positive and negative signs made these calculations more complicated. The terms “false easting” and “false northing” were used to remove these signs and refer to the absolute value of the X and Y coordinates. Now, MapInfo Professional handles these computations, but these parameters still have to be accounted for in the projections that use them.

**Range (Azimuthal Projections)**

The range specifies, in degrees, how much of the Earth is visible. The range can be between 1 and 180. When you specify 90, you see a hemisphere. When you specify 180 you see the whole earth, though much of it is very distorted.

**About Polyconic Coordinate Systems**

The following description has been copied from “Map Projections – A Working Manual”, USGS Professional Paper 1395, by John P. Snyder.
The Polyconic projection, usually called the American Polyconic in Europe, achieved its name because the curvature of the circular arc for each parallel on the map is the same as it would be following the unrolling of a cone which had been wrapped around the globe tangent to the particular parallel of latitude, with the parallel traced onto the cone. Thus, there are many ("poly-") cones involved, rather than the single cone of each regular conic projection.

The Polyconic projection is neither equal-area nor conformal. Along the central meridian, however, it is both distortion free and true to scale. Each parallel is true to scale, but the meridians are lengthened by various amounts to cross each parallel at the correct position along the parallel, so that no parallel is standard in the sense of having conformity (or correct angles), except at the central meridian. Near the central meridian, distortion is extremely small.

This projection is not intended for mapping large areas. The conversion algorithms used break down when mapping wide longitude ranges. For example, World.tab, from the sample data shipped with MapInfo Professional, may exhibit anomalies if reprojected using Polyconic.

Examples of Projection Entries in the MAPINFOW.PRJ File

The MAPINFOW.PRJ file lists the parameters for each coordinate system on a separate line, as in the following examples:

- "Mollweide (Equal Area)", 13, 62, 7, 0
- "Albers Equal-Area Conic (Alaska)", 9, 63, 7, -154, 50, 55, 65, 0, 0
- "UTM Zone 9 (NAD 27 for Canada)", 8, 66, 7, -129, 0, 0.9996, 500000, 0

This is a basic list of the elements of a coordinate system, for review. Following this list, you can see some entries from the .PRJ file.

1. The first element in each list is the name of the projection in quotes.
2. The second element in each list is the number that identifies the projection type as indicated in Datums Table on page II-166.
3. The remaining elements in the list are the parameter values for that particular projection. The elements follow the order as outlined in the table Common Coordinate Systems and their Parameters on page II-162. Each element is separated by a comma.

Let's look at some specific coordinate systems to prepare you to create your own projection. It is important to remember that the elements of a projection are different for each projection. Here are some examples we have already seen:

Example: "Mollweide (Equal Area)", 13, 62, 7, 0

where:

<table>
<thead>
<tr>
<th>Where</th>
<th>Refers to:</th>
<th>For More Information, See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Mollweide (Equal Area)&quot;,</td>
<td>Name of Coordinate System</td>
<td>Common Coordinate Systems and their Parameters on page II-162</td>
</tr>
<tr>
<td>13,</td>
<td>Projection type used</td>
<td>MapInfo Professional Projection Types Table on page II-163</td>
</tr>
<tr>
<td>62,</td>
<td>Datum used</td>
<td>Datums Table on page II-166</td>
</tr>
</tbody>
</table>
Example: “Albers Equal–Area Conic (Alaska)”, 9, 63, 7, –154, 50, 55, 65, 0, 0
where:

<table>
<thead>
<tr>
<th>Where</th>
<th>Refers to:</th>
<th>For More Information, See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>7,</td>
<td>Units used</td>
<td>Units Table on page II-174</td>
</tr>
<tr>
<td>0</td>
<td>Origin Longitude used</td>
<td>Coordinate System Origin on page II-174</td>
</tr>
</tbody>
</table>

Note: If a projection is not in the list in Common Coordinate Systems and their Parameters on page II-162, this coordinate system is a variation of one of the systems in the list.

“UTM Zone 9 (NAD 27 for Canada)”, 8, 66, 7, –129, 0, 0.9996, 500000, 0
where:

<table>
<thead>
<tr>
<th>Where</th>
<th>Refers to:</th>
<th>For More Information, See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>“UTM Zone 9 (NAD 27 for Canada)”,</td>
<td>Name of Coordinate System</td>
<td>Common Coordinate Systems and their Parameters on page II-162</td>
</tr>
<tr>
<td>9,</td>
<td>Projection type used</td>
<td>MapInfo Professional Projection Types Table on page II-163</td>
</tr>
<tr>
<td>66,</td>
<td>Datum used</td>
<td>Datums Table on page II-166</td>
</tr>
<tr>
<td>7,</td>
<td>Units used</td>
<td>Units Table on page II-174</td>
</tr>
<tr>
<td>-129, 0</td>
<td>Origin Longitude and Origin Latitude used</td>
<td>Coordinate System Origin on page II-174</td>
</tr>
<tr>
<td>55, 65,</td>
<td>Standard Parallels used</td>
<td>Standard Parallels (Conic Projections) on page II-175</td>
</tr>
<tr>
<td>0</td>
<td>False Easting, False Northing</td>
<td>False Easting and False Northing on page II-175</td>
</tr>
</tbody>
</table>
New Projections in the MAPINFOW.PRJ File

Once you understand the structure of the entries in the MAPINFOW.PRJ file, you are ready to create a new projection entry for your coordinate system. You may want to make a copy of the MAPINFOW.PRJ file in case you want to revert back to it later.

To create a new projection entry for the coordinate system in the MAPINFOW.PRJ file:

1. Open MAPINFOW.PRJ in a text editor or word processor. In this file, you are going to add the new projection entries.

   Figure: MAPINFOW.PRJ in Notepad

2. Scroll down in this list to find the type of projection you want to base your map on. See Understanding Coordinate Systems on page II-157 for descriptions of the different projection types.

3. Add a new line at the end of the projection list you are modifying.

   For example, to add a new Universal Transverse Mercator projection (Australian Map Grid using AGD66 datum), scroll down to that entry in the list and enter the new projection at the end of that list.

   Figure: Adding a Line in the MAPINFOW.PRJ File

<table>
<thead>
<tr>
<th>Where</th>
<th>Refers to:</th>
<th>For More Information, See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9996, 500000</td>
<td>False Easting, False Northing</td>
<td>False Easting and False Northing on page II-175</td>
</tr>
<tr>
<td>0</td>
<td>Scale Factor used</td>
<td>Scale Factor (Transverse Mercator) on page II-175</td>
</tr>
</tbody>
</table>
4. On a new line, type the new parameter entries based on the required parameters described for that projection type in the table Common Coordinate Systems and their Parameters on page II-162.
   • If the name of your projection does not appear in the Common Map Projections list, consider the kind of projection you are creating (Latitude/Longitude, Conic, Transverse, etc.) and follow the table entries for the type of projection you want.
   • Remember to include constant values (Accounting for Affine Transformations and Explicit Bounds in Projection Types on page II-164) to indicate an affine transformation, specific bounds, or both if appropriate or necessary.

   Note: The order of parameters is vitally important. Remember to separate each parameter with a comma.

5. Save your edited MAPINFOW.PRJ file in the directory in your user directory.

   Note: In the past the MAPINFOW.PRJ file was saved in your installation directory but this did not allow different users to have different PRJ files. This new file placement permits this.

Things to keep in mind when editing the MAPINFOW.PRJ file:

• When specifying projection, datum and units, use the number that represents the parameter. These numbers are listed in the table for each parameter earlier in this appendix. In our example, 6 represents Equidistant Conic projection; 74 represents NAD 83 datum, and 7 represents meters.

• You must record the X and Y coordinates of the origin point in decimal degrees.

• Remember to include a negative sign for west longitudes and south latitudes.

• You must list the origin longitude first in the MAPINFOW.PRJ file entry.

• Carry out decimals to at least five (5) places for greater accuracy.

• Do not use commas to represent thousands or millions in large numbers. Only use commas to separate parameters from one another.

Using the New Projection in a Coordinate System

Once you have created this new projection, you can use it in a Map window to replace the coordinate system you are using.

1. Open the map for which you want to change projections.
2. From the MAP menu, select OPTIONS to display the MAP OPTIONS dialog box.
3. Click the PROJECTIONS button to display the CHOOSE PROJECTION dialog box.

   Note: To change the projection of a tab file and all of the map objects in it, use the FILE > SAVE COPY AS command and select the new projection.

   Figure: Choose Projection
4. Select the new projection from the list and click **OK** to confirm. The Map Options dialog rediresplays.
5. Click **OK** to implement the new projection in the Map window.

### Entering a New Coordinate System (Example)

To illustrate this process in another way, create the following coordinate system using these parameters by adding a new entry to the MAPINFO.W.PRJ file:

<table>
<thead>
<tr>
<th>Parameter Type</th>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>“Equidistant Conic Plus”</td>
<td>Name of the new coordinate system</td>
</tr>
<tr>
<td>Projection Type</td>
<td>6,</td>
<td>Equidistant Conic</td>
</tr>
<tr>
<td>Datum</td>
<td>74,</td>
<td>(NAD 83)</td>
</tr>
<tr>
<td>Units</td>
<td>7,</td>
<td>meters</td>
</tr>
<tr>
<td>Origin Longitude</td>
<td>-90.5,</td>
<td>90°30′W</td>
</tr>
<tr>
<td>Origin Latitude</td>
<td>30, 30°,</td>
<td>30°N,</td>
</tr>
<tr>
<td>Standard Parallel 1</td>
<td>10.33333,</td>
<td>10°20′N</td>
</tr>
<tr>
<td>Standard Parallel 2</td>
<td>50,</td>
<td>50°N</td>
</tr>
<tr>
<td>False Easting</td>
<td>10000000,</td>
<td>10,000,000 m</td>
</tr>
<tr>
<td>False Northing</td>
<td>500000,</td>
<td>500,000 m</td>
</tr>
</tbody>
</table>

1. Open MAPINFO.W.PRJ in a text editor or word processor.
2. Go to the Equidistant Conic section and add a new line.
3. Type the name of your new coordinate system in quotes, followed by a comma.
4. Enter the following information to represent your coordinate system:
   
   \[
   6, 74, 7, -90.5, 30, 10.33333, 50, 10000000, 500000 
   \]
5. Save your edited MAPINFO.W.PRJ file.

You can now use your custom coordinate system just as you would use any of the coordinate systems that come with MapInfo.

There are other ways you can edit this file. To shorten the list, remove coordinate systems from the file. You can also change the names, change group headings and reorder the file to suit your needs.

**Note:** Group headings are distinguished by the hyphen at the beginning of the name. Names of coordinate systems cannot begin with a hyphen or a space.
Understanding Affine Transformations

An affine transformation allows you to match the points on two vector maps that use different coordinate systems so they can be used together. The base map stays the same while the derived map is transformed mathematically to match up coordinates to the base map.

MapInfo Professional provides the definitions for scale, translation, rotation, reflection, and shearing necessary to support an optional affine transformation for any coordinate system definition. You can also define a coordinate system with bounds and/or with an affine transformation. This is described in detail in Accounting for Affine Transformations and Explicit Bounds in Projection Types on page II-164.

Description of an Affine Transformation

There are several basic types of transformation that can be applied to the base map using an affine transformation. These include scaling, translation, rotation, shearing, and reflection.

The scale factor of a transformation indicates the distance between the fixed points of one map versus the fixed points of the second map. If the only difference between two maps is the scale, the affine transformation of the derived map is only the same map zoomed in or out around a fixed point. The orientations of the lines connecting the points, and the angles between these lines, remain the same. The scaling in the case of the figure below is around the 0,0 point.

The difference between these two images is the scale. To create an affine transformation that maps the base image (A) to the derived image (B), you need change only the scale.

The translation factor of a transformation is when every point on an image follows a parallel path and no rotation takes place.

The difference between these two images is the translation.
The rotation factor of a transformation indicates that the image turns on a particular point. The next figure shows a 25-degree rotation of the map around the 0,0 point.

The difference between these two images is not the scale, because the size of each image is the same. The difference is the rotation of the derived image (B).

The shearing factor of a transformation indicates that one of the coordinates of one image should change proportionally to the other. You can apply a shear transformation either on the x-axis as shown in the next figure or on the y-axis. As you can see the vertical scale of the image has not changed, and the corner of the figure at 0,0 has not moved -- but points higher up on the figure are shifted progressively further to the right.

The difference is the shearing of the derived image (B).

The reflection factor of a transformation indicates that the derived image is the mirror image of the base image, that is, all the points in the base image should be reflected across some straight line, such as the x-axis or y-axis. In the figure below, the derived image (B) is the reflection of the base image (A).

The difference between these two images is that the derived image (B) is a reflection of the base image (A) along the x-axis.

Mathematically, an affine transformation in MapInfo Professional has the following form:

\[ x' = Ax + By + C \]
\[ y' = Dx + Ey + F \]
In these equations, the **base** coordinates \((x, y)\) are transformed to produce the **derived** coordinates \((x', y')\). The six constants A through F determine the effect of the transformation. We can use the post multiply method for homogenous 2D coordinate systems, which can be considered a matrix operation as follows:

\[
\begin{bmatrix}
A & B & C \\
D & E & F \\
0 & 0 & 1
\end{bmatrix}
\begin{bmatrix}
x \\
y \\
1
\end{bmatrix}
=
\begin{bmatrix}
x' \\
y' \\
1
\end{bmatrix}
\]

where \((X,Y)\) and \((X',Y')\) are as defined above.

To do various types of affine transformations the values of A, B, C, D, E, and F need to be determined. To define the basic transformations that can be done using an affine transformation, determine the translations, rotations, reflections, scaling and shearing in the X and Y directions.

**Translation:** C and F are the values you want \((0, 0)\) to go to, A=E=1 and B=D=0. To move the coordinate system so the origin is at \((5, 2)\) the values would be: A=1, B=0, C=5, D=0, E=1, and F=2.

**Rotation about the origin:** A=E=\(\cos(\text{angle to rotate})\), -B=D=\(\sin(\text{angle to rotate})\), C=F=0. To rotate 60 degree counterclockwise around the origin, A=.5, B=-.866, C=0, D=.866, E=.5, and F=0.

**To scale in the X direction:** A is the scale you want to use. E =1 and the rest are 0. So to scale to 3 times the size in the X direction the values would be A=3, B=0, C=0, D=0, E=1, F=0.

**To scale in the Y direction:** E is the scale you want to use. A =1 and the rest are 0. So to scale to 5 times the size in the Y direction the values would be A=1, B=0, C=0, D=0, E=5, F=0.

**To scale overall just make sure that A and E are equal.**

**To shear in the X direction:** A = E = 1, B is the shear factor and the rest are 0. So for a shear factor of 5 in the X direction (that is, to move a derived point 5 units in the X direction for each Y unit in the base point) use A=1, B=5, C=0, D=0, E=1, F=0.

**To shear in the Y direction:** A = E = 1, D is the shear factor and the rest are 0. So for a shear factor of 4 in the Y direction, use A=1, B=0, C=0, D=4, E=1, F=0.

**To reflect an image across the X axis:** A = 1, E = -1 and the rest are 0. More generally, to reflect across the line \(y = k\), use A=1, B=0, C=0, D=0, E=-1, F=2\*k.

**To reflect an image across the Y axis:** A = -1, E = 1 and the rest are 0. More generally, to reflect across the line \(x = j\), use A=-1, B=0, C=2\*j, D=0, E=1, F=0.

Now to get a general affine transformation, do a pre-matrix multiplication of the basic pieces of the transformation. Make sure that you put the first operation on the right. So to Translate to \((5,2)\), rotate 60 degrees and then shear 5 units in Y, set up and multiply the following matrices:

\[
\begin{bmatrix}
1 & 0 & 0 & 0.5 & -.0866 & 0 & 1 & 0 & 5 \\
5 & 1 & 0 & .0866 & 0.5 & 0 & * & 0 & 1 & 2 \\
0 & 0 & 1 & 0 & 0 & 1 & 0 & 0 & 1
\end{bmatrix}
\]
Multiplying these out gives the following matrix:

\[
\begin{bmatrix}
0.5 & -0.866 & 0.768 \\
3.366 & -3.83 & 9.17 \\
0 & 0 & 1
\end{bmatrix}
\]

Therefore, the required values are: A=.5, B=-.866, C=0.768, D=3.366, E=-3.83, F=9.17.

**Note:** When using affine transformation values in projection definitions or .MIF file COORDSYS settings, you may need to calculate the "inverse" of an affine transformation. This is because if a table displays in a projection that includes an affine transformation, MapInfo Professional transforms the coordinate system, not the objects in the table!

### Frequently Asked Questions

**What do the \p#### codes mean in the MAPINFO.PRF file?**

**e.g.:** "— Australian Map Grid (AGD 66) —"

"AMG Zone 47 (AGD 66)", 8, 12, 7, 99, 0, 0.9996, 500000, 10000000

"AMG Zone 48 (AGD 66)\p20248", 8, 12, 7, 105, 0, 0.9996, 500000, 10000000

**Answer:** MapInfo Professional uses the \p#### or Projected Coordinate System (PCS) codes shown in the above example when registering GeoTIFF images or other georeferenced raster images. GeoTIFF files often identify their coordinate system with a single code number instead of listing the coordinate system parameters, so MapInfo Professional scans the MAPINFO.PRF file to find a matching supported code. MapInfo Professional supports a subset of PCS codes, depending on the projection they use, in values between 20000 and 32760. Codes cannot be used more than once in the MAPINFO.PRF file.

**Note:** WMS tables (and WFS) also use these \p#### codes in mapinfow.prj file entries to determine correct coordinate system to use.

For more information about GeoTIFF files and PCS codes, see this web page:

http://www.remotesensing.org/geotiff/geotiff.html

**How do I convert a coordinate system with units in meters to feet?**

**Answer:** You will need to edit the MAPINFO.PRF file to modify the same projection in a different measurement system and adjust the False Eastings and Northings used for the difference.

For example below, the first line is the original projection expressed in meters. The second line is a copied modification of the first, where the units were changed from "7" (meters) to "8" (feet) indicating this coordinate system is now using feet, and the False Easting (2000000) and Northing (500000) components were divided by .3048 to convert them from meters to feet.

**Example:**

"California, Zone I (1983)\p26941", 3, 74, 7, -122, 39.3333333333, 40, 41.6666666667, 2000000, 5000000
I chose Longitude/Latitude (NAD 83) as my projection; however, whenever I look at the Choose Projection dialog, it keeps saying Longitude/Latitude (GRS 80). Why won't my projection change?

Answer: The GRS 80 datum is identical to NAD 83 datum. MapInfo Professional uses the numeric parameters, not the name, to decide which coordinate system to highlight in the Choose Projection dialog. Since GRS 80 has the same numeric parameters as NAD 83, and GRS 80 datum comes earlier in the list, MapInfo Professional chooses GRS 80 instead of NAD 83.

For More Information

The first three publications listed below are relatively short pamphlets. The last two are substantial books. We've also given addresses and phone numbers for the American Congress of Surveying and Mapping (the pamphlets) and the U.S. Geological Survey (the books).


Contact Information

The Department of Geography at the University of Colorado at Boulder has made available “The Geographer’s Craft” project, a website devoted to explanations of map projections, geodetic datums, and coordinate systems. It is particularly valuable because many of the explanations are presented using MapInfo Professional. The materials may be used for study, research, and education. If you link to or cite the materials below, please credit the author: Peter H. Dana, The Geographer’s Craft Project, Department of Geography, The University of Colorado at Boulder.

For geodetic datum information and explanations, go to:
http://www.colorado.edu/geography/gcraft/notes/datum/datum.html

For information on coordinate systems and associated topics, go to:
http://www.colorado.edu/geography/gcraft/notes/coordsys/coordsys.html

For information on map projections, go to:
http://www.colorado.edu/geography/gcraft/notes/mapproj/mapproj.html
High-Resolution Custom Symbols

MapInfo provides new high-resolution (24-bit color) custom symbols.

The destination CustSymb directory is determined by the during installation. If you executed the MapBasic command to reload custom symbols from a particular directory, then the Add Custom Symbols dialog box will add to that directory instead. See the Reload Symbols statement in the MapBasic Reference Guide, Version 7.8.

Sections in this Appendix:

- New High Resolution Custom Symbols ........................ II-187
- Enhanced High Resolution Custom Symbols .............. II-189
## New High Resolution Custom Symbols

This table illustrates the new high-resolution (24-bit color) custom symbols that are provided with MapInfo Professional version 7.8.

<table>
<thead>
<tr>
<th>Name</th>
<th>Image</th>
<th>Name</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>camping-64.bmp</td>
<td><img src="camping-64.bmp" alt="Image" /></td>
<td>hospital-64.bmp</td>
<td><img src="hospital-64.bmp" alt="Image" /></td>
<td>pencil-64.bmp</td>
<td><img src="pencil-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>church-64.bmp</td>
<td><img src="church-64.bmp" alt="Image" /></td>
<td>interstate-64.bmp</td>
<td><img src="interstate-64.bmp" alt="Image" /></td>
<td>police-64.bmp</td>
<td><img src="police-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>compass-64.bmp</td>
<td><img src="compass-64.bmp" alt="Image" /></td>
<td>lighthouse-64.bmp</td>
<td><img src="lighthouse-64.bmp" alt="Image" /></td>
<td>restaurant-64.bmp</td>
<td><img src="restaurant-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>construction-64.bmp</td>
<td><img src="construction-64.bmp" alt="Image" /></td>
<td>lighthouse2-64.bmp</td>
<td><img src="lighthouse2-64.bmp" alt="Image" /></td>
<td>STOP-64.BMP</td>
<td><img src="STOP-64.BMP" alt="Image" /></td>
</tr>
<tr>
<td>FARM-64.BMP</td>
<td><img src="FARM-64.BMP" alt="Image" /></td>
<td>MAIL-64.BMP</td>
<td><img src="MAIL-64.BMP" alt="Image" /></td>
<td>synagogue-64.bmp</td>
<td><img src="synagogue-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>FIRE2-64.BMP</td>
<td><img src="FIRE2-64.BMP" alt="Image" /></td>
<td>MAIL2-64.BMP</td>
<td><img src="MAIL2-64.BMP" alt="Image" /></td>
<td>target-64.bmp</td>
<td><img src="target-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>FIRE3-64.BMP</td>
<td><img src="FIRE3-64.BMP" alt="Image" /></td>
<td>MAIL3-64.BMP</td>
<td><img src="MAIL3-64.BMP" alt="Image" /></td>
<td>TAXI-64.BMP</td>
<td><img src="TAXI-64.BMP" alt="Image" /></td>
</tr>
<tr>
<td>GLOBE-64.BMP</td>
<td><img src="GLOBE-64.BMP" alt="Image" /></td>
<td>mosque-64.bmp</td>
<td><img src="mosque-64.bmp" alt="Image" /></td>
<td>temple-64.bmp</td>
<td><img src="temple-64.bmp" alt="Image" /></td>
</tr>
<tr>
<td>Name</td>
<td>Image</td>
<td>Name</td>
<td>Image</td>
<td>MB ID</td>
<td>Image</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>---------------</td>
</tr>
<tr>
<td>GOLF-64.BMP</td>
<td>![Golf Image]</td>
<td>oneway-left-64.bmp</td>
<td>![One Way Left]</td>
<td>TOWER-64.BMP</td>
<td>![Tower Image]</td>
</tr>
<tr>
<td>highway-64.bmp</td>
<td>![Highway Image]</td>
<td>oneway-right-64.bmp</td>
<td>![One Way Right]</td>
<td>tower2-64.bmp</td>
<td>![Tower Image]</td>
</tr>
</tbody>
</table>

Note: The images are not included in this text representation.
Enhanced High Resolution Custom Symbols

This table illustrates the enhanced high-resolution (24-bit color) custom symbols that are provided with MapInfo Professional version 7.8. These images were originally provided with MapInfo Professional version 7.5, but have been enhanced for a sharper appearance.

<table>
<thead>
<tr>
<th>Name</th>
<th>Image</th>
<th>Name</th>
<th>Image</th>
<th>MB ID</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMBU-64.BMP</td>
<td><img src="image1.png" alt="Image" /></td>
<td>PING-64.BMP</td>
<td><img src="image2.png" alt="Image" /></td>
<td>PINR-64.BMP</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>BUILDINGS.BMP</td>
<td><img src="image4.png" alt="Image" /></td>
<td>PINGY-64.BMP</td>
<td><img src="image5.png" alt="Image" /></td>
<td>RED-CAR.BMP</td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>FOOD-64.BMP</td>
<td><img src="image7.png" alt="Image" /></td>
<td>PINR-64.BMP</td>
<td><img src="image8.png" alt="Image" /></td>
<td>TRUC-64.BMP</td>
<td><img src="image9.png" alt="Image" /></td>
</tr>
<tr>
<td>PINB-64.BMP</td>
<td><img src="image10.png" alt="Image" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 8/13/04 MapInfo Corporation. All rights reserved.
New and Enhanced MapBasic Statements and Functions

These are the new statements and functions available for the MapInfo Professional 7.8 product.

Sections in this Appendix:

New statements and functions

- MGRSToPoint Statement ................. II-191
- PointToMGRS Statement .................. II-191
- Objects Pline Statement .................. II-192
- Save MWS Statement ..................... II-193
- WFS Refresh Statement ................... II-194

Enhanced statements

- Create Cartographic Legend Statement .... II-194
- Export Statement .......................... II-195
- LegendInfo() ............................. II-196
- Objects Snap Statement ................... II-196
- PrintWin Statement ....................... II-196
- Register Table Statement .................. II-197
- Set Cartographic Legend Statement ....... II-197
- Shade Statement .......................... II-197
- TableInfo() ............................. II-198
MGRSToPoint Statement

Purpose
Converts a string representing an MGRS coordinate to an object value representing a point.

Syntax
MGRSToPoint(string)

Return Value
Object

Example
dim x,y As Float
dim obj as Object
dim s_mgrs As String
dim obj2 as Object

x = -74.669
y = 43.263
obj = CreatePoint(x, y)

s_mgrs = PointToMGRS$(obj)

obj2 = MGRSToPoint(s_mgrs)

PointToMGRS Statement

Purpose
Converts an object value representing a point to a string representing an MGRS coordinate.

Syntax
PointToMGRS$(inputobject)

Return Value
String

Example
dim x,y As Float
dim obj as Object
dim s_mgrs As String
dim obj2 as Object

x = -74.669
y = 43.263
obj = CreatePoint(x, y)

s_mgrs = PointToMGRS$(obj)

obj2 = MGRSToPoint(s_mgrs)
Objects Pline Statement

Purpose
Splits a single section polyline into two polylines.

Syntax

```
Objects Pline Split At Node index
[IntoTable name]
[Data column_name = expression]
[ , column_name = expression ... ]]
```

Return Value
Object

Description
If an object is a single section polyline, then two new single section polyline objects are created in the output table. The Node index should be a valid MapBasic index for the polyline to be split. If Node is a start or end node for the polyline, the operation is cancelled and an error message is displayed.

The optional Data clause controls what values are stored in the columns of the output objects. The Data clause can contain a comma-separated list of column assignments. Each column assignment can take one of the forms listed in the following table:

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_name = col_name</td>
<td>Does not alter the value stored in the column.</td>
</tr>
<tr>
<td>col_name = value</td>
<td>Stores a specific value in the column. If the column is a character column the value can be a string; if the column is a numeric column, the value can be a number.</td>
</tr>
</tbody>
</table>

The Data clause can contain an assignment for every column in the table. If the Data clause only specifies assignments for some of the columns, blank values are assigned to those columns that are not listed in the Data clause.

If you omit the Data clause entirely, all columns are blanked out of the target objects, storing zero values in numeric columns and blank values in character columns.

Example
You would typically split a polyline through the graphical user interface, but an equivalent MapBasic syntax might appear as follows.

```
Objects Pline Split At Node 12 Into Table WORLD
Data Country=Country,Capital=Capital,...
```
Save MWS Statement

Purpose
The Save MWS statement allows you to save the current workspace as an XML-based MWS file for use with MapXtreme 2004 applications. These MWS files can be shared across platforms in ways that workspaces cannot.

Syntax
```
Save MWS Window ( window_id [ , window_id ... ] ) Default default_window_id As filespec
```

`window_id` is an Integer window identifier for a Map window

`default_window_id` is an Integer window identifier for the Map window to be recorded in the MWS as the default map.

Description
MapInfo Professional enables you to save the maps in your workspace to an XML format for use with MapXtreme 2004 applications. When saving a workspace to MWS format, only the map windows and legends are saved. All other windows are discarded as MapXtreme 2004 applications cannot read that information. Once your workspace is saved in this format, it can be opened with the Workspace Manager utility that is included in the MapXtreme 2004 installation or with an application developed using MapXtreme 2004. The file is valid XML so can also be viewed using any XML viewer or editor. MWS files created with MapInfo Professional 7.8 can be validated using schemas supplied with MapXtreme 2004.

Note: You will not be able to read files saved in MWS format in MapInfo Professional 7.8.

In MapInfo Professional, you can set the visibility of a modifier theme without regard to its reference feature layer, so you can turn the visibility of the main reference layer off but still display the theme. In MapXtreme2004, the modifier themes (Dot Density, Ranges, Individual Value) are only drawn if the reference feature layer is visible. To ensure that modifiers marked as visible in MapInfo Professional display in tools like Workspace Manager, we force the visibility of the reference feature layer so that its modifier themes display.

What is Saved in the MWS
The following information is included in the MWS workspace file:

- Tab files' name and alias
- Coordsys information
- Map center and zoom settings
- Layer list with implied order
- Map size as pixel width and height
- Map resize method
- Style overrides
- Raster layer overrides
- Label and label edit information
- Individual value themes
- Dot density themes
• Graduated symbol themes
• Bar themes
• Range themes
• Pie themes
• Grid themes as MapXtreme 2004 grid layers with a style override
• Themes and label expressions based upon a single attribute column.

What is Not Saved to the MWS

The following information is not saved in the MWS workspace file:

• Any non-map windows (browsers, charts, redistricters, 3D map windows, Prism maps)
• Distance, area, or XY and military grid units
• Snap mode, autoscroll, and smart pan settings
• Printer setup information
• Any table that is based on a query
• Any theme that is generated from a complex expression

Note: A complex expression includes any operator or multiple referenced tables.

• Any queries
• Export options
• Line direction arrows
• Whether object nodes are drawn or not
• Hot links for labels and objects

WFS Refresh Statement

Purpose
The WFS Refresh Table statement refreshes a WFS table from the server.

Syntax

WFS Refresh Table alias

Example

WFS Refresh Table watershed

Create Cartographic Legend Statement

The Create Cartographic Legend statement has a new clause that creates the small or large legend sample size.

Purpose
The Create Cartographic Legend statement allows you to create and display cartographic style legends as well as theme legends for an active map window.

Syntax
The new clause in the syntax is indicated in bold.

Create Cartographic Legend
    [ Style Size {Small | Large} ]

Export Statement

Purpose
Exports a table to another file format.

Syntax 1 (for exporting MIF/MID files, DBF files, ASCII text files or CSV files)

```mapbasic
Export table
   Into file_name
[Type
   { "MIF"  |
   "DBF"  [ Charset char_set ]  |
   "ASCII" [ Charset char_set ] [ Delimiter "d " ] [ Titles ] } ]
   "CSV" [Charset char_set ] [ Titles ] ]
   [ Overwrite ]
```

Syntax 2 (for exporting DXF files)

```mapbasic
Export table
   Into file_name
[ Type "DXF" ]
[ Overwrite ]
[ Preserve
   [ AttributeData ] [ Preserve ] [ MultiPolygonRgns [ As Blocks ] ] ]
[ ( Binary | ASCII [ DecimalPlaces decimal_places ] ] ]
[ Version { 12 | 13 } ]
[ Transform
   ( MI_x1 , MI_y1 ) ( MI_x2 , MI_y2 )
   ( DXF_x1 , DXF_y1 ) ( DXF_x2 , DXF_y2 ) ]
```

table is the name of an open table; do not use quotation marks around this name

file_name is a String specifying the filename to contain the exported data; if the file name does not include a path, the export file is created in the current working directory

char_set is a String that identifies a character set, such as "WindowsLatin1"; see the separate CharSet discussion for details

d is a character used as a delimiter when exporting an ASCII file

decimal_places is a small integer (from 0 to 16, default value is 6), which controls the number of decimal places used when exporting floating-point numbers in ASCII

MI_x1, MI_y1, etc. are numbers that represent bounds coordinates in the MapInfo table

DXF_x1, DXF_y1, etc. are numbers that represent bounds coordinates in the DXF file

Description
The Export statement copies the contents of a MapInfo table to a separate file, using a file format which other packages could then edit or import. For example, you could export the contents of a table to a DXF file, then use a CAD software package to import the DXF file. The Export statement does not alter the original table.

Further details are available in the MapBasic Help System and in the MapBasic Reference Guide.
LegendInfo()

The LegendInfo() function has a new LEGEND_INFO_STYLE_SAMPLE_SIZE attribute that returns the legend size information.

Purpose
Returns information about a legend.

Syntax
LegendInfo( window_id, attribute )

The new attribute is:
LEGEND_INFO_STYLE_SAMPLE_SIZE

This attribute returns 0 for small legend sample style or 1 for large legend sample style.


Example
LegendInfo(FrontWindow() LEGEND_INFO_STYLE_SAMPLE_SIZE)

Objects Snap Statement

Purpose
Cleans the objects from the given table, and optionally performs various topology-related operations on the objects, including snapping nodes from different objects that are close to each other into the same location and generalization/thinning.

New for MapBasic 7.8: The settings specified in the Objects Snap statement are written to the input table’s metadata when the Objects Snap statement is executed. These settings become the default values for the table when the Set Values for Node Snap and Thinning dialog box is opened.

For more information about this statement, see the MapBasic Reference Guide.

PrintWin Statement

The MapBasic PrintWin statement has been enhanced so that a MapInfo window can be printed to a file.

Purpose
Prints an existing window.

Syntax
PrintWin [ Window window_id ] [ Interactive ] [ File output_filename] [ Overwrite ]

Description
The PrintWin statement prints a window.

If the statement includes the optional Window clause, MapBasic prints the specified window; otherwise, MapBasic prints the active window.
The window_id parameter represents a window identifier; see the FrontWindow() and WindowInfo() functions for more information about obtaining window identifiers.

If you include the Interactive keyword, MapInfo Professional displays the Print dialog. If you omit the Interactive keyword, MI Pro prints the window automatically, without displaying the dialog.

Example

```
PrintWin Window FrontWindow() File "c:\output\file.plt"
```

## Register Table Statement

When opening an Excel spreadsheet, the user can now specify how each column is imported. For example, the user might want a 'Date' column in Excel to be a Text column in MapInfo Professional. The MapBasic Register Table statement has been enhanced to support this new feature.

**Syntax**

When the Interactive keyword is specified for type XLS, it instructs the interface to display the Set Field Properties window when importing Excel files. The following illustrates the changes to the Register Table syntax that support this new feature.

```
Register Table source_file
Type "XLS" [ Titles ] [ Range range_name ] [Interactive]
```


## Set Cartographic Legend Statement

The Set Cartographic Legend statement now allows you to control the sample legend sizes that appear in Cartographic Legend windows.

**Purpose**

The Set Cartographic Legend statement allows you to set redraw functionality on or off, refresh, set the orientation to portrait or landscape, select small or large sample legend sizes, or change the frame order of an existing cartographic legend.

**Syntax**

The change from the previous syntax is indicated in **bold**.

```
Set Cartographic Legend
[ Window legend_window_id ]
[ Refresh ]
[ Portrait | Landscape ]
[ Align]
[ Style Size {Small | Large}]
[ Frame Order { frame_id, frame_id, frame_id, ... } ]
```


## Shade Statement

The MapBasic Shade statement now allows for circle/square dot density thematics with user-defined size.
Purpose

Creates a thematic map layer and adds it to an existing Map window.

Syntax

The MapBasic Shade statement now allows for circle/square dot density thematics with user defined size. The following illustrates the changes to the Density and Width parts of the MapBasic syntax that support this new feature.

```mapbasic
Shade[ Window window_id ]
   { layer_id | layer_name }
   With expr
   Density dot_value {Circle | Square}
   Width dot_size
   [ Color color ]
```

The full syntax is described in the MapBasic Reference Guide, Version 7.8. For backwards compatibility, the older MapBasic syntax (version 7.5 or earlier) is still supported.

Description

For **Circle** dot style, the `dot_size` can be 2 to 25 pixels in width. For **Square** dot style, the `dot_size` can be 1 to 25 pixels.

The keyword **Width** is followed by `dot_size`. This specifies how large the dots should be, in terms of pixels.

The optional **Color** clause is used to set the color of the dots.

Example

The following example creates a dot density map using the States table’s Num_HH_90 column (which in this case indicates the number of households per state, circa 1990). The resultant dot density map will show many 4-pixel dots; each dot representing 60,000 households.

```mapbasic
shade window 176942288 7 with Pop_1990 density 600000 circle width 4 color 255
```

**TableInfo()**

The MapBasic TableInfo() variable includes a new value for the TAB_INFO_TYPE attribute to support Web Feature Service (WFS).

Purpose

Returns information about an open table.

Syntax

```mapbasic
TableInfo( table_id , attribute )
```

The new return value for the TAB_INFO_TYPE attribute is:

```
TAB_TYPE_WFS
```

This return value indicates that the table is from a Web Feature Service.

Affine Transformation
The mathematical calculation required to align two vector maps that use different coordinate systems.

Alias
The name assigned to an expression or a column when you are working in the Select Columns field in the SQL Select dialog box. This name appears as the column title for that expression or column in a Browser.

Application
A computer program used for a particular kind of work, such as word processing. Application is often interchangeable with the word program.

ASCII
The acronym for American Standard Code for Information Interchange. ASCII is a standard code used in most microcomputers, computer terminals, and printers for representing characters as numbers. It not only includes printable characters, but also control codes to indicate carriage return, backspace, and so forth.

Axis
Used in a graph, these are graduated lines bordering the plot area of a graph. Location coordinates are measured relative to the axes. By convention the X-axis is horizontal, the Y-axis is vertical.

Bar Chart Map
A type of thematic map that displays a bar chart of thematic variables for each record in a table from which the map is based.
**Base Map**
Usually the dominant or underlying layer in a given map. *(These are typically the data layers that MapInfo® offers as ready products.)* Users usually layer their own data on top of these base maps or use these base maps to geocode or to make new layers. Examples are joining industry data to postal code boundaries for analysis and then combining arrangements of the postal codes into new territory layers.

**Base Table**
A permanent table, which is part of a map, as opposed to a query table, which is temporary. You can edit the contents of base tables, and you can change their structure (by editing, deleting, reordering columns and adding or deleting graphic objects). See *Query Table on page 210.*

**Bitmap**
A screen image displayed as an array of dots or bits. Software usually generates either bit-mapped (raster) or object-oriented (vectored) files. MapInfo can work with both.

**Boundary Region**
In GIS a boundary is a region on a map enclosed by a border. Cambria County, Manitoba, and Argentina would all be represented as boundaries on a map. Note that a single boundary could encompass several polygons. Thus, Indonesia is a single boundary but consists of many polygons.

**Browser**
A window for viewing a table (or database, spreadsheet or text file) in tabular form.

**Buffer**
A type of proximity analysis where areas or zones of a given distance are generated around selected map objects. Buffers are user-defined or can be generated for a set of objects based on those objects’ attribute values. The resulting buffer zones form region objects representing the area that is within the specified buffer distance from the object.

**Cadastral**
A map set used to graphically define the cadastre or land ownership in a given area. A tax map is an example of a cadastral map. The land registration, assessment roles, and tax maps comprise the cadastre.

**Cartesian**
A coordinate system using an x,y scale not tied to any “real-world” system. Most CAD drawing uses this method of registering objects (e.g., a drawing of a ball-bearing assembly, floor plans). If a drawing uses Cartesian coordinates, one corner of the drawing probably has coordinates 0, 0.

**Cartesian Coordinates**
The conventional representation of geometric objects by x and y values on a plane.
Cartographic Legend
A MapInfo legend window that enables you to display cartographic information for any map layer in the Map window.

Cartography
The art and science of making maps. In GIS it is also the graphic presentation and visual interpretation of data.

Centroid
Usually the center of a map object. For most map objects, the centroid is located at the middle of the object (the location halfway between the northern and southern extents and halfway between the eastern and western extents of the object). In some cases, the centroid is not at the middle point because there is a restriction that the centroid must be located on the object itself. Thus, in the case of a crescent-shaped region object, the middle point of the object may actually lie outside the limits of the region; however, the centroid is always within the limits of the region.

In MapInfo, the centroid represents the location used for automatic labeling, geocoding, and placement of thematic pie and bar charts. If you edit a map in Reshape mode, you can reposition region centroids by dragging them.

Check Box
A small square box that appears in a dialog box. You can click in the check box or on the text in order to select the option. Check boxes are generally present when multiple options can be selected at one time.

Command
A word or phrase, usually found in a menu, that displays a dialog box and/or carries out an action.

Conflict Resolution
When conflicts exist between the data residing on a remote database and new data that you want to upload to the remote database via a MapInfo linked table. The conflict resolution process is invoked whenever an attempt to save the linked table detects a conflict in an update.

Control Points
The points on a raster image whose coordinates serve as a reference for associating earth coordinates with any location on the image. See Registration on page 211.

Coordinate
An x,y location in a Cartesian coordinate system, or a Latitude, Longitude location in an earth coordinate system. Coordinates represent locations on a map relative to other locations. Earth coordinate systems may use the equator and the Greenwich prime meridian as fixed reference points. Plane coordinate systems describe a two-dimensional x,y location in terms of distance from a fixed reference and are usually in the first quadrant so that all coordinates are positive numbers.
Coordinate System
A coordinate system is used to create a numerical representation of geometric objects. Each point in a geometric object is represented by a pair of numbers. Those numbers are the coordinates for that point. In cartography, coordinate systems are closely related to projections. You create a coordinate system by supplying specific values for the parameters of a projection. See Cartesian Coordinates on page 201, Projection on page 210, and Spherical Coordinates on page 211.

Cosmetic Layer
The topmost layer of a Map window. Objects may be placed in this layer such as map titles and graphic objects. It is always displayed, and all objects placed in the Cosmetic Layer must be saved to a new or existing layer.

Data Aggregation
A process that occurs when combining separate map objects into a single object. MapInfo calculates what the column values for the new object should be, based on sums or averages of the values of the original objects.

Data Disaggregation
A process that occurs when splitting a map object(s) into smaller parts where MapInfo splits the data associated with the map object(s) into smaller parts to match the new map objects.

Data Sources
An ODBC data source is an SQL database and the information you need to access that database. For example, an SQL Server data source is the SQL Server database, the server on which it resides, and the network used to access that server.

Database
Any organized collection of data. The term is often used to refer to a single file or table of information in MapInfo.

Decimal Degree
The decimal representation of fractions of degrees. Many paper maps express coordinates in degrees, minutes, seconds (e.g., 40_30/10!), where minutes and seconds are fractions of degrees. 30 minutes equal half a degree, and 30 seconds equal half a minute. MapInfo, however, expresses coordinates in decimal degrees (e.g., 72.558 degrees), where fractions of degrees are expressed as decimals. Thus, the longitude: 40 degrees, 30 minutes, would be expressed in MapInfo as 40.5 degrees.

Default
The value or option used in the absence of explicit specification. Often the original setting or value for a variable.
Degrees Longitude, Degrees Latitude, Decimal Degrees
Degrees (longitude and latitude) are coordinates used to represent locations on the surface of the earth. Longitude, or X-coordinate, represents a location’s east-west position, where any location west of the prime meridian has a negative X value. Latitude, or Y-coordinate, represents a location’s north-south position, where any location south of the equator has a negative Y value.

Derived Column
In a table created through the SQL Select, a derived column is one created by using an expression. The column is derived in the sense that it isn’t just a copy of the data in one of the tables being accessed by the SQL Select command.

Derived Field
The same as a derived column.

Deselect
The process of undoing a selection. The object or area you deselect will not be affected by subsequent commands. Performed by selecting another area, by clicking in a blank area, or by executing the Unselect All command.

Digitizer, Digitizing Tablet
An electronic device that lets you trace a paper map into a GIS or CAD package. The digitizer consists of a table (or tablet) onto which you attach a paper map. You then can trace the map by moving a hand-held, mouse-like device known as a cursor, or puck, across the surface. Digitizing a map produces vector data as the end result.

Districts Browser
A special browser that displays when redistricting. It differs from other Browser windows in the following respects: one row can only be selected at one time, one row is always selected, and the selected row becomes the target district into which you can add other objects.

Dot Density Map
A type of thematic map that carries information by showing a large number of tiny dots, wherein each dot represents some specific unit quantity. For example, for a population dot density map each dot might represent 10,000 people.

Drawing Toolbar
A MapInfo window containing twelve buttons that access tools for drawing and modifying objects on your map or layout.

Edit Handle
The small boxes that appear at the four corners of the minimum bounding rectangle of an object in an editable layer of a Map window or in a Layout window.

Export
The process whereby a program saves information in a file to be used by another program.
Expression
A statement containing two parts: 1) column names and constants (i.e., specific data values), and 2) functions (e.g., area) and operators (e.g., +, -, >), in order to extract or derive information from a database. Expressions are used in Select, SQL Select, Update Column, Create Thematic Map, and Label with Column.

Field
A field in a table corresponds to a column in a Browser. A field contains a specific type of information about an object, such as, name, abbreviation, land area, price, population, and so forth. The record for each object consists of that object’s values for each of the fields in the database.

File
A collection of information that has been given a name and is stored on some electronic medium such as a tape or disk. A file can be a document or an application.

Fill Pattern
The design and color used to fill a closed object.

Font
A character set based on a particular style used for text characters.

Generalization
The process of simplifying a data set to a size that can be easily manipulated and represented. For example, a river may have many twists and turns; however, if a map covers a very large area, the river may be represented as a straight line. Similarly, in a map of a very large area, a city might be represented as a point marker.

Geocode
The process of assigning X and Y coordinates to records in a table or database so that the records can be displayed as objects on a map.

Geographic Information System (GIS)
An organized collection of computer hardware and software designed to efficiently create, manipulate, analyze, and display all types of geographically or spatially referenced data. A GIS allows complex spatial operations that are very difficult to do otherwise.

Graduated Symbols Map
A type of thematic map that shows symbols (point objects) in a variety of sizes to indicate which objects have higher or lower numerical values.

Graph window
A window that displays numerical data in the form of a graph.
Graticule
A grid of horizontal (latitude) and vertical (longitude) lines displayed on an earth map, spaced at a regular distance (e.g., every five degrees, every fifteen degrees). Used to establish a frame of reference.

Grid Surface Map
A type of thematic map that displays data as continuous color gradations across the map. This type of thematic map is produced by an interpolation of point data from the source table. A grid file from the data interpolation is generated and displays as a raster image in a Map window.

Heads-Up Digitizing
A method of digitizing where the user creates vector objects by tracing over a raster image displayed on the screen. Thus, heads-up digitizing does not require a digitizing tablet.

Help Button Bar
A bar located at the top of the Help Window that contains buttons you use to move to Help topics.

Hot Views
MapInfo technology that automatically updates all the windows you have open for a particular table when you make a change in any one of the windows. For example, if an item is selected in a Map window, it will be selected in all other Map windows and Browsers you have open for that table.

Import
The process whereby a program loads a file that is the output of another program.

Individual Values Map
A type of thematic map that shades records according to individual values.

Join
The process of creating a relational link between two tables (databases).

Jump
Text graphics or parts of graphics that provide links to other Help topics or more information on the current Help topic.

Latitude
The horizontal lines on a map that increase from 0 degrees at the Equator to 90 degrees at both the North (+90.0 degrees) and South (-90.0 degrees) poles. Used to describe the North-South position of a point as measured usually in degrees or decimal degrees above or below the equator.
Layer
A layer is a basic building block of MapInfo maps and consists of a table with graphic and text settings like style override, labeling, and zoom layering. Maps are made of one or more superimposed layers (e.g., a layer of street data superimposed over a layer of county or postal code boundaries) which you can design to convey geographical or statistical information. Typically, each map layer corresponds to one open table. Cosmetic Layers contain map objects that represent temporary map annotations (e.g., text objects). Cosmetic Layers contain map objects that represent temporary map annotations (e.g., labels). See Cosmetic Layer on page 203 and Table on page 212.

Layout Window
A window where you arrange and annotate the contents of one or several windows for printing.

Legend Window
A window that displays the key to the different colors, shapes, or fill patterns used on the map. A legend can also include a scale. See Cartographic Legend on page 202 and Theme Legend on page 213.

Line, Line Object
A map object defined by a set of sequential coordinates that may represent the generalized shape of a geographic feature (e.g., street centerlines, railroads, cables). A MapInfo street map is a collection of thousands of line objects.

Linked Table
A linked table is a special kind of MapInfo table that is downloaded from a remote database and retains connections to its remote database table. You can perform most operations on a linked table that you do for a regular MapInfo table.

Longitude
The vertical lines on a map, running from the North to South poles, used to describe the east-west position of a point. The position is reported as the number of degrees east (to -180.0 degrees) or west (to +180.0 degrees) of the prime meridian (0 degrees). Lines of longitude are farthest apart at the Equator and intersect at both poles, and therefore, are not parallel.

Longitude/Latitude
MapInfo’s default coordinate system for representing geographic objects in a map.

Main Toolbar
A window containing buttons for choosing tools, accessing dialog boxes, and showing or hiding windows.

Map Scale
A statement of a measure of the map and the equivalent measure on the earth. Often expressed as a representative ratio of distance, such as 1:10,000. This means that one unit of distance on the map (e.g., one inch) represents 10,000 of the same units of distance on the earth.
The term *scale* must be used carefully. Technically, a map of a single city block is *large-scale* (e.g., 1:12,000), while a map of an entire country is *small-scale* (e.g., 1:1,000,000). A 1:1,000,000 map is considered small-scale because of the small numeric value obtained when you divide 1 by 1,000,000.

**Map Segment**
In a street map, a segment is a single section of the street. In urban maps, segments are generally one block long. Address ranges are stored at the segment level.

**MapBasic**
The programming language used to customize and/or automate MapInfo. To create MapBasic applications, you need the MapBasic compiler, which is a separate product. However, you do not need the MapBasic compiler to run a compiled MapBasic application.

**Map window**
A window that allows you to view a table as a map.

**Meridian**
A line or a portion of a line running from the North to the South pole. A longitudinal line.

**Minimum Bounding Rectangle (MBR)**
For any given map object, the smallest rectangle that completely encompasses the object.

**Native Projection**
The projection in which a map’s coordinate points are stored. MapInfo allows you to display maps in other projections, but not as fast as displaying maps in their native projection.

**Node**
An end-point of a line object, or an end-point of a line segment which is part of a polyline or region object.

**Non-Earth Map**
A map in which objects are not explicitly referenced to locations on the earth’s surface. Floor plans are typical examples.

**ODBC Drivers**
An ODBC driver is a dynamic-link library (.DLL) file that MapInfo uses to connect to an SQL database. Each type of SQL database requires a different ODBC driver.

**ODBC Table**
An ODBC table is a table residing in a remote SQL database.

**Outer Join**
A type of multi-table join where all the records in the specified tables are included in the result table, even records that do not match the join criteria. MapInfo does not perform outer joins.
Pack
The process of compressing MapInfo tables so that they use less disk space.

Pie Chart Map
A type of thematic map that displays a pie chart of thematic variables for each record in the table from which the map is based.

Pin Map, Push-Pin Map
A type of map named after the practice of inserting push-pins into a wall map. A pin map features point objects. Geocoding a database is one way of creating a pin map.

Pixel
The acronym for picture element. The smallest dot that can be displayed on a computer screen. If a screen is described as having a resolution of 1,024 x 768, the screen shows 1,024 pixels from right to left, and 768 pixels from top to bottom. Each character, object, or line on the screen is composed of numerous pixels.

Point, Point Object
A map object defined by a single X,Y coordinate pair. Each point object is represented by a symbol style (e.g., circle, square, triangle, etc.).

Point Size
A unit of measurement equal to 1/72 of an inch. Used to measure character size.

Pointer
An arrow-shaped cursor on the screen that can be manipulated by a mouse.

Polygon, Polygon Object
A simple bounded region, simple in the sense that it does not consist of more than one polygon (where a boundary can consist of more than one polygon). The Polygon tool creates a single polygon.

Polygon Overlay
A spatial operation that merges overlapping polygons from two layers to analyze those intersected areas or to create a third layer of new polygons.

Polyline, Polyline Object
A linetype object made up of many line segments. It contains more than two nodes, that is, more than its end points. The Polyline tool creates a single polyline. In contrast, the Line tool only draws a single straight line (that is, a line defined by two nodes).
Projection
A mathematical model that transforms the locations of features on the earth’s surface to locations on a two-dimensional surface, such as a paper map. Since a map is an attempt to represent a spherical object (the earth) on a flat surface, all projections have some degree of distortion. A map projection can preserve area, distance, shape or direction but only a globe can preserve all of these attributes. Some projections (e.g., Mercator) produce maps well suited for navigation. Other projections (e.g., equal-area projections, such as Lambert) produce maps well suited for visual analysis.

Query Table
A temporary table produced as the result of a Select, SQL Query, or by choosing objects in a Map window or records in a Browser and mapping, graphing, or browsing that selection. You cannot make edits and structural changes on query tables, but you can edit a selected set of rows in your source table through a query table. See Selection on page 211 and Base Table on page 201.

Ranged Map
A type of thematic map that displays data according to ranges set by the user. The ranges are shaded using colors or patterns.

Raster Image
A type of computerized picture consisting of row after row of tiny dots (pixels). Raster images are sometimes known as bitmaps. Aerial photographs and satellite imagery are common types of raster data found in GIS. A computer image can be represented in raster format or in vector format. See Scanning on page 211 and Vector Image on page 214.

Record
All the information about one object in a database or table. A record in a table corresponds to a row in a Browser.

Redistricting
The process of assigning map objects to groups. As you assign map objects, MapInfo automatically calculates totals for each group and displays the totals in a special Districts Browser. This process is sometimes known as load-balancing.

Region, Region Object
An enclosed area defined by one or more polygons. If a region contains one or more lakes or islands, each lake or island is a separate polygon. A region is an object created with the Polygon tool.
Registration
Usually the first stage of the digitizing process or when opening a raster image for the first time in MapInfo. Before you can digitize a paper map or work with a raster image, you must point to several control points across the map, and enter their coordinates (e.g., longitude, latitude). After you have registered the map, MapInfo can associate a longitude, latitude position with any point on the map surface; this allows MapInfo to perform area and distance calculations, and overlay multiple map layers in a single map. CAD systems as well as GIS systems utilize this process. See Control Points on page 202.

Scale Bar
A map element that graphically depicts the map scale (e.g., 0 —— 5 —— 10 km).

Scanning
The process of inputting data into a raster format using an optical device called a scanner.

Scroll Bar
Bars along the right and bottom sides of each window that allow you to scroll the window view. Clicking on the shaded area moves one window screen at a time.

Selection
A data item or set of data items chosen for inspection and/or analysis. Regardless of the kinds of windows on the screen, selections can be made using the Select and SQL Select Query commands in MapInfo’s Query menu. In Browsers and Map windows, items can be placed in the selection set by clicking on them individually. Map windows also have special tools for selecting multiple items on a spatial basis.

Snap To Nodes
A feature that helps in drawing, moving and positioning map objects. In Snap mode (S key) the cursor snaps to a node of a map object when it comes within a certain distance.

Spatial Analysis
An operation that examines data with the intent to extract or create new data that fulfills some required condition or conditions. It includes such GIS functions as polygon overlay or buffer generation and the concepts of contains, intersects, within or adjacent.

Spherical Coordinates
Latitude and longitude values that represent objects on the surface of the globe.

SQL Query
The selection of information from a database according to the textual attributes and object relationships of the items. In MapInfo, queries are created with the SQL Select and Select commands or with MapBasic commands in the MapBasic window.

Standard Deviation
A measurement of the variation of a set of data values around the mean.
**Standard Toolbar**
A window containing buttons for quick access to the most commonly used menu commands such as Cut, Copy, and Paste.

**Statistics Window**
A window containing the sum and average of all numeric fields for the currently selected objects/records. The number of records selected is also displayed. As the selection changes, the data is re-tallied, and the statistics window updates automatically.

**StatusBar**
A bar at the bottom of the screen that displays messages that help in using MapInfo. The StatusBar also displays messages that pertain to the active window. In a Map window, the StatusBar indicates what layer is editable, the zoom display of the map, and the status of Snap and Digitizing modes. In a Browser window, the StatusBar indicates the number of records currently displaying and the total number of records. In a Layout window, the StatusBar indicates the zoom display as a percentage of the actual size of the map.

**Structured Query Language (SQL)**
A standard language used for analyzing information stored in relational databases. MapInfo’s database engine is based on the SQL standard.

**Subselect**
A select statement that is placed inside the Where Condition field of the SQL Select dialog box. MapInfo first evaluates the subselect and then uses the results of the subselect to evaluate the main SQL Select statement.

**Symbol, Symbol Object**
A small, relatively simple shape (e.g., square, circle, star, push-pin) used to graphically represent a point object (e.g., a customer location).

**Table**
A table is made up of data in rows and columns. Each row contains information about a particular geographic feature, event, etc. Each column contains a particular kind of information about the items in the table. You can display tables with graphic information stored in them as maps. See Base Table on page 201 and Query Table on page 210. See also Layer on page 207.

**Table Row**
In a table, a row contains all the information for a single item. It corresponds to a record in a table.

**Target District**
The district that is selected in a Districts Browser to be affected by subsequent redistricting operations.

**Text Cursor**
A blinking vertical bar that shows the position where text can be edited, inserted, or deleted.
Thematic Layer
A layer containing the thematic settings for a map layer. Thematic layers are drawn directly over the map layer on which the thematic settings are based. They are also drawn in a particular order, depending on the number of thematic layers you have and the type of thematic map objects you are creating.

Thematic Map
A type of map that uses a variety of graphic styles (e.g., colors or fill patterns) to graphically display information about the map's underlying data. Thus, a thematic map of sales territories might show one region in deep red (to indicate the region has a large number of customers), while showing another region in very pale red (to indicate the region has relatively few customers).

Thematic Shading
Map objects — points, lines, regions — that have been shaded, using a pattern and/or color, according to some point of information about the object, or theme (population, size, annual rainfall, date, and so forth).

Thematic Variable
The data values displayed on a thematic map. A thematic variable can be a field or expression.

Theme Legend
MapInfo's original style legend that allows you to display legends for thematic maps and graphs. MapInfo automatically creates a theme legend window for a thematic map. Customize its display through the Modify Thematic Map dialog box. See Cartographic Legend on page 202.

Toolbars
MapInfo windows that contain a variety of buttons used to access tools and commands for mapping and drawing. There are four Toolbars: the Standard Toolbar provides tools for commonly performed tasks, the Main Toolbar provides primary tools (e.g., Zoom-in, Select, Info, etc.) and the Drawing Toolbar contains all drawing tools. The Tools Toolbar contains the Run MapBasic Program and the Show/Hide MapBasic Window buttons. All four Toolbars may be reshaped and hidden.

Transformation
The process of converting coverage coordinates from one coordinate system to another through programmatic translation. The transformation of CAD generated Cartesian coordinates into earth coordinates is an example.

Ungeocode
The process of removing X and Y coordinates from records in a table or database. Can also describe a table that has not been geocoded, e.g., an ungeocoded table.
**Vector Image**
A coordinate-based data structure commonly used to represent map features. Each object is represented as a list of sequential x,y coordinates. Attributes may be associated with the objects. A computer image can be represented in vector format or in raster format. See [Raster Image](#) on page 210.

**Web Feature Service**
a Web Feature Service (WFS) client that can retrieve geo-spatial GML (Geography Markup Language)2 data and HTTP GET and HTTP POST requests over the Internet or through a private intranet. WFS was developed in accordance with the 1.0.0 OpenGIS® Web Feature Service Implementation Specification. This feature was added with MapInfo Professional version 7.8.

**Web Map Service**
Web Map Service (WMS) is a technology that gives you a source for data over your Intranet or over the Internet. This innovation is based on a specification from the Open GIS Consortium (OGC) and allows you to use raster map images from servers that also comply with the specification. This feature was added with MapInfo Professional version 7.5.

**Weighted Average**
An average that gives more weight to one value over another when averaging. A method of averaging that uses a separate column of information to define the relative importance of each data value. The formula for a weighted average is:

\[
\frac{\text{SUM(DATA*WEIGHT)}}{\text{SUM(WEIGHT)}}
\]

where DATA is the column of data values and WEIGHT is the column of weights. If WEIGHT contains all 1’s (or other non-zero values) this reduces to a simple average.

**Window**
In MapInfo, Map windows, Browser windows, Graph windows and Layout windows are the major types of windows. They display the data stored in tables. The Toolbars, map legends, and the Info tool window are other types of windows.

**Workspace**
A saved configuration of open MapInfo tables and windows.

**Zoom Layering**
A setting that determines the range (e.g., 0–3 miles, 2–5 miles, etc.) at which a layer is visible in a Map window.
Index

Numerics
3D maps (7.5) I-35

A
add in changes
vertical mapper (7.5) I-62
add in enhancements
crystal reports (7.5) I-61
adding
odb drivers (7.5) I-15
odb drivers (7.8) II-102
advanced options and settings registry (7.8) II-106
affine transformation
defined II-200
description II-181
affine transformations
coordinate systems II-181–II-184
aliases
defined II-200
application data files
mode.ini (7.5) I-19
mode.ini (7.8) II-107
per-user install (7.5) I-12
per-user install (7.8) II-99
specifying installation location (7.8) II-106
arrow keys
positioning selected objects (7.5) I-41
ASCII
defined II-200
autoscroll
using microsoft intellimouse (7.5) I-22
using microsoft intellimouse (7.8) II-110
axis
defined II-200
Azimuthal projections
range II-175

B
bar chart maps II-200
base maps
defined II-201
base tables
defined II-201
bitmaps
defined II-201
boundaries
boundary region defined II-201
Browser windows
defined II-201
buffer regions
creating (7.5) I-56
defined II-201
saving as new layer (7.5) I-56
saving as new table (7.5) I-56–I-58
saving to a new table (7.5) I-56
saving to an existing table (7.5) I-58
C
cadastral
defined II-201
Cartesian coordinates
defined II-201
cartographic legends
defined II-202
sample size preference II-132
cartography
defined II-202
centroids
defined II-202
selecting using snap mode (7.5) I-46
colors
custom symbols (7.5) I-51
conflict resolution
defined II-202
Conic projections II-175
control points
defined II-202
coordinate systems
creating ??–II-180
defined II-203
documentation upgrade (7.8) II-149
elements of II-157, II-181
entering a new projection for II-180
euref89 added and reordered (7.8) II-136
israeli additions (7.8) II-136
more information on II-185
origin point II-174
parameters of II-162
projections II-165
RGF93 added (7.8) II-135
RT90 added (7.8) II-136
SWEREF 99 added (7.8) II-136
using a new projection in II-179
coordinates
defined II-202
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>register the _ of a raster (7.5)</td>
<td>I-29</td>
</tr>
<tr>
<td>transferring vector map _ directly to a raster map (7.5)</td>
<td>I-31</td>
</tr>
<tr>
<td>copying objects to clipboard (7.5)</td>
<td>I-44</td>
</tr>
<tr>
<td>Cosmetic layer defined</td>
<td>II-203</td>
</tr>
<tr>
<td>create points changes (7.5)</td>
<td>I-31</td>
</tr>
<tr>
<td>creating .tab files from other data tables (7.5)</td>
<td>I-34</td>
</tr>
<tr>
<td>creating points placing longitude/latitude coordinates on a map (7.5)</td>
<td>I-32</td>
</tr>
<tr>
<td>crystal reports installing user guide 7.5</td>
<td>I-23</td>
</tr>
<tr>
<td>installing user’s guide (7.8)</td>
<td>II-111</td>
</tr>
<tr>
<td>custom symbols defined</td>
<td>II-189</td>
</tr>
<tr>
<td>enhanced</td>
<td>II-132</td>
</tr>
<tr>
<td>high resolution (24-bit color)</td>
<td>II-187</td>
</tr>
<tr>
<td>new</td>
<td>II-177</td>
</tr>
<tr>
<td>understanding (7.5)</td>
<td>I-51</td>
</tr>
<tr>
<td>working with (7.5)</td>
<td>I-49</td>
</tr>
<tr>
<td>custom symbols (7.5)</td>
<td>I-49–I-52</td>
</tr>
<tr>
<td>custom workstation installation (7.5)</td>
<td>I-14</td>
</tr>
<tr>
<td>custom workstation installation (7.8)</td>
<td>II-100</td>
</tr>
<tr>
<td>data obtaining (7.5)</td>
<td>I-21</td>
</tr>
<tr>
<td>obtaining (7.8)</td>
<td>II-108</td>
</tr>
<tr>
<td>sample data changes (7.8)</td>
<td>II-135</td>
</tr>
<tr>
<td>data aggregation defined</td>
<td>II-203</td>
</tr>
<tr>
<td>data disaggregation defined</td>
<td>II-203</td>
</tr>
<tr>
<td>data sources defined</td>
<td>II-203</td>
</tr>
<tr>
<td>databases connectivty</td>
<td>I-11</td>
</tr>
<tr>
<td>connectivity (7.8)</td>
<td>II-97</td>
</tr>
<tr>
<td>defined II-203</td>
<td></td>
</tr>
<tr>
<td>datum changes JGD conversion changes (7.5)</td>
<td>I-40</td>
</tr>
<tr>
<td>KKJ projection algorithm (7.5)</td>
<td>I-40</td>
</tr>
<tr>
<td>datum changes (7.5)</td>
<td>I-40</td>
</tr>
<tr>
<td>datums MAPINFO.W.PRJ ID numbers II-166–II-173</td>
<td></td>
</tr>
<tr>
<td>decimal degrees defined</td>
<td>II-203</td>
</tr>
<tr>
<td>default defined</td>
<td>II-203</td>
</tr>
<tr>
<td>degrees latitude defined</td>
<td>II-204</td>
</tr>
<tr>
<td>degrees longitude defined</td>
<td>II-204</td>
</tr>
<tr>
<td>derived columns defined</td>
<td>II-204</td>
</tr>
<tr>
<td>digitizing defined</td>
<td>II-204</td>
</tr>
<tr>
<td>digitizing tablet defined</td>
<td>II-204</td>
</tr>
<tr>
<td>districts browser defined</td>
<td>II-204</td>
</tr>
<tr>
<td>dmbs making a dbms table mappable</td>
<td>I-55</td>
</tr>
<tr>
<td>document panning using microsoft intellimouse (7.8)</td>
<td>II-110</td>
</tr>
<tr>
<td>document scrolling using microsoft intellimouse (7.8)</td>
<td>II-110</td>
</tr>
<tr>
<td>dot density more choices for thematic maps (7.8)</td>
<td>II-130</td>
</tr>
<tr>
<td>dot density maps defined</td>
<td>II-204</td>
</tr>
<tr>
<td>drawing objects on a map custom symbols (7.5)</td>
<td>I-49–I-52</td>
</tr>
<tr>
<td>Drawing toolbar defined</td>
<td>II-204</td>
</tr>
<tr>
<td>Excel files default range options</td>
<td>II-138</td>
</tr>
<tr>
<td>specifying column properties</td>
<td>II-139</td>
</tr>
<tr>
<td>exporting files defined</td>
<td>II-204</td>
</tr>
<tr>
<td>output preferences (7.5)</td>
<td>II-39</td>
</tr>
<tr>
<td>expressions defined</td>
<td>II-205</td>
</tr>
<tr>
<td>false easting description</td>
<td>II-175</td>
</tr>
<tr>
<td>false northing description</td>
<td>II-175</td>
</tr>
<tr>
<td>fields defined</td>
<td>II-205</td>
</tr>
<tr>
<td>files defined</td>
<td>II-205</td>
</tr>
<tr>
<td>fill patterns defined</td>
<td>II-205</td>
</tr>
</tbody>
</table>
### G

- **generalization**  
  - defined II-205
- **geocoding**  
  - defined II-205
- **Geographic Information System (GIS)**  
  - defined II-205
- **geotracker upgrade (7.8)** II-149  
- **getfeatureinfo support (7.8)** II-124

### GML

- **importing into .tab files** (7.5) I-33  
- **support** (7.5) I-33
- **understanding the use of the topography layer** (7.5) I-35

### gml files

- **importing** (7.5) I-33–I-34
- **defined** II-205

### Graph windows

- defined II-205

### graticule

- defined II-206

### grid image files

- **display settings** (7.5) I-37
- **defined** II-206

### grid surface maps

- **defined** II-206

### H

- **heads-up digitizing** II-206
- **Help button bar**  
  - defined II-206
- **hot views**  
  - defined II-206
- **Hotine Oblique Mercator projection**  
  - defined II-206
- **HotLinks**  
  - querying (7.5) I-85  
  - querying (7.8) II-196

### I

- **importing files**  
  - defined II-206
- **web map service (wms) data** (7.5) I-25–I-28
- **individual values maps**  
  - defined II-206
- **installation**  
  - 7.8 data II-108
  - application data files (7.5) I-12, I-18
- **application data files (7.8)** II-106
  - **custom** (7.5) I-14
  - **custom workstation** (7.5) I-14
  - **custom workstation (7.8)** II-100
  - **data** (7.5) I-20
  - **ecw compressor** (7.5) I-21
  - **ecw compressor (7.8)** II-109
  - **global positioning software (gps)** (7.5) I-22
  - **global positioning software (gps)** (7.8) II-110
  - **metadata browser** (7.5) I-21
  - **metadata browser (7.8)** II-109
  - **modifying mapinfow.prf** for 7.0 directories (7.5) I-12
  - **modifying mapinfow.prf** for 7.8 directories II-98
  - **navigating the 7.5 cd** I-12
  - **network** (7.5) I-15
  - **network** (7.8) II-102
  - **online references** (7.5) I-23
  - **online references** (7.8) II-111
  - **per-user installs** (7.8) II-99
  - **preparatory tasks** (7.5) I-11
  - **procedure** (7.5) I-12
  - **procedure** (7.8) II-98
  - **running from drive** (7.5) I-23
  - **running from the C drive** (7.8) II-111
  - **setting the temp variable** (7.5) I-23
  - **setting up clients** (7.5) I-16
  - **setting up clients** (7.8) II-103
  - **troubleshooting** (7.5) I-23
  - **troubleshooting** (7.8) II-111
  - **typical workstation** (7.5) I-13
  - **typical workstation** (7.8) II-99

### installing

- **navigating the mi pro 7.8 cd** II-98

### J

- **joining tables**  
  - join definition II-206
- **jumps**  
  - defined II-206

### L

- **lambert azimuthal projection map**  
  - example of II-161
- **latitude**  
  - defined II-206
- **LayerInfo( ) function** (7.5) I-85
- **LayerInfo( ) function** (7.8) II-196
- **Layers**  
  - reading settings (7.5) I-85
  - reading settings (7.8) II-196
- **layers**  
  - creating buffer (7.5) I-56
  - **defined** II-207
  - **voronoi polygon** (7.5) I-59
- **layout windows**  
  - creating (7.5) I-47
  - **defined** II-207
  - **frames** (7.5) I-47
legend windows  defined II-207
line objects  defined II-207
Linked tables  determining if table is linked (7.5) I-93
linked tables  defined II-207
longitude  defined II-207
longitude/latitude coordinates  creating points on a map (7.5) I-32
longitude/latitude projection map example of II-158
M
Main toolbar  defined II-207
map  transferring vector coordinates directly to a raster (7.5) I-31
map scale  defined II-207
map segment  defined II-208
Map windows  defined II-208
reading layer settings (7.5) I-85
reading layer settings (7.8) II-196
mapbasic  cartographic legend sample size change (7.8) II-153
excel column import II-153
excel csv export support (7.8) II-153
mtrs conversion functions II-151
polyline split at node (7.8) II-152
printwin change (7.8) II-152
running the tutorial (7.8) II-154
wfs support (7.8) II-151
MapBasic language  defined II-208
MapInfo  I-12
MapInfo Professional 7.5
accessing web map services I-25
adding odbc drivers I-61
advanced options and settings I-17
advanced options and settings registry I-18
application data files I-18
cd browser I-12
clearing default workspace name after close all I-40
cogoline tool (7.5) I-63
create points changes I-31
creating layouts I-47
custom symbols I-49
custom symbols, enhancements I-48
database changes I-39
datum enhancements I-39-I-40
drawing frames in layouts I-47
easyloader changes I-65
Excel file changes I-39
fill patterns I-36
gml support I-33
improved resolution for 3D and prism maps I-35
improving performance I-18
increase memory size and resolution preference I-43
installation procedure I-12
installing reference materials I-23
line snap tool enhancement I-64
major features I-25
making a dbms table mappable I-55
mapbasic changes I-65
mapping changes I-40
zooming, panning, moving I-45
mapping changes, custom symbol changes I-48
mapping changes, data disaggregation I-53
mapping changes, dot density theme enhancements I-54
mapping changes, large crosshairs I-48
mapping changes, moving objects I-40
mapping changes, object rotation I-52
mapping changes, saving a buffer as a table I-56
mapping changes, saving voronoi polygons to a new table I-58
mapping changes, setting and printing map scale (layout window) I-47
mapping changes, setting bounds in make table mappable I-54
mapping changes, zoom layering I-46
menu changes I-62
new tools I-63
objects, clean gaps I-54
objects, positioning and sizing I-41
objects, rotation I-52
opening, web map service (wms) layers I-25
Oracle changes I-40
pattern scaling I-39
printing changes I-36
printing enhancements I-36
printing guide I-36
program maintenance I-16
raster registration enhancements I-28
register vector tool I-63
registering the coordinates of a raster I-29
removing from your system I-16
setting defaults for printing I-38
specifying installation location I-18
toc utility enhanced I-64
tool changes I-63
web map service I-25
window manager enhanced I-64
wms, displaying and importing data I-25
workspace packager I-64

MapInfo Professional 7.8
3D changes II-135
adding odbc drivers II-102
advanced options and settings II-105
airphotousa conterminous coordinate system II-137
application data files II-98
australian coordinate system changes II-136
cartographic legend (MapBasic changes) II-153
cd browser II-98
cogoline enhancements II-147
danish coordinate system added and reordered II-136
distance calculator tool II-142
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
danish coordinate system added and reordered II-136
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
excel column import (MapBasic changes) II-153
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
dot density for thematic map (MapBasic changes) II-152
dot density choices II-130
improving performance II-106
installation procedure II-98
installing reference materials II-111
israeli coordinate system added II-136
legend window preferences II-133
line style editor enhanced II-150
major features II-113
mapx mobile
mapinfow.prj file
datum ID numbers II-166-II-173
editing II-178-II-180
projection ID numbers II-163-II-164
unit ID numbers II-174
mapping changes
offsetting objects (7.5) I-40
mastermap gml files
importing (7.5) I-33-I-34
mastermap topography layer (7.5) I-35
menu enhancements
window menu changes (7.5) I-62
meridian
defined II-208
metadata
metadata browser (7.5) I-21
metadata browser (7.8) II-109
microsoft intellimouse
using with 7.5 I-22
minimum bounding rectangle (MBR)
defined II-208
mode.ini file
application data files (7.5) I-19
application data files (7.8) II-107
N
native projections
defined II-208
network installation (7.5) I-15
network installation (7.8) II-102
nodes
defined II-208
selecting using snap mode (7.5) I-46
non-earth maps
defined II-208
O
object snap enhancement (7.8) II-196
objects
moving (7.5) I-41
offsetting (7.5) I-41
splitting polyline at node (7.8) II-140
understanding a default anchor point (7.5) I-53
objects, editing
  object offset (7.5) I-41–I-42
  positioning and sizing (7.5) I-41
  rotating (7.5) I-41, I-52–I-53
  set target model (7.5) I-53
  snap mode (7.5) I-46
Oblique azimuth II-175
odbc drivers, adding (7.5) I-15
ODBC tables
  defined II-208
offsetting map objects (7.5) I-41–I-42
online reference guides
  adobe acrobat reader (7.5) I-23
  adobe acrobat reader (7.8) II-111
  crystal reports (7.5) I-23
  crystal reports (7.8) II-111
  installing (7.5) I-23
  installing (7.8) II-111
opening
  web map service (wms) layers (7.5) I-25–I-28
outer joins
  defined II-208
output settings preferences
  specifying (7.5) I-37–I-38
P
packing a table
  defined II-209
panning
  using microsoft intellimouse (7.5) I-22
parameters
  projections ??–II-176
performance
  improving (7.5) I-18
per-user installs (7.8) II-99
pie chart maps
  defined II-209
pin maps
  defined II-209
pixels
  defined II-209
point objects
  defined II-209
point size
  defined II-209
pointer
  defined II-209
points
  creating from coordinates (7.5) I-32
polyconic coordinate systems II-175
Polyconic projection II-175–II-176
polyconic projection map
  example of II-160
polygon objects
  creating a voronoi (7.5) I-59–I-61
  defined II-209
polygon overlay
  defined II-209
region objects
  defined II-210
registering
  a raster image, projections (7.5) I-29
registering a raster image
  defined II-211
registry settings
  advanced (7.5) I-18
  advanced (7.8) II-106
  modifying (7.5) I-17
  modifying (7.8) II-105
removing
  7.5 I-16
  mapInfo professional 7.8 II-104
rotating
  map objects (7.5) I-52–I-53
  objects (7.5) I-41
S
s key
  snap mode (7.5) I-46
saving
  buffer regions to tables (7.5) I-56–I-58
  voronoi polygons (7.5) I-59–I-61
  workspace as an xml-based file (7.8) II-127
scale bar
  defined II-211
Scale factor
  Transverse Mercator projection II-175
scaling patterns (7.5) I-39
scanning
  defined II-211
scroll bars
  defined II-211
scrolling
  using microsoft intellimouse (7.5) I-22
search and replace
  updates multiple column entries (7.8) II-149
selections
  defined II-211
shapefiles (7.5) I-90
Shortcut
  Edit menu (7.5) I-67
  File menu (7.5) I-67
  Objects menu (7.5) I-68
  Tool menu (7.5) I-67
snap
  data saved in metadata (7.8) II-130
  new preference settings (7.8) II-130
snap mode
  selecting nodes and centroids (7.5) I-46
snap radius
  display preference II-130
snap to nodes
  defined II-211
snap tolerance
  map window preference II-130
spatial analysis
  defined II-211
spherical coordinates
  defined II-211
SQL Select command
  SQL Query defined II-211
standard deviation
  defined II-211
Standard parallels
  conic projections II-175
Statistics window
  defined II-212
status bar
  defined II-212
Structured Query Language (SQL)
  defined II-212
styles
  custom symbols (7.5) I-49
subselect
  defined II-212
symbol objects
  pre-version 4.0 (7.5) I-45
symbols
  custom (7.5) I-49–I-52
  defined II-212
system requirements
  7.5 I-11
system settings
  preferences (7.5) I-43–I-44
  setting advanced (7.5) I-17
T
Table names
  determining table name from number (7.5) I-92
  determining table name from number (7.8) II-197
table rows
  defined II-212
Table structure
  determining how many columns (7.5) I-92
  determining how many columns (7.8) II-197
TableInfo( ) function (7.5) I-92
TableInfo( ) function (7.8) II-197
tables
  defined II-212
  making a dbms _ mappable (7.5) I-55
tables, managing
  defined II-204, II-206
Tables, querying
  table information (7.5) I-92
  table information (7.8) II-197
tables, saving
  buffer regions as tables (7.5) I-56–I-58
target district
  defined II-212
text boxes, 256 character limit removed (7.8) II-130
text objects
  defined II-212
thematic layers
  defined II-213
thematic maps defined II-213
thematic maps, shading defined II-213
thematic maps, variables defined II-213
theme legends defined II-213
thin settings saved in metadata (7.8) II-130
toolbars defined II-213
tools adding new tools to tool manager II-139
cogoline (create line by length) enhancements (7.8) II-147
distance calculator II-142
grotracker upgrade (7.8) II-149
search and replace update (7.8) II-149
spider graph II-141
split polyline at node (7.8) II-140
synchronize windows II-146
universal translator log file (7.8) II-144
topography layer (7.5) I-35
transferring vector map coordinates directly to a raster map (7.5) I-31
transformation defined II-213
Transverse Mercator projection scale factor II-175
transverse mercator projection map example of II-159
two-digit years (7.5) I-45

U undo command (7.5) I-44
ungeocode defined II-213
uninstalling MapInfo Professional 7.5 I-16
using the cd browser (7.8) II-111
using the cd browser 7.5 I-23
units MAPINFOW.PRJ ID numbers II-174
universal translator log viewing (7.8) II-144
UTM projection map example of II-161

V vector images defined II-214
voronoi saving a polygon to a new table (7.5) I-59
saving the polygon to an existing table (7.5) I-61
voronoi polygons (7.5) I-59–I-61

W web map service (wms) importing files (7.5) I-25–I-28
projection issues (7.5) I-28
weighted averages defined II-214
wfs adding client support (7.8) II-113
adding wfs server (7.8) II-121
changing coordinate system (7.8) II-119
changing wfs styles (7.8) II-120
controlling server timeout (7.8) II-121
error messages II-122
refreshing wfs layer (7.8) II-120
windows defined II-214
windows 2000 system requirements (7.5) I-11
windows 95/98 system requirements (7.5) I-11
windows nt 4.0 system requirements (7.5) I-11
windows registry advanced settings (7.5) I-18
advanced settings (7.8) II-106
modifying (7.5) I-17
modifying (7.8) II-105
windows xp system requirements (7.5) I-11
Windows, querying map window settings (7.5) I-85
map window settings (7.8) II-196
wms adding getfeatureinfo support (7.8) II-124
controlling server timeout (7.8) II-125
error messages II-126
how mapinfo professional uses wms (7.5) I-28
projection issues (7.5) I-28
workspace lost data in .mws files (7.8) II-129
saved data in .mws files (7.8) II-128
saving as .mws file (xml-based) (7.8) II-127
workspaces defined II-214
workstations custom installation (7.5) I-14
custom installation (7.8) II-100

Z zoom layering defined II-214
zoom levels using microsoft intellimouse (7.5) I-22
using microsoft intellimouse (7.8) II-110